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Preface 
This instruction manual provides information about the installation and operation of the DGC-2020ES 
Digital Genset Controller. To accomplish this, the following information is provided: 

• Controls and indicators 
• Inputs and outputs 
• Protection and control functions 
• Reporting and alarms information 
• Mounting and connection diagrams 
• BESTCOMSPlus® software 
• Communication and security 
• Maintenance and troubleshooting procedures 
• Specifications 
• CEM-2020 
• MTU Fault Codes 
• Exhaust Treatment 
• Diagnostic Trouble Codes 

Conventions Used in this Manual 

Important safety and procedural information is emphasized and presented in this manual through 
Warning, Caution, and Note boxes. Each type is illustrated and defined as follows. 
 

Warning! 

Warning boxes call attention to conditions or actions that may cause 
personal injury or death. 

 

Caution 
Caution boxes call attention to operating conditions that may lead to 
equipment or property damage. 

 

Note 
Note boxes emphasize important information pertaining to Digital 
Genset Controller installation or operation. 
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© 2014 by Basler Electric 
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Warning! 

READ THIS MANUAL. Read this manual before installing, operating, or maintaining the DGC-2020ES. 
Note all warnings, cautions, and notes in this manual as well as on the product. Keep this manual with 
the product for reference. Only qualified personnel should install, operate, or service this system. 
Failure to follow warning and cautionary labels may result in personal injury or property damage. 
Exercise caution at all times. 

 
 

Basler Electric does not assume any responsibility to compliance or noncompliance with national code, local code, 
or any other applicable code. This manual serves as reference material that must be well understood prior to 
installation, operation, or maintenance. 

For terms of service relating to this product and software, see the Commercial Terms of Products and Services 
document available at www.basler.com/terms.  

This publication contains confidential information of Basler Electric Company, an Illinois corporation. It is loaned for 
confidential use, subject to return on request, and with the mutual understanding that it will not be used in any 
manner detrimental to the interests of Basler Electric Company and used strictly for the purpose intended. 

It is not the intention of this manual to cover all details and variations in equipment, nor does this manual provide 
data for every possible contingency regarding installation or operation. The availability and design of all features 
and options are subject to modification without notice. Over time, improvements and revisions may be made to this 
publication. Before performing any of the following procedures, contact Basler Electric for the latest revision of this 
manual. 
The English-language version of this manual serves as the only approved manual version. 
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Introduction 
The DGC-2020ES Digital Genset Controller provides integrated engine-genset control, protection, and 
metering in a rugged and economical package. Its features set make the DGC-2020ES ideal for 
standalone genset applications where paralleling or load sharing is not required. Microprocessor based 
technology allows for exact measurement, setpoint adjustment, and timing functions. Front panel controls 
and indicators enable quick and simple DGC-2020ES operation. Basler Electric communication software 
(BESTCOMSPlus®) allows units to be easily customized for each application. Because of the low sensing 
burden in the DGC-2020ES, dedicated potential transformers (PTs) are not required. A liquid crystal 
display (LCD) with backlighting can be viewed under a wide range of ambient light and temperature 
conditions. 

Features and Functions 

The DGC-2020ES Digital Genset Controller has the following features: 
• Generator Control 
• Engine and Generator Protection 
• Automatic Transfer Switch Control (Mains Failure) 
• Automatic Generator Configuration Detection 
• Programmable Analog Engine Senders 
• Seven Programmable Contact Inputs 
• Programmable Logic 
• Exercise Timer 
• ECU Communications via SAE J1939 
• Additional contact input/output module available to expand the capabilities of the DGC-2020ES 

DGC-2020ES Digital Genset Controllers perform the following functions: 

Generator Protection and Metering 
Multifunction generator protection guards against generator overvoltage, undervoltage, reverse power, 
loss of excitation, underfrequency, overfrequency, and overcurrent. Each generator protection function 
has an adjustable pickup and time delay setting. 

Metered generator parameters include voltage, current, real power (watts), apparent power (VA), and 
power factor (PF). 

Engine Protection and Metering 
Engine protection features include oil pressure and coolant temperature monitoring, overcrank protection, 
ECU specific protection elements, and diagnostic reporting. 

Metered engine parameters include oil pressure, coolant temperature, battery voltage, speed, fuel level, 
engine load, coolant level (from ECU), ECU specific parameters, and run-time statistics. 

Event Recording 
An event log retains a history of system events in nonvolatile memory. Up to 30 event types are retained 
and each record contains a time stamp of the first and last occurrence, and the number of occurrences for 
each event. For more information, see the Event Recording chapter. 

Contact Inputs and Outputs 
DGC-2020ES controllers have seven programmable contact inputs. All contact inputs recognize dry 
contacts. The programmable inputs can be configured to initiate a pre-alarm or alarm. An input can be 
programmed to receive an input from an automatic transfer switch. Inputs can also be programmed to 
override DGC-2020ES alarms and protection functions. Each input can be assigned a user-defined name 
for easy identification at the front panel display and in fault records. 

DGC-2020ES Introduction 



2  9469200990 Rev B 

Output contacts include three dedicated relays for energizing an engine’s glow plugs, fuel solenoid, and 
starter solenoid. Four additional user-programmable output contacts are provided. 

Additional contact inputs and output contact requirements can be accommodated with an optional CEM-
2020 (Contact Expansion Module). Contact Basler Electric for ordering information. 

Automatic Transfer Switch Control (Mains Failure) 
The DGC-2020ES can detect a mains failure via a single- or three-phase bus input. A mains failure is 
established when any one of the following conditions are met: 

• Any phase of bus voltage falls below dead the bus threshold 
• Any phase of bus voltage is unstable due to overvoltage or undervoltage 
• Any phase of bus voltage is unstable due to overfrequency or underfrequency 

At this time, the DGC-2020ES will start the genset and when ready, apply power to the load via the 
genset. The DGC-2020ES implements open transitions to and from the mains. When the mains returns 
and is considered stable, the DGC-2020ES will transfer the load back to the mains. 

Communication 
DGC-2020ES communication features include a standard USB port for local (and temporary) 
communication, SAE J1939 interface for remote communication, and RS-485 interface for communication 
with an optional Remote Display Panel. 

USB Port 

The USB communication port can be used with BESTCOMSPlus software to quickly configure a DGC-
2020ES with the desired settings or retrieve metering values and event log records. 

CAN Interface 

The CAN interface provides high-speed communication between the DGC-2020ES and the engine control 
unit (ECU) on an electronically controlled engine. This interface provides access to oil pressure, coolant 
temperature, and engine speed data by reading these parameters directly from the ECU. When available, 
engine diagnostic data can also be accessed. The CAN interface supports the following protocols: 

• SAE J1939 Protocol - Oil pressure, coolant temperature, and engine speed data are received 
from the ECU. In addition, DTCs (Diagnostic Trouble Codes) help diagnose any engine or related 
failures. The engine DTCs are displayed on the front panel of the DGC-2020ES and may be 
obtained using BESTCOMSPlus® software. 

• MTU Protocol - A DGC-2020ES connected to a genset equipped with an MTU ECU receives oil 
pressure, coolant temperature, and engine speed data from the engine controller, along with 
various alarms and pre-alarms that are MTU specific. In addition, the DGC-2020ES tracks and 
displays the active fault codes issued by the MTU engine ECU. 

Style Number 

Standard-order DGC-2020ES controllers are identified by a style number which consists of a combination 
of letters and numbers that define the controller’s electrical characteristics and operational features. The 
model number, together with the style number, describes the options included in a specific controller. 
Figure 1 illustrates the DGC-2020ES style number identification chart. 

Introduction  DGC-2020ES 
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Figure 1. DGC-2020ES Style Chart 

 

For example, a DGC-2020ES with style number 5A2, has the following characteristics and features. 
5 5 Aac Current Sensing Inputs 
A Analog Senders 
2 Mains Failure Detection 

Optional Features and Capabilities 

CEM-2020 (Contact Expansion Module) 
The optional CEM-2020 provides 10 additional contact inputs and 18 or 24 additional output contacts 
(depending on module type) to the DGC-2020ES. The CEM-2020 communicates with the DGC-2020ES 
through a CAN interface. Refer to the CEM-2020 chapter for more information. 

Remote Display Panel 
The optional Remote Display Panel provides remote indication of many pre-alarm and alarm conditions. 
The DGC-2020ES communicates with the Remote Display Panel through an RS-485 interface. Refer to 
the Controls and Indicators chapter for more information. 
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Controls and Indicators 
DGC-2020ES controls and indicators are located on the front panel and are intended for local control and 
monitoring of DGC-2020ES operation. Front panel controls consist of pushbuttons. Front panel indicators 
consist of LED (light emitting diode) indicators and a backlit LCD (liquid crystal display). 

DGC-2020ES controls and indicators are illustrated in Figure 2. Lettered locators in Figure 2 correspond 
to the control and indicator descriptions of Table 1. 

 

 
Figure 2. Front Panel 
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Table 1. Front Panel HMI Descriptions 

Locator Description 
A Liquid Crystal Display. The backlit, 64 by 128 pixel LCD serves as the local information 

source for metering, alarms, pre-alarms, and protective functions. Display operation is 
maintained at −40°C. 

B Supplying Load Indicator. This green LED lights when the generator current is greater 
than Emergency Power Supply (EPS) threshold current. 

C Alarm Indicator. This red LED lights continuously during alarm conditions and flashes 
during pre-alarm conditions. 

D Not in Auto Indicator. This red LED lights when the DGC-2020ES is not operating in Auto 
mode. When the DGC-2020ES is operating in Run or Off mode, this LED is on. 

E Run Pushbutton and Mode Indicator. Pressing this button places the DGC-2020ES in 
Run mode. The green Run mode LED lights when Run mode is active. 

F Off Pushbutton and Mode Indicator. Pressing this button places the DGC-2020ES in Off 
mode. The red Off mode LED lights when the DGC-2020ES is in Off mode. This button 
also resets the Breaker Management Pre-Alarms and all MTU ECU Alarms. 

G Auto Pushbutton and Mode Indicator. Pressing the Auto button places the DGC-2020ES 
in Auto mode. The green Auto mode LED lights when Auto mode is active. 

H Back Pushbutton. This button is pressed to cancel a settings editing session and discard 
any settings changes. When navigating through menus, pressing this button moves 
upward a level. When pressed momentarily, this button also resets the Breaker 
Management Pre-Alarms and all MTU ECU Alarms. This button is also used to reset the 
Maintenance Interval when pressed for 10 seconds while viewing Hours Until 
Maintenance or Maintenance Due Pre-Alarm. 

I Alarm Silence Pushbutton Combination. Simultaneously pressing both the Back and Edit 
buttons opens the relay output programmed as the horn output. 

J Edit Pushbutton. Pressing this button starts an editing session and enables changes to 
DGC-2020ES settings. At the conclusion of an editing session, the Edit pushbutton is 
pressed again to save the setting changes. When navigating through menus, pressing 
this button moves downward one level. When entering a string, such as a password, this 
button locks the selected character and moves to the next position. When finished, press 
Edit twice to submit the string. 

K Arrow Pushbuttons. These two buttons are used to navigate through the front panel 
display menus and modify settings. Within a level, the up- and down-arrow buttons are 
used to move among items within the menu level. Pressing the down-arrow button moves 
to items lower in the list. Pressing the up-arrow button moves to items higher in the list. 
During a settings editing session, the up- and down-arrow buttons are used to raise and 
lower the value of the selected setting. 

L Lamp Test Pushbutton Combination. Simultaneously pressing both the Up- and Down-
arrow buttons tests the DGC-2020ES indicators by exercising all LCD pixels and lighting 
all LEDs for as long as both buttons are held.  

 

Display Operation and Navigation 

The front panel display is used to make settings changes and display metering values. Refer to locators 
H, J, and K in Table 1 for information on changing settings through the front panel and navigating through 
the Metering screens. 
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Login and Permissions 
To login, navigate to the SETTINGS, ENTER PASSWORD screen and press the Edit key. Use the 
Up/Down arrow keys to scroll through the characters. Use the Edit key to accept a character and move to 
the next space. Once the password has been entered, press the Edit key again to login. A LOGOUT 
selection now appears in the list of SETTINGS. To logout, navigate to SETTINGS, LOGOUT and press 
the Edit key. The LOGOUT selection is removed from the SETTINGS list. 

If communication access is active through the USB port, the front panel will display REMOTE COMMS, 
FRONT PANEL IS READ ONLY, and the summary screen. This informs the user that the front panel can 
only be used for viewing metering data and settings information. USB port access must be ended before 
modifying settings through the front panel. 

Summary Screen and Configurable Metering 
The summary screen can be set to standard or scrolling. When set to standard, only the following 
parameters are displayed: 

• VOLT∗ 
• AMP∗ 
• PH∗ 
• Hz 
• OIL 
• FUEL 
• TEMP 
• BATT 

∗ When set to standard, individual phase information can be automatically toggled at a rate set by the 
Phase Toggle Delay setting. Navigate to the SETTINGS, GENERAL SETTINGS, FRONT PANEL HMI 
screen and edit PH TOG DELAY. When the Phase Toggle Delay is set to zero, information for each 
phase is obtained by pressing the Up or Down arrow keys on the front panel HMI. When it is set to a 
number other than zero, the display will toggle through the phases automatically at the rate specified by 
the Phase Toggle Delay Setting. 

When the summary screen is set to scrolling, you can select/configure the metering values that are 
displayed. Up to 20 values can be displayed and these values will scroll at a delay time specified by the 
user. To select a standard or scrolling summary, navigate to the SETTINGS, GENERAL SETTINGS, 
FRONT PANEL HMI screen and edit the SUMMARY VIEW. The SCROLL DELAY setting is also found on 
this screen. 

To select the scrolling values, navigate to the SETTINGS, GENERAL SETTINGS, FRONT PANEL HMI 
screen and edit the CONFIGURABLE METERING. The following parameters may be placed in the 
scrolling summary: 

 
• BATT V 
• BLANK (Shows nothing on this line) 
• BOOST PRESS 
• BUS Hz 
• BUS VAB 
• BUS VBC 
• BUS VCA 
• CHRG AIR TMP 
• COOLANT PRESS 
• ENGINE % LOAD 
• ENG INTCLR TEMP 
• ENG OIL TEMP 
• FUEL 
• FUEL DELV P 
• FUEL RATE 

• GEN VCA 
• GEN VCN 
• INJ RAIL PRS 
• INTAK MNFLD TMP 
• kVA A 
• kVA B 
• kVA C 
• kVA TOT 
• kvar A 
• kvar B 
• kvar C 
• kvar TOTAL 
• kW A 
• kW B 
• kW C 

DGC-2020ES Controls and Indicators 
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• FUEL TEMP 
• GEN Hz 
• GEN IA 
• GEN IB 
• GEN IC 
• GEN PF 
• GEN VAB 
• GEN VAN 
• GEN VBC 
• GEN VBN 

• kWh 
• kW TOT 
• NONE (Removes a line from the scrolling list) 
• OIL P 
• RPM 
• RPM SRC 
• RUN HRS 
• TEMP 
• TOTAL FUEL USED 

Sleep Mode 
Sleep mode de-energizes the LCD backlight and heater when no pushbutton activity is detected for 15 
minutes and the DGC-2020ES is operating in OFF mode or Auto mode with the engine not running. 
Normal display operation resumes when any pushbutton is pressed or the genset is started remotely via 
the ATS input. Sleep mode will not be entered while an alarm is active. Sleep mode can be permanently 
disabled through BESTCOMSPlus® or the front panel. 

Changing a Setting 
To change a setting, navigate to the setting you want to change and press the Edit key. If you are not 
already logged in, you will be prompted for your password. Use the Up/Down arrow key to raise or lower 
the value. Press the Edit key again when finished. 

Front Panel Display Structure 
The front panel display structure begins with the SUMMARY SCREEN. Pressing the Edit key opens the 
MAIN MENU screen. The MAIN MENU screen consists of METERING and SETTINGS. The METERING 
screen branches are shown in Figure 3. Details of the METERING screen branches follow Figure 3. The 
SETTINGS screen branches are shown in Figure 4. Details of the SETTINGS screen branches follow 
Figure 4. 

 
Figure 3. Metering Screen Branches 

 

ENGINE 

● OIL PRESSURE 
● COOLANT TMP 
● BATTERY VOLT 
● RPM 
● SPEED SRC 
● FUEL LEVEL 
● ENGINE LOAD 
● COOLANT LEVL (Visible when CAN BUS is enabled.) 
● TOTAL RUN TM 
● HRS TO MAINT 
● DEF TANK 1 LVL % (Visible when CAN BUS is enabled.) 
● DEF TANK 2 LVL % (Visible when CAN BUS is enabled.) 
 
 

P0067-82

ENGINE
GENERATOR
POWER
RUN STATISTICS
ALARMS-STATUS
DIAGNOSTICS

METERING
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GENERATOR 

● GEN VAB 
● GEN VBC 
● GEN VCA 
● GEN VAN 
● GEN VBN 
● GEN VCN 
● GEN FREQ 
● GEN AMPS A 
● GEN AMPS B 
● GEN AMPS C 
● BUS VAB 
● BUS VBC 
● BUS VCA 
● BUS FREQ 

POWER 

● kW A 
● kW B 
● kW C 
● kW TOTAL 
● kVA A 
● kVA B 
● kVA C 
● kVA TOTAL 
● kvar A 
● kvar B 
● kvar C 
● kvar TOTAL 
● PF 

RUN STATISTICS 

● CUMULATIVE 
○ CUMULATIVE 

■ START 
■ # STARTS 
■ HRS TO MAINT 
■ kW-HRS 

○ TOTAL RUN TIME 
■ HOURS 
■ MINUTES 

○ LOADED RUN TIME 
■ HOURS 
■ MINUTES 

○ UNLOADED RUN TIME 
■ HOURS 
■ MINUTES 

● SESSION 
○ SESSION 

■ START 
■ kW-HRS 

○ TOTAL RUN TIME 
■ HOURS 
■ MINUTES 

○ LOADED RUN TIME 
■ HOURS 
■ MINUTES 

○ UNLOADED RUN TIME 
■ HOURS 
■ MINUTES 

DGC-2020ES Controls and Indicators 
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ALARMS-STATUS 

● ACTIVE ALARMS 
● ACTIVE PRE-ALARMS 
● MTU FAULT CODES (Visible when ECU is configured for MTU MDEC, MTU ADEC, MTU ECU7/ECU8 or MTU 

Smart Connect.) 
● MTU STATUS (Visible when ECU is configured for MTU MDEC, MTU ADEC, MTU ECU7/ECU8, or MTU Smart 

Connect.) 
○ NMT-ALIVE STATUS (Visible when ECU is configured for MTU MDEC or MTU ECU7/ECU8.) 

■ SPS_NODE 
■ SW_TYP 
■ SW_VAR 
■ SW_ED1 
■ SW_ED2 
■ REV 
■ SW_MOD 

○ TRIP FUEL (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ TRIP HRS 
■ TRIP IDLE HRS 
■ FUEL RATE 
■ TRIP FL RATE 
■ TOTAL RUN TM 
■ DAILY FUEL 
■ TOTAL FUEL 

○ FUEL (Visible when ECU is configured for MTU ADEC.) 
■ DAY TANK LVL 
■ STORE TANK LVL 

○ ENGINE STATUS (Visible when ECU is configured for MTU ADEC, MTU ECU7/ECU8, or MTU Smart 
Connect.) 

■ MTU FAULT CODES 
■ ENG RUNNING 
■ CYL CUTOUT 
■ ENG OPTIMIZED (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ PREHT NT RCHD (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ SPEC TORQUE (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ SPD DMD FL MD (Visible when ECU is configured for MTU ADEC.) 
■ CURR P DEGREE (Visible when ECU is configured for MTU ADEC.) 
■ LOAD GEN ON (Visible when ECU is configured for MTU ADEC, MTU ECU7/ECU8, or MTU 

Smart Connect.) 
■ PRIME PUMP ON (Visible when ECU is configured for MTU ADEC.) 
■ RUNUP SPD LO (Visible when ECU is configured for MTU ADEC.) 
■ IDLE SPD LO (Visible when ECU is configured for MTU ADEC.) 
■ CYL CUTOUT CD (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ DROOP % (Visible when ECU is configured for MTU ECU7/ECU8 or MTU Smart Connect.) 
■ ENG COOL TEMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ CHRG AIR TMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ INTRCOOLR TEMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ ENG OIL TEMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ FUEL TEMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ ECU TEMP (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ OIL PRESSURE (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ CHG AIR P (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ FUEL DELV P (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ FL RAIL P (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ CAMSHAFT RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ IDLE RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ ECU SHUTDOWN (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ TOTAL RUN TM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ ECU SUPP VOLTS (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ INJCT DBR % (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ RATED RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ INJCT QTY (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ RATED KW (Visible when ECU is configured for MTU ECU7/ECU8.) 
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■ RESRV PWR % (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ START SEQ (Visible when ECU is configured for MTU ECU7/ECU8 or MTU Smart Connect.) 
■ ECU OVRD FDBK (Visible when ECU is configured for MTU Smart Connect.) 
■ COOLNT PRHT DONE (Visible when ECU is configured for MTU Smart Connect.) 
■ REQ TORQUE (Visible when ECU is configured for MTU Smart Connect.) 
■ EXT STOP (Visible when ECU is configured for MTU Smart Connect.) 
■ OPERATING MODE (Visible when ECU is configured for MTU Smart Connect.) 

○ SPEED (Visible when ECU is configured for MTU ADEC, MTU ECU7/ECU8, or MTU Smart Connect.) 
■ SPD DMD SRC 
■ CAN SPD DMD 
■ ANLG SPD DMD 
■ SPEED DEMAND (Visible when ECU is configured for MTU Smart Connect.) 
■ SEL SPD DMD (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ EFF SET SPEED (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ SPD DMD FL MD (Visible when ECU is configured for MTU ECU7/ECU8 or MTU Smart 

Connect.) 
■ RATED RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ CAMSHAFT RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ IDLE RPM (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ FREQ RPM DMD (Visible when ECU is configured for MTU ECU7/ECU8.) 

○ SIGNL FEEDBK (Visible when ECU is configured for MTU ADEC, MTU ECU7/ECU8, or MTU Smart 
Connect.) 

■ ECU_OVRD_FDBK 
■ EXT STOP 
■ SPD UP IN 
■ SPD DN IN 
■ CAN MODE FDBK (Visible when ECU is configured for MTU ADEC or MTU ECU7/ECU8.) 
■ CYL CUTOUT (Visible when ECU is configured for MTU ECU7/ECU8.) 

○ DIAGNOSTICS (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ AL PWR AMP 1 
■ AL PWR AMP 2 
■ XSTR OUT AL 
■ XSTR OUT STS 
■ ECU SHUTDOWN 

○ CAN BUS (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ CAN MODE FDBK 
■ CAN NODES 
■ LOST NODES 

○ LIMITS (Visible when ECU is configured for MTU ECU7/ECU8.) 
■ OIL PRESSURE 
■ LO LIM OILP 
■ LOLOLIM OILP 
■ ENG COOL TEMP 
■ CLNT LMT HI 
■ CLNT LMT HIHI 
■ CHRG AIR TMP 
■ CHG AIR LMT HI 
■ ECU SUPP VOLTS 
■ L1L ECU VOLTS 
■ L2L ECU VOLTS 
■ U1L ECU VOLTS 
■ U2l ECU VOLTS 
■ INTRCOOLR TMP 
■ INTCLR LMT HI 

● STATUS 
○ AUTO XFER SWITCH (Visible when the Auto Transfer Switch programmable function is configured to 

be driven by an input.) 
○ EPS SUPP. LOAD 
○ GEN BREAKER 
○ MAINS BREAKER 
○ BATTLE OVERRIDE (Visible when the Battle Override programmable function is configured to be 

driven by an input.) 
○ LOW LINE OVERRIDE (Visible when the Low Line Override programmable function is configured to be 

driven by an input.) 
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○ LOW COOL LEVEL (Visible when the Low Coolant Level programmable function is configured to be 
driven by an input.) 

○ LOW FUEL LEVEL (Visible when the Low Coolant Level programmable function is configured to be 
driven by an input.) 

○ BATT CHRG FAIL (Visible when the Battery Charger Fail programmable function is configured to be 
driven by an input.) 

○ FUEL LEAK DETECT (Visible when the Fuel Leak Detect programmable function is configured to be 
driven by an input.) 

○ GRND DELTA O-RIDE (Visible when Generator Connection is configured for Delta and the Grounded 
Delta Override programmable function is configured to be driven by an input.) 

○ 1 PHASE O-RIDE (Visible when the 1-Phase Override programmable function is configured to be driven 
by an input.) 

○ BUS DEAD 
○ BUS STABLE 
○ BUS FAILED 
○ GEN DEAD 
○ GEN STABLE 
○ GEN FAILED 
○ ENG RUNNING 
○ CLDN TMR ACTVE 
○ OFF MODE COOLDN 
○ COOLDN REQ 
○ COOL & STOP REQ 
○ EXT START DEL 
○ START DEL BYPASS 
○ ALT FRQ O-RIDE 
○ RESET 
○ ALARM SILENCE 
○ LAMP TEST 
○ IDLE REQUEST 
○ MAINS FAIL TEST 
○ CEM CONNECTED 

● INPUTS 
○ INPUT X (X = 1 to 7 (8 to 17 optional)) 

● OUTPUTS 
○ START 
○ RUN 
○ PRESTART 
○ OUTPUT X (X = 1 to 4 (5 to 28 optional)) 

● LOGIC CTL RELAYS 
○ LCR X (X = 1 to 16) 

● CONF ELEMENTS 
○ CONFIG ELEMENT X (X = 1 to 8) 

● EVENT LOG 
○ [EVENT NAME] 

■ ACTIVE 
■ OCCURRENCE COUNT 
■ FIRST DATE 
■ FIRST TIME 
■ LAST DATE 
■ LAST TIME 
■ FIRST ENG HRS 
■ LAST ENG HRS 
■ DETAILS 

□ OCCURRENCE (Use the Edit/Up/Down keys to change the occurrence.) 
□ DATE 
□ TIME 
□ ENG HRS 

■ CLEAR EVENT (Visible when logged in through the front panel.) 
● J1939 DATA (Visible when CAN bus is enabled and ECU is configured for Standard, Volvo Penta, MTU ADEC, 

GM/Doosan, Cummins or MTU Smart Connect.) 
○ THROTTLE POSITN 
○ LOAD @ CRNT RPM 
○ ACTUAL ENG TORQ 
○ ENGINE SPEED 
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○ DESIRED SPEED 
○ INJ CNTRL PRESS 
○ INJ RAIL PRS 
○ ENGINE HOURS 
○ TRIP FUEL 
○ TRIP AVE FL RT 
○ TOTAL FUEL USED 
○ ENG COOLANT TEMP 
○ COOLNT PRHT DONE 
○ FUEL TEMP 
○ ENG OIL TEMP 
○ ENG INTCLR TEMP 
○ INTRCR CLNT LVL 
○ FUEL DELV P 
○ ENG OIL LEVEL 
○ ENG OIL PRESS 
○ COOLANT PRESS 
○ COOLANT LEVEL 
○ FUEL RATE 
○ BAROMETRIC PRESS 
○ AMB AIR TEMP 
○ AIR INLET TEMP 
○ BOOST PRESS 
○ INTAK MNFLD TEMP 
○ INTAK MNFLD1 ABS PRESS 
○ AIR FLTR DIF PRS 
○ EXHAUST GAS TEMP 
○ BATTERY VOLTAGE 
○ ECU INPUT VOLTS 
○ TRANS OIL PRESS 
○ TRANS OIL TEMP 
○ WINDG 1 TEMP 
○ WINDG 2 TEMP 
○ WINDG 3 TEMP 
○ ECU TEMP 
○ AUX PRESSURE1 
○ AUX PRESSURE2 
○ RATED KW 
○ RATED RPM 
○ EXHAUST TMP A 
○ EXHAUST TMP B 
○ CHRG AIR TMP 
○ FUEL 1 LEAK 
○ FUEL 2 LEAK 
○ ALARM RST FDBK 
○ ECU SHUTDOWN 
○ DEF TANK 1 LVL % 
○ DEF TANK 2 LVL % 

● J1939 ENGINE CONFIG (Visible when CAN bus is enabled and ECU is configured for Standard, Volvo Penta, 
MTU ADEC, GM/Doosan, Cummins, or MTU Smart Connect.) 

○ SPD @ IDLE PNT 1 
○ TRQ @ IDLE PNT 1 
○ SPD @ PNT 2 
○ TRQ @ PNT 2 
○ SPD @ PNT 3 
○ TRQ @ PNT 3 
○ SPD @ PNT 4 
○ TRQ @ PNT 4 
○ SPD @ PNT 5 
○ TRQ @ PNT 5 
○ SPD @ PNT 6 
○ ENDSPEED GOV KP 
○ REF ENG TORQUE 
○ O-RIDE SPD PNT 7 
○ O-RIDE TIME LMT 
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○ SPEED LOWER LMT 
○ SPEED UPPER LMT 
○ TORQUE LOWER LMT 
○ TORQUE UPPER LMT 

DIAGNOSTICS 

● FLASH WR 
 

 
Figure 4. Settings Screen Branches 

 

GENERAL SETTINGS 

● FRONT PANEL HMI 
○ SUMMARY VIEW 
○ SCROLL DELAY 
○ PH TOG DELAY 
○ LCD CONTRAST 
○ SLEEP MODE 
○ LANGUAGE 
○ CONFIGURABLE METERING 

■ ITEM X (X = 1 to 20) 
● CONFIGURE DATE/TIME 

○ YEAR 
○ MONTH 
○ DAY 
○ HOURS 
○ MINUTES 
○ SECONDS 
○ UTC OFFSET 
○ DST ENABLED 
○ CLK NOT SET WRN 

● VIEW DATE/TIME 
● VERSION INFO 

○ DGC-2020ES 
■ FIRMWARE VERSION 
■ BOOT CODE VERSION 
■ SERIAL NUMBER 
■ PART NUMBER 
■ MODEL NUMBER 
■ LANGUAGE VERSION 
■ LANGUAGE PART NUM 
■ STYLE CODE 

○ CEM-2020 (Visible when CEM-2020 is enabled.) 
■ FIRMWARE VERSION 
■ BOOT CODE VERSION 
■ SERIAL NUMBER 
■ PART NUMBER 
■ MODEL NUMBER 
■ BUILD DATE 

 

P0067-83

GENERAL SETTINGS
COMMUNICATIONS
SYSTEM PARAMS
PROGRAMMABLE INPUTS
PROGRAMMABLE OUTPUTS
ALARM CONFIGURATION
GENERATOR PROTECTION
BREAKER MANAGEMENT
LOGIC TIMERS
ENTER PASSWORD

SETTINGS
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COMMUNICATIONS∗ 

∗(Visible when the optional J1939 CAN bus is enabled, style code xCx.) 

● CAN BUS SETUP 
○ CAN BUS SETUP 

■ CAN BUS ENABLE 
■ DTC ENABLE (Visible when CAN BUS is enabled.) 
■ SPN CONV METHOD (Visible when CAN BUS is enabled.) 
■ CAN BUS ADDR (Visible when CAN BUS is enabled.) 
■ ECU OPT SLCT (Visible when CAN BUS is enabled.) 
■ ECU PULSING (Visible when CAN BUS is enabled.) 
■ ENG SHTDN TM (Visible when CAN BUS is enabled.) 
■ PLS CYCL TM (Visible when CAN BUS is enabled.) 
■ ECU SET TM (Visible when CAN BUS is enabled.) 
■ RESP TIMEOUT (Visible when CAN BUS is enabled.) 

○ ECU SETUP (Visible when CAN BUS is enabled.) 
■ ECU CONF 
■ GEN DATA TRANSMIT 
■ ENGINE PARAM XMT 
■ TRIP RESET (Visible when ECU is configured for Standard, Volvo Penta, MTU ADEC, 

GM/Doosan, Cummins, or MTU Smart Connect.) 
■ DPF REGENRATE SETUP (Visible when ECU is configured for Standard, Volvo Penta, MTU 

ADEC, GM/Doosan, Cummins, or MTU Smart Connect.) 
□ DPF MANUAL REGEN 
□ DPF REGEN DISABLE 

■ SPEED SELECT (Visible when ECU is configured for Volvo Penta.) 
■ ACCEL POSITION (Visible when ECU is configured for Volvo Penta.) 
■ MODULE TYPE (Visible when ECU is configured for MTU MDEC or MTU ECU7/ECU8.) 
■ ALIVE MSG (Visible when ECU is configured for MTU MDEC or MTU ECU7/ECU8.) 
■ SPEED SETUP 

□ J1939 RPM ENABLE (Visible when ECU is configured for Standard, Volvo Penta, 
MTU ADEC, GM/Doosan, Cummins, or MTU Smart Connect.) 

□ ENGINE RPM 
□ RPM BAND WIDTH 
□ IDLE RPM 
□ SPEED UP (Visible when ECU is configured for MTU ADEC, MTU MDEC 304, MTU 

ECU7/ECU8, or MTU Smart Connect.) 
□ SPEED DN (Visible when ECU is configured for MTU ADEC, MTU MDEC 304, MTU 

ECU7/ECU8, or MTU Smart Connect.) 
□ TEST OVRSPEED (Visible when ECU is configured for MTU ADEC, MTU MDEC 

304, MTU ECU7/ECU8, or MTU Smart Connect.) 
□ SPD DMAND SRC (Visible when ECU is configured for MTU ADEC, MTU MDEC 

304, MTU ECU7/ECU8, or MTU Smart Connect.) 
□ IDLE REQUEST (Visible when ECU is configured for MTU MDEC 304, MTU 

ECU7/ECU8, or MTU Smart Connect.) 
□ INCREASE IDLE (Visible when ECU is configured for MTU MDEC 304, or MTU 

ECU7/ECU8.) 
■ ECU SETUP (Visible when ECU is configured for MTU ADEC, MTU MDEC 304, MTU 

ECU7/ECU8, or MTU Smart Connect.) 
□ TRIP RESET (Visible when ECU is configured for MTU MDEC 304, or MTU 

ECU7/ECU8.) 
□ INT OIL PRIME 
□ GOV PRM SW (Visible when ECU is configured for MTU ADEC or MTU Smart 

Connect.) 
□ ENG STRT PRIME (Visible when ECU is configured for MTU MDEC 304, or MTU 

ECU7/ECU8.) 
□ FAN OVERRIDE (Visible when ECU is configured for MTU MDEC 304, or MTU 

ECU7/ECU8.) 
□ MODE SWITCH (Visible when ECU is configured for MTU MDEC 304, or MTU 

ECU7/ECU8.) 
□ GOV PARAM SET (Visible when ECU is configured for MTU ECU7/ECU8.) 
□ CAN RATING SW 1 (Visible when ECU is configured for MTU ECU7/ECU8.) 
□ CAN RATING SW 2 (Visible when ECU is configured for MTU ECU7/ECU8.) 
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□ DIS CYL CUT 1 (Visible when ECU is configured for MTU MDEC 304, or MTU 
ECU7/ECU8.) 

□ DIS CYL CUT 2 (Visible when ECU is configured for MTU MDEC 304, MTU 
ECU7/ECU8 or MTU Smart Connect.) 

□ OPERATING MODE (Visible when ECU is configured for MTU Smart Connect.) 

SYSTEM PARAMS 

● SYSTEM SETTINGS 
○ GEN CONNECT 
○ BUS CONNECT 
○ RATED kW 
○ RATED VOLTS 
○ RATED FREQ 
○ ALTRNATE FRQ 
○ RATED RPM 
○ RATED PF 
○ ROTATION 
○ EPS 

■ EPS THRESHLD 
■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 

function.) 
○ FUEL LVL TYP 
○ SYSTEM UNITS 
○ PRESSURE UNITS (Visible when Metric is selected for System Units.) 
○ BATTERY VOLT 
○ FLYWHL TEETH 
○ SPEED SOURCE 
○ MAINT RESET 
○ NFPA LEVEL 
○ POWER UP DELAY 

● REMOTE MODULE SETUP 
○ CEM SETUP 

■ ENABLE 
■ OUTPUTS (Visible when CEM-2020 is enabled.) 
■ CAN BUS ADDR (Visible when CEM-2020 is enabled.) 
■ VERSION INFO (Visible when CEM-2020 is enabled.) 

□ FIRMWARE VERSION 
□ BOOT CODE VERSION 
□ SERIAL NUMBER 
□ PART NUMBER 
□ MODEL NUMBER 
□ BUILD DATE 

■ CEM DEBUG MENU (Visible when CEM-2020 is enabled.) 
□ DGC TO CEM BP 
□ CEM TO DGC BP 

● CRANK SETTINGS 
○ DISCNCT LMIT 
○ PRECRNK DELY 
○ PRESTRT CNTCT 
○ STYLE 
○ # CYCLES (Visible when Cycle is selected for Cranking Style.) 
○ CONT TIME (Visible when Continuous is selected for Cranking Style.) 
○ CYCLE TIME 
○ COOLDWN TIME 
○ OFF MODE COOLDN 
○ PRESTART REST CONFIG 

■ CONF 
○ OIL PRS CRANK DISC 

■ ENABLE 
■ CRANK DISC PRS 

● AUTOMATIC RESTART 
○ ENABLE 
○ ATTEMPTS 
○ INTERVAL 
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● EXERCISE TIMER 
○ MODE 
○ RUN WITH LOAD 
○ START HOUR 
○ START MINUTE 
○ RUN HOURS 
○ RUN MINUTES 

● SENSING TRANS 
○ GEN PT PRI V 
○ GEN PT SEC V 
○ GEN CT PRI A 
○ CT LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.)  
○ BUS PT PRI V 
○ BUS PT SEC V 

● RELAY CONTROL 
○ START 
○ RUN 
○ PRESTART 

● AUTO CONFIG DETECT 
○ ENABLE 
○ LOW LINE THRESH 
○ 1-PH THRESH 

● ENGINE STATISTICS 
○ START YEAR 
○ START MONTH 
○ START DAY 
○ # STARTS 
○ HRS TO MAINT 
○ kW-HRS 
○ TOTAL HRS 
○ LOADED HRS 
○ UNLOADED HRS 

PROGRAMMABLE INPUTS 

● CONFIGURABLE INPUTS 
○ INPUT X (X = 1 to 7) 

■ ALARM CONFIG 
■ ACTIVATN DLY 
■ RECOGNITION 

● PROG FUNCTIONS 
○ EMERGENCY STOP 

■ INPUT 
○ AUTO XFER SWITCH 

■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ GRND DELTA O-RIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ BATTLE OVERRIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW LINE OVERRIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ 1 PHASE O-RIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ BATT CHRG FAIL 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW COOL LEVEL 
■ INPUT 
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■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW FUEL LEVEL 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ FUEL LEAK DETECT 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

PROGRAMMABLE OUTPUTS 

● CONFIG ELEMENTS 
○ CONFIG ELEMENT X (X = 1 to 8) 

■ ALARM CONFIG 
■ ACTIVATN DLY 
■ RECOGNITION 

ALARM CONFIGURATION 

● HORN CONFIGURATION 
○ HORN 
○ NOT IN AUTO HORN 

● PRE-ALARMS 
○ HIGH COOLANT TEMP 

■ ENABLE 
■ THRESHOLD 

○ LOW COOLANT TEMP 
■ ENABLE 
■ THRESHOLD 

○ LOW OIL PRESSURE 
■ ENABLE 
■ THRESHOLD 

○ LOW FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 

○ MAINTENANCE INTERVAL 
■ ENABLE 
■ THRESHOLD 

○ BATTERY OVERVOLTAGE 
■ ENABLE 
■ THRESHOLD 

○ LOW BATTERY VOLTAGE 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ WEAK BATTERY VOLTAGE 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ HIGH FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ ACTIVE DTC (Visible when DTC is enabled.) 
■ ENABLE 

○ ECU COMMS FAIL (Visible when CAN BUS is enabled.) 
■ ENABLE 

○ COOLANT LEVEL (Visible when CAN BUS is enabled.) 
■ ENABLE 
■ THRESHOLD 
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○ CEM COMM FAIL (Visible when CEM-2020 is enabled.) 
■ ENABLE 

○ CHECKSUM FAIL 
■ ENABLE 

○ BRK CLOSE FAIL PALM 
■ ENABLE 

○ BRK OPEN FAIL PALM 
■ ENABLE 

• ALARMS 
○ HIGH COOLANT TEMP 

■ ENABLE 
■ THRESHOLD 
■ ARMING DELAY 

○ LOW OIL PRESSURE 
■ ENABLE 
■ THRESHOLD 
■ ARMING DELAY 

○ LOW FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ OVERSPEED 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ COOLANT LEVEL (Visible when CAN bus is enabled.) 
■ ENABLE 
■ THRESHOLD 

NOTE 

The HIGH COOLANT TEMP and LOW OIL PRESSURE alarms have an 
ARMING DLY setting that disables the alarm for the specified time after engine 
startup. 

 
● SENDER FAIL 

○ COOL TEMP SENDR FAIL 
■ CONFIG TYPE 
■ ACTIVATN DLY 

○ OIL PRESS SENDR FAIL 
■ CONFIG TYPE 
■ ACTIVATN DLY 

○ FUEL LEVL SENDR FAIL 
■ CONFIG TYPE 
■ ACTIVATN DLY 

○ VOLTAGE SENSE FAIL 
■ CONFIG TYPE 
■ ACTIVATN DLY 

○ SPEED SENDR FAIL 
■ TIME DELAY 

 

GENERATOR PROTECTION 

● 27 UNDERVOLTAGE 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ FREQ INHIBIT 
■ ALARM CONFIG 
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● 59 OVERVOLTAGE 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 

● 47 PHASE IMBALANCE 
○ PICKUP 
○ HYSTERESIS 
○ TIME DELAY 
○ ALARM CONFIG 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 

● 81 O/U FREQUENCY 
○ UNDERFREQUENCY 

■ INHIBIT VOLTS 
■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 

○ OVERFREQUENCY 
■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 

○ ALTRNT FRQ SCALE FCTR 
■ ALT FREQ SF 

● 50 OVERCURRENT 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ TIME DELAY 
■ ALARM CONFIG 

BREAKER MANAGEMENT 

● BREAKER HARDWARE 
○ MAINS FAIL TRANSFER 

■ ENABLE 
■ RETURN DELAY 
■ TRANSFER DELAY 
■ MAX TRANSFER TIME 

○ CLOSE WAIT TIME 
■ TIME 

○ GEN BREAKER 
■ CONTINUOUS 
■ CLOSING TIME 
■ OPEN CMD 
■ CLOSE CMD 

○ MAINS BREAKER 
■ CONFIGURED 
■ CONTINUOUS (Visible when configured.) 
■ CLOSING TIME (Visible when configured.) 
■ OPEN CMD (Visible when configured.) 
■ CLOSE CMD (Visible when configured.) 

○ BRK CLOSE FAIL PALM 
○ BRK OPEN FAIL PALM 

● BUS CONDITION DETECT 
○ GEN DEAD 

■ THRESHOLD 
■ TIME DELAY 

○ GEN STABLE 
■ OV PICKUP 
■ OV DROPOUT 
■ UV PICKUP 

Controls and Indicators  DGC-2020ES 



9469200990 Rev B 21 

■ UV DROPOUT 
■ OF PICKUP 
■ OF DROPOUT 
■ UF PICKUP 
■ UF DROPOUT 
■ TIME DELAY 
■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 

function.) 
■ ALT FREQ SF 

○ GEN FAILED 
■ TIME DELAY 

○ BUS DEAD 
■ THRESHOLD 
■ TIME DELAY 

○ BUS STABLE 
■ OV PICKUP 
■ OV DROPOUT 
■ UV PICKUP 
■ UV DROPOUT 
■ OF PICKUP 
■ OF DROPOUT 
■ UF PICKUP 
■ UF DROPOUT 
■ TIME DELAY 
■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 

function.) 
■ ALT FREQ SF 

○ BUS FAILED 
■ TIME DELAY 

LOGIC TIMERS 

● TIMER X (X = 1 to 10) 
○ HOURS 
○ MINUTES 
○ SECONDS 

ENTER PASSWORD 

 

LOGOUT (Visible when logged in through the front panel.) 

Display Setup 

The DGC-2020ES LCD can be customized to fit the needs of your specific application. Most of the 
options can be adjusted using the front panel buttons while all options can be adjusted within 
BESTCOMSPlus®. The display options are described below. 

The Front Panel HMI screen is found in the BESTCOMSPlus® Settings Explorer under the General 
Settings category. If using the front panel, navigate to Settings > General Settings > Front Panel HMI. 

Figure 5 shows the BESTCOMSPlus® Front Panel HMI settings screen. 

LCD Contrast - Adjust this setting to reach the desired level of LCD contrast. 

1. Front Panel Sleep Mode - Select enable to send the DGC-2020ES into sleep mode. In sleep 
mode, the LEDs and LCD backlight turn off after 15 minutes of inactivity on the front panel to 
minimize battery drain. 

2. Language Selection - Select from English, French, German, or Spanish. 

3. Scrolling Screens - These settings are not accessible via the front panel. If a different overview 
screen for the LCD is desired, specify the scrolling screens in which parameters are configured to 
appear on the front panel LCD display. 
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a. Configure the Configurable HMI Summary Settings. 

b. Set the Scrolling Screen Enable to Enable. 

c. Set the Scrolling Screen Scroll Delay parameter to the desired value. 

4. Phase Toggle Delay - Set the phase toggle delay to a nonzero value if automatic scrolling 
through the phase information in the standard overview screen on the front panel is desired. If it is 
left at zero, scrolling through phase information is accomplished using the up and down arrow 
buttons. 

5. Initializing Message 1 - This parameter defines the first line of text that appears on the front panel 
of the DGC-2020ES as it is going through its power up and initializing sequence. 

6. Initializing Message 2 - This parameter defines the second line of text that appears on the front 
panel of the DGC-2020ES as it is going through its power up and initializing sequence. 

 
Figure 5. Settings Explorer, General Settings, Front Panel HMI Screen 

Remote Display Panel (optional) 

Applications that require remote annunciation can use Basler Electric’s Remote Display Panel. This 
device provides remote indication of many pre-alarm and alarm conditions. 

The following pre-alarm conditions are indicated by LEDs on the Remote Display Panel: 
• High coolant temperature 
• Low coolant temperature 
• Low oil pressure 
• Low fuel level∗ 
• Weak battery 
• Battery overvoltage† 
• Battery charger failure∗† 

The following alarm conditions are indicated by LEDs and an audible alarm on the Remote Display Panel: 
• Low coolant level∗ 
• High coolant temperature 
• Low oil pressure 
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• Overcrank 
• Overspeed 
• Emergency stop activated 
• Fuel leak/Sender failure∗† 
• Sender failure† 

∗ This can be configured in the DGC-2020ES as None, Alarm, or Pre-alarm. See the Contact Inputs 
chapter for more information. The LED on the Remote Display Panel illuminates when the input that is 
assigned to the programmable function is closed, whether the function is configured as None, Alarm, or 
Pre-alarm. 

† This LED can be reprogrammed in the DGC-2020ES to suit the needs of a particular application. The 
condition listed above is annunciated by default. 

Additionally, the Remote Display Panel indicates when the DGC-2020ES is not operating in Auto mode 
and when the generator is supplying load or when the DGC-2020ES is in an alarm state not listed above. 

Refer to Basler Publication 9318100990 for more information on the Remote Display Panel. 

See the Terminals and Connectors chapter for more information on connecting the Remote Display Panel 
to the DGC-2020ES. 
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Power Input 
Operating power for the DGC-2020ES is typically supplied by the genset starter battery. Power from the 
battery is supplied to an internal power supply that provides power for DGC-2020ES logic, protection, and 
control functions. 

Nominal Voltage Input and Acceptable Range of Input Voltage 

A nominal voltage of 12 or 24 Vdc within a range of 6 to 32 Vdc is accepted. Operating power must be of 
the correct polarity. Although reverse polarity will not cause damage, the DGC-2020ES will not operate. 

Terminal Assignments 

Input power is applied to terminals 18 (BATT+), 17 (BATT–), and 16 (CHASSIS). 

Power Consumption 

The amount of power consumed by the DGC-2020ES varies based on the selected mode. The power 
saving Sleep mode consumes 4.5 W with all relays de-energized. The Normal Operational Mode 
consumes 6.5 W in Run mode with the LCD heater off and 3 relays energized. The Maximum Operational 
Mode consumes 14 W in Run mode with the LCD heater on and 7 relays energized. 

Battery Ride-Through Capability 

Starting at 10 Vdc, withstands cranking ride-through down to 0 Vdc for 50 milliseconds. 

Fuse Protection 

To follow UL guidelines, a 5 A maximum, 32 Vdc supplementary fuse must be implemented in the battery 
input circuit to the DGC-2020ES. 
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Voltage and Current Sensing 
The DGC-2020ES senses generator voltage, generator current, and bus voltage through dedicated, 
isolated inputs. 

Generator Voltage 

The DGC-2020ES accepts either line-to-line or line-to-neutral generator sensing voltage over the range of 
12 to 576 volts, rms line-to-line. Single-phase generator voltage is sensed across phases A and B. 
Generator voltage sensing terminals are listed in Table 2. 

Table 2. Generator Voltage Sensing Terminals 

Terminal Description 
40 (GEN VN) Neutral generator voltage sensing input 
41 (GEN VC) C-phase generator voltage sensing input 
43 (GEN VB) B-phase generator voltage sensing input 
45 (GEN VA) A-phase generator voltage sensing input 

Bus Voltage 

Bus sensing over the range of 12 to 576 volts rms line-to-line is accepted by the DGC-2020ES. Sensing 
of bus voltage enables the DGC-2020ES to detect failures of the mains (utility). Controllers with style 
number xx2 measure bus voltage sensing to perform automatic mains failure transfers. Single-phase bus 
voltage is sensed across phases A and B. Bus voltage sensing terminals are listed in Table 3. 

Table 3. Bus Voltage Sensing Terminals 

Terminal Description 
46 (BUS VA) A-phase bus voltage sensing input 
48 (BUS VB) B-phase bus voltage sensing input 
50 (BUS VC) C-phase bus voltage sensing input 

Generator Current 

The DGC-2020ES has sensing inputs for A-phase, B-phase, and C-phase generator current. Depending 
on the style number, a DGC-2020ES has a nominal sensing current rating of 1 Aac or 5 Aac. A style 
number of 1xx indicates 1 Aac nominal current sensing and a style number of 5xx indicates 5 Aac 
nominal current sensing. Generator current sensing terminals are listed in Table 4. 
 

Table 4. Generator Current Sensing Terminals 

Terminal Description 
38 (IA+) 

A-phase generator current sensing input 
37 (IA–) 
36 (IB+) 

B-phase generator current sensing input 
35 (IB–) 
34 (IC+) 

C-phase generator current sensing input 
33 (IC–) 
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Note 

Unused current sensing inputs should be shorted to minimize noise 
pickup. 

 

Caution 
Generator current sensing terminals 37 (IA–), 35 (IB–), and 33 (IC–) 
must be terminated to ground for proper operation. 
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Engine Sender Inputs 
The DGC-2020ES has sender inputs dedicated to monitoring the engine fuel level, oil pressure, and 
coolant temperature. These inputs are programmable to give the user flexibility in selecting the sender to 
be used in an application. Information about programming sender inputs is provided later in this chapter. 

Connections 

Oil pressure sender connections are made at terminals 8 and 11 (sender common). Fuel Level sender 
connections are made at terminals 9 and 11. Coolant Temperature sender connections are made at 
terminals 10 and 11. 

Compatible Senders 

Oil pressure senders that are compatible with the DGC-2020ES include Datcon model 02505-00, Isspro 
model R8919, Stewart-Warner models 279BF, 279C, 411K and 411M, and VDO models 360025 and 
360811. Compatible Fuel Level senders include the Isspro model R8925. Compatible Coolant 
Temperature senders include Datcon model 02019-00, Faria model TS4042, Isspro model, R8959, and 
Stewart-Warner model 334P. Other senders may also be used. 

Operation 

A current is provided to each sender. The developed voltage is measured and scaled for use by the 
internal circuitry. An open circuit or short circuit across the sender terminals will cause the DGC-2020ES 
to indicate a failed sender. 

Sender Programmability 

BESTCOMSPlus® software allows for the programming of sender characteristics. See Sender 
Characteristic Curves, below, for more information. 

Sender Characteristic Curves 

The sender inputs of the DGC-2020ES can be customized to obtain maximum accuracy from the coolant 
temperature, oil pressure, and fuel level senders. 

The characteristic curve of each sender input can be configured with up to 11 points. Each point can be 
assigned a resistance input value and a corresponding temperature (coolant temperature sender), 
pressure (oil pressure sender), or percentage (fuel level sender) value. A sender slope setting 
automatically orders the values in the resistance column according to whether the sender requires a 
negative or positive slope. Sender curve points are automatically plotted on a curve in BESTCOMSPlus, 
which can be printed. 

Sender curve points configured in BESTCOMSPlus can be saved in the configuration file. The data for all 
three senders is automatically saved with the DGC-2020ES configuration file. 

Any changes made in BESTCOMSPlus to the sender points, can be reverted to the factory-default 
values. A new settings file can also be created. 

Curve Configuration 
If the DGC-2020ES receives engine information from an ECU, the programmable sender parameters for 
coolant temperature and oil pressure do not require configuration because they have no effect. 
Configuration of sender parameters is appropriate for resistive senders only. 
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Fuel Level 

Figure 6 illustrates the Fuel Level screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Senders category. To program the fuel level sender, perform the following procedure: 

1. The percent fuel level sender is configured by selecting one of the sender types that come as a part 
of the BESTCOMSPlus sender library. Click on Load Fuel Settings File and select the appropriate 
sender. 

2. If no sender file matches the sender being used, the individual points that map resistance points to 
fuel level may be modified by setting numeric values in the table, or dragging the points of the graph 
to the desired characteristic. Information on sender characteristics should be obtained from the 
sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Fuel Data to save the data in the current settings file. 

5. If you want to save newly entered sender data as a sender library file, click Create Fuel Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 

 
Figure 6. Settings Explorer, Programmable Senders, Fuel Level Screen 
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Oil Pressure 

Figure 7 illustrates the Oil Pressure screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Senders category. To program the oil pressure sender, perform the following procedure: 

1. The oil pressure sender can be configured by selecting one of the sender types that come as a part of 
the BESTCOMSPlus sender library. Click on Load Oil Settings File and select the appropriate sender. 

2. If no sender file matches the sender being used, the individual points that map resistance points to oil 
pressure may be modified by setting numeric values in the table, or dragging the points of the graph 
to the desired characteristic. Information on sender characteristics should be obtained from the 
sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Oil Data to save the data in the current settings file. 

5. If you want to save newly entered sender data as a sender library file, click Create Oil Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 

 
Figure 7. Settings Explorer, Programmable Senders, Oil Pressure Screen 
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Coolant Temperature 

Figure 8 illustrates the Coolant Temperature screen found in the BESTCOMSPlus Settings Explorer 
under the Programmable Senders category. To program the fuel level sender, perform the following 
procedure: 

1. The coolant temperature sender can be configured by selecting one of the sender types that come as 
a part of the BESTCOMSPlus sender library. Click on Load Cool Settings File and select the 
appropriate sender. 

2. If no sender file matches the sender being used, the individual points that map resistance points to 
coolant temperature may be modified by setting numeric values in the table, or by dragging the points 
of the graph to the desired characteristic. Information on sender characteristics should be obtained 
from the sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Cool Data to save the data in the current settings file. 

5. If you want to save newly entered sender data as a sender library file, click Create Cool Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 

 
Figure 8. Settings Explorer, Programmable Senders, Coolant Temperature Screen 
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Sender Failure Detection 

The DGC-2020ES can be configured to annunciate a pre-alarm or alarm when a loss of signal is detected 
at the coolant temperature, oil pressure, or fuel level sender input. The speed sender fail alarm is always 
enabled. A user-adjustable time delay is provided for each sender/sensing alarm/pre-alarm. 

Alarm and pre-alarm annunciations for loss of engine speed signals are not user-programmable and 
operate as follows. If the MPU (magnetic pickup) or generator frequency is programmed as the sole 
engine speed source and that signal source fails, an alarm (and shutdown) is triggered. If the engine 
speed source is configured as MPU and generator frequency and a loss of one of the signal sources 
occurs, a pre-alarm is annunciated. An alarm (and shutdown) is triggered if both speed signals are lost. 

The BESTCOMSPlus Sender Fail screen is illustrated in Figure 9 and is found in the Settings Explorer 
under Alarm Configuration. If using the front panel, navigate to Settings > Alarm Configuration > Sender 
Fail. 

 
Figure 9. Settings Explorer, Alarm Configuration, Sender Fail Screen 
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Speed Signal Inputs 
The DGC-2020ES uses signals from the generator voltage sensing inputs and magnetic pickup (MPU) 
input to detect machine speed. 

Magnetic Pickup 

Voltage supplied by a magnetic pickup is scaled and conditioned for use by the internal circuitry as a 
speed signal source. The MPU input accepts a signal over the range of 3 to 35 volts peak and 32 to 
10,000 hertz. 

Terminals 
Magnetic pickup connections are provided at terminals 31 (+) and 32 (–). 

Generator Sensing Voltage 

The generator voltage sensed by the DGC-2020ES is used to measure frequency and can be used to 
measure machine speed. 

Terminals 
Sensing voltage is applied to terminals 45 (A-phase), 43 (B-phase). 
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Contact Inputs 
Contact inputs are available to initiate DGC-2020ES actions. The DGC-2020ES has seven programmable 
contact sensing inputs. Additional contact inputs can be accommodated with an optional CEM-2020 
(Contact Expansion Module). Contact Basler Electric for availability and ordering information. 

Programmable 

Each programmable input (Input 1 through Input 7) can be independently configured to perform the 
following functions. By default, each programmable input is disabled. 

• Auto Transfer Switch 
• Battery Charger Fail 
• Battle Override 
• Emergency Stop 
• Fuel Leak Detect 
• Grounded Delta Override 
• Low Coolant Level 
• Low Fuel Level 
• Low Line Override 
• Single-Phase Override 

The programmable inputs accept dry contacts. A contact is connected between a programmable input 
and the negative side of the battery. Through BESTCOMSPlus®, each programmable contact input can be 
assigned a name (16 alphanumeric characters, maximum) and configured as an alarm input, a pre-alarm 
input, or none. The default names for the inputs are INPUT_x (where x = 1 to 7). When a programmable 
contact input is closed, the front panel display shows the name of the closed input if it was programmed 
as an alarm or pre-alarm input. Alarm inputs are annunciated through the Normal display mode screens 
of the front panel. Pre-alarm inputs are annunciated through the pre-alarm metering screen of the front 
panel. If neither alarm nor pre-alarm is programmed, no indication is given. Programming an input as 
None is useful when a programmable input is used as an input to programmable logic. 
Connections for the programmable inputs are provided at terminals 3 (Input 1) through 9 (Input 7). The 
negative side of the battery voltage (terminal 17) serves as the return connection for the programmable 
inputs. 

Contact Input Configuration 
Figure 10 illustrates the Contact Inputs screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Inputs > 
Configurable Inputs. 
For each contact input, configure the following parameters: 
1. Alarm Configuration - Select None, Alarm, or Pre-Alarm. When an alarm occurs, the horn output 

closes and the engine shuts down. When a pre-alarm occurs, the horn output toggles between open 
and closed while the engine remains running. If None is selected, the input is status only. The status 
is available to BESTlogic™Plus Programmable Logic regardless of Alarm Configuration setting. 

2. Activation Delay - This parameter defines the duration that the input remains on before any 
annunciation occurs. 

3. Label Text - Enter descriptive text that signifies the use of the input. This text appears next to the 
input in BESTlogic™Plus Programmable Logic and in the event log if the input is configured as an 
alarm or pre-alarm. 

4. Contact Recognition - Select whether the contact input should be recognized always, or only while 
the engine is running. For example, a switch closes when oil pressure is low. Such a switch would be 
closed when the engine is not running but a low oil pressure alarm or pre-alarm should not be 
annunciated unless the switch is closed while the engine is running. A selection of While Engine 
Running Only prevents spurious annunciation when the engine is not running. 
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Figure 10. Settings Explorer, Programmable Inputs, Contact Inputs Screen 

Programmable Functions 
Any of the seven contact inputs can be programmed to recognize any one of 10 function types: 

• Automatic Transfer Switch (ATS) - Start and run the generator while the ATS input is true and the 
DGC-2020ES is in Auto mode. 

• Grounded Delta Override - Uses Grounded Delta sensing if the generator connection is set for 
Delta. 

• Battle Override - The alarms programmed to shut down the unit will be overridden and ignored. 
• Low-Line Override - The 51, 27, and 59 settings are scaled by the low-line scale factor setting. 
• Single-Phase Override - The unit switches to single-phase sensing configuration and uses the 1 

Phase Override Sensing setting (A-B or A-C). 
• Emergency Stop - Opens the Start, Run, and Fuel output relays and an ESTOP alarm is 

annunciated. 
• Battery Charger Fail - When the selected input is invoked, a user selectable pre-alarm or alarm is 

annunciated after the activation delay. 
• Low Coolant Level - When the selected input is invoked, a Low Coolant Level pre-alarm or alarm 

is annunciated after the activation delay. 
• Low Fuel Level - When the selected input is invoked, a Low Fuel Level pre-alarm or alarm is 

annunciated after the activation delay. 
• Fuel Leak Detect - When the selected input is invoked, a Fuel Leak pre-alarm or alarm is 

annunciated after the activation delay. 
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An Alarm Configuration setting of “None” prevents a function from being triggered by a contact input. 
Programmable function status is available in BESTlogic™Plus Programmable Logic when the “None” 
alarm configuration setting is selected. 
The Programmable Functions screen is found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Inputs > 
Programmable Functions. 
The BESTCOMSPlus Programmable Functions screen is illustrated in Figure 11. 

 
Figure 11. Settings Explorer, Programmable Inputs, Programmable Functions 
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Contact Outputs 
Output contact operation is controlled by the operating mode of the DGC-2020ES. The state of the 
Emergency Stop contact input also affects output contact operation. When the Emergency Stop contact 
input is open (emergency stop condition), the PRESTART, START, and RUN outputs open and an 
emergency stop alarm is annunciated. When the Emergency Stop input is closed, all output contacts 
operate normally. 

DGC-2020ES output contacts include PRESTART, START, RUN, and four programmable outputs. 
Additional output contacts can be accommodated with an optional CEM-2020 (Contact Expansion 
Module). 

Prestart 

This output closes to energize the engine glow plugs or run pre-lubrication pumps. The PRESTART 
output can be programmed to close up to 30 seconds prior to engine cranking. The PRESTART output 
can also be programmed to open upon engine startup or remain closed as long as the engine is 
operating. 

During the resting state, the PRESTART output can be set to Off, On, or Preheat Before Crank. If Preheat 
Before Crank is selected, the PRESTART output will be closed for a time equal to the Pre-crank delay 
time prior to re-entering the cranking state. If the Pre-crank delay setting is longer than the rest interval, 
the PRESTART output will be closed for the entire rest time. 

PRESTART output connections are made through terminals located on the PRESTART relay. 

Start 

This output closes when engine cranking is initiated by the DGC-2020ES and opens when the magnetic 
pickup (MPU) or generator frequency indicates that the engine has started. Prior to engine starting, the 
duration of cranking is determined by the cranking style (cycle or continuous) selected. Cycle cranking 
permits up to seven crank cycles with crank cycle duration of 5 to 15 seconds. The continuous crank time 
is adjustable from 5 to 60 seconds. 

START output connections are made through terminals located on the START relay. 

Run 

This output closes when engine cranking is initiated by the DGC-2020ES. The RUN output remains 
closed until it receives a command to stop the engine. 

RUN output connections are made through terminals located on the RUN relay. 

Relay Control 

In some applications, it may be beneficial to modify the standard operation of the DGC-2020ES Run, Pre-
Start, or Start relays. If desired, these relays can be configured to operate outside their predefined 
functionality. For example, if your genset does not require starting assistance from glow plugs, the Pre-
Start relay may be assigned for another purpose. Configuring these relays as programmable makes them 
available in BESTlogic™Plus programmable logic to be used in the same manner as the other 
programmable relay outputs. Predefined or programmable operation of the Run, Pre-Start, and Start 
relays is selected on the Relay Control screen (Figure 12). See the BESTlogicPlus chapter for more 
information about DGC-2020ES programmable logic. 
The Relay Control screen is found in the BESTCOMSPlus® Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Relay Control. 
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Figure 12. Settings Explorer, System Parameters, Relay Control Screen 

For each relay (Start, Run, and Pre-Start), select whether it should use its predefined functionality or be 
made programmable. 

When Programmable is selected for a relay, it becomes available to BESTlogicPlus Programmable Logic 
as a logic element. The elements are titled Start Output, Prestart Out, and Run Output. The predefined 
functionality is available as an input to the logic. If Programmable is selected as the relay control mode, 
connecting the corresponding predefined input function to the relay causes it to function as if Predefined 
were selected as its relay control type. However, other logic can be combined with it to create operation 
that is more versatile. If Programmable is selected for a relay, but it is not used in the logic, that relay will 
never close. 

An example logic scheme connecting the predefined inputs directly to the “programmable” relay outputs 
for all three relays is shown in Figure 13. 

 
Figure 13. Example Logic Scheme of Programmable Relays 

Programmable 

DGC-2020ES controllers have four programmable output contacts (OUT 1 through 4). An additional 24 
contact outputs are provided with an optional CEM-2020 (Contact Expansion Module). An optional CEM-
2020H (Contact Expansion Module - High Current) provides 18 contact outputs. 

Programmable Output Configuration 
Figure 14 illustrates the Contact Outputs screen found in the BESTCOMSPlus Settings Explorer under 
the Programmable Outputs category. If using the front panel, navigate to Settings > Programmable 
Outputs > Contact Outputs. 

Each output can be programmed with a text label describing its use. This label appears in BESTlogicPlus 
Programmable Logic where the output is used to aid in program clarity and ease of programming. 
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Figure 14. Settings Explorer, Programmable Outputs, Contact Outputs 

Configurable Elements 
Configurable elements are connected to the logic scheme as outputs. The configurable elements are 
incorporated into a BESTlogicPlus programmable logic scheme by selecting them from the Elements 
group in BESTlogicPlus. For more details, refer to the BESTlogicPlus chapter. Each of the eight elements 
can be independently configured to annunciate an alarm or pre-alarm. A user-adjustable time delay can 
be set to delay recognition of an element. By default, all elements are configured so that they do not 
trigger an alarm or pre-alarm. To make identifying an element easier, each of the elements can be given a 
user-assigned name. If used for an alarm or pre-alarm, the user-assigned name appears in the alarm or 
pre-alarm annunciation and in the DGC-2020ES event log. Elements can be recognized always or only 
while the engine is running. Configurable element status is available in BESTlogicPlus Programmable 
Logic when “None” is selected for Alarm Configuration. Configurable element status can be used as logic 
inputs to drive other logic in the program, similar to logic control relays.  
The BESTCOMSPlus Configurable Elements screen is illustrated in Figure 15 and found in the Settings 
Explorer under the Programmable Outputs category. If using the front panel, navigate to Settings > 
Programmable Outputs > Configurable Elements. 
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Figure 15. Settings Explorer, Programmable Outputs, Configurable Elements 
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Operating Modes 
Three operating modes provide the versatility to meet the application’s needs. The DGC-2020ES 
operates in Off, Run, or Auto mode. These operating modes are described in the following paragraphs. 

Off 

In OFF mode, the DGC-2020ES will not start under any circumstance. It cannot be started automatically. 
Programmable logic functions normally in this mode. 

Run 

In RUN (manual) mode, the DGC-2020ES runs and cannot be shut off automatically. The breaker can be 
opened or closed through programmable logic inputs. Programmable logic functions normally in this 
mode. 

Auto 

In AUTO mode, the DGC-2020ES may be started automatically or “self-start” from an automatic starting 
feature described in the following paragraphs. If the DGC-2020ES is not in AUTO mode, the self-starting 
modes will have no effect. The self-starting modes are independent, meaning that if any self-starting 
mode indicates that the unit should run, it will run. It will not shut down unless all self-starting modes 
indicate that the unit should not be running. 

ATS Contact Input 
The ATS (automatic transfer switch) programmable function has an input mapped to it through 
BESTCOMSPlus®. The unit will start and run when this contact is closed, and will stop when the contact 
is open. 

Generator Exerciser 
The unit starts at the designated time and runs for the specified duration. The breaker will be closed if 
“Run with Load” is checked in the generator exerciser settings. 

Mains Fail Transfer Functionality 
If mains fail transfer is enabled, the unit runs when any phase of the utility is dead or unstable, and will not 
stop until all phases of the utility are stable and the load has been transitioned to the utility. 

Run-with-Load Logic Element 
When the run-with-load logic element start input is energized, the unit starts and closes its breaker. When 
the run-with-load logic element stop input is energized, the unit opens its breaker and stops. 

Engine Run Logic Element 
When the engine run logic element start input is energized, the unit starts. When the engine run logic 
element stop input is energized, the unit opens its breaker if needed, cools down, and then stops. 

Operating Mode Control 

Controls for selecting operating mode are located on the front panel and within BESTCOMSPlus. 

Refer to the Controls and Indicators chapter for more information. 
  

DGC-2020ES Operating Modes 



46  9469200990 Rev B 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Operating Modes  DGC-2020ES 



9469200990 Rev B 47 

Breaker Management 
The DGC-2020ES is capable of controlling the generator breaker and the mains breaker. Once it is 
determined that a valid breaker request is available, the DGC-2020ES will attempt to operate the breaker 
if possible. The user can choose to control only the generator breaker, the generator and mains breakers, 
or none. BESTCOMSPlus® is used to configure breaker management. Refer to the BESTCOMSPlus 
chapter for setting information. 

Breaker Status 

The status of the breakers is determined by using BESTlogic™Plus programmable logic and sent to the 
GENBRK and MAINSBRK logic blocks. These logic blocks have outputs that can be configured to 
energize an output contact and control a breaker as well as inputs for breaker control and status. See 
Breaker Configuration, below, for details on configuring the logic. 

Breaker Operation 

The DGC-2020ES will attempt to close a breaker only after verifying that it can be closed. If the breaker 
cannot be closed, the close request will be ignored. Only one breaker can be closed at a time. Closure to 
a dead bus can be performed after meeting dead bus threshold and timing requirements set by the user. 

Breaker Operation Requests 
Types of breaker operation requests include: 
• Local Request - initiated by internal functions and based on operating modes. 
• Com Request - initiated through a communication port using BESTCOMSPlus or the front panel. 
• Logic Request - initiated from BESTlogicPlus. 

The type of response given for a local request depends on the operating mode of the DGC-2020ES. 

RUN Mode 

When in RUN mode, the generator and mains breakers can be closed manually using contact inputs or 
the breaker operation settings on the BESTCOMSPlus Control screen. 

OFF or AUTO Mode (Not Running) 

If operating in the OFF mode or AUTO and not running, the generator breaker can be closed if the bus is 
determined to be dead. 

AUTO Mode (Running) 

When in AUTO mode and running, the mains fail transfer feature will automatically control the mains 
breaker and the generator breaker. Or, the external ATS (automatic transfer switch) will start the 
generator and control the breakers itself. In addition, the generator breaker can be automatically 
controlled by the exercise timer function or a RUNWLOAD (run with load) start through BESTlogicPlus. 
The generator breaker can be manually controlled using contact inputs and outputs or the breaker 
operation settings on the BESTCOMSPlus Control screen. 

Breaker Closure Conditions 
The conditions under which the DGC-2020ES will close a breaker are described in the following 
paragraphs. 

Breaker Status and Voltage Stability 

Before the generator breaker can be closed, it must be configured in BESTCOMSPlus. If only the 
generator breaker is configured (mains breaker not configured) the DGC-2020ES reads user settings to 
determine if the generator side of the breaker is stable or dead and the bus side is dead. If both the 
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generator and the mains breakers are configured and open, the DGC-2020ES closes the generator 
breaker if the generator side of the breaker is stable or dead. If both breakers are configured and the 
mains breaker is closed, the DGC-2020ES will not close the generator breaker. 

Before the mains breaker can be closed, it must be configured in BESTCOMSPlus. If both the mains and 
the generator breakers are configured and open, the DGC-2020ES will close the mains breaker if the 
mains side of the breaker is stable. If both breakers are configured and the generator breaker is closed, 
the DGC-2020ES will not close the mains breaker. 

Command Agreement 

A breaker will not change state if it receives conflicting commands. In other words, if an input is indicating 
an open command at the same time another input is indicating a close command, the breaker will not 
change state. 

Breaker Configuration 

The following paragraphs describe how to properly configure a DGC-2020ES for generator breaker 
control. 

Initial System Setup 
Connect the DGC-2020ES according to the appropriate figure in the Typical Connections chapter for the 
type of generator connection desired (wye, delta, etc.). 

Set up the basic system parameters that will govern engine operation and alarm and pre-alarm 
annunciation. Details can be found in the Configuration chapter. 

Breaker Hardware 
Configure the generator breaker parameters on the BESTCOMSPlus Settings Explorer, Breaker 
Management, Breaker Hardware screen. If using the front panel, navigate to Settings > Breaker 
Management > Breaker Hardware. Figure 16 illustrates the BESTCOMSPlus Breaker Hardware screen. 

1. Breaker Close Wait Time: This is a time interval in which it is expected that the breaker will transition 
from open to closed or closed to open. If the generator breaker does not change state within that 
time, either a Gen Breaker Close Fail alarm or Gen Breaker Open Fail alarm is annunciated. If the 
mains breaker does not change state within that time, either a Mains Breaker Close Fail alarm or 
Mains Breaker Open Fail alarm is annunciated. 

2. Generator Breaker 

a. Set the Contact Type and Open/Close Pulse Times if pulsed contacts are used. 

b. Set the Breaker Closing Time. 

3. Mains Breaker 

a. Set the Mains Breaker as Configured if it is used, otherwise do not configure these settings. 

b. If the mains breaker is configured, set the contact type and pulse times if pulsed contacts are 
used. 

c. If the mains breaker is configured, set the breaker close time. 
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Figure 16. Settings Explorer, Breaker Management, Breaker Hardware Screen 
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Breaker Setup in BESTlogic™Plus 
Set up the Gen Breaker in BESTlogicPlus Programmable Logic under the BESTCOMSPlus Settings 
Explorer, BESTlogicPlus Programmable Logic screen. BESTlogicPlus is not available through the front 
panel interface. Figure 17 illustrates the Gen breaker logic scheme in BESTlogicPlus. 

 
Figure 17. Settings Explorer, BESTlogicPlus Programmable Logic Screen 

 

1. Generator Breaker 

a. Drag the Gen Breaker element into the logic diagram. 

b. Connect the breaker element open and close outputs to the contact outputs that will drive the 
breaker. 

c. Connect the physical input or remote input that has the breaker status (closed if breaker is 
closed, open when the breaker is open) to the Status input of the breaker element. This is the 
only way to indicate breaker status to the DGC-2020ES. 

d. If it is desired to have physical inputs that can request breaker open and close commands, 
connect the desired inputs to the open and close command inputs of the breaker element. 
These inputs should be pulsed. If both inputs close at the same time, the breaker will not 
change state. If it is not desired to have inputs for breaker commands, connect a “Logic 0” 
input object to the open and close command inputs of the breaker block. 

2. Mains Breaker (if configured) 

a. Drag the Mains Breaker element into the logic diagram. 

b. Connect the breaker element open and close outputs to the contact outputs that will drive the 
breaker. 

c. Connect the physical input or remote input that has the breaker status (closed if breaker is 
closed, open if the breaker is open) to the Status input of the breaker element. This is the 
only way to indicate breaker status to the DGC-2020ES. 

d. If it is desired to have physical inputs that can request breaker open and close commands, 
connect the desired inputs to the open and close command inputs of the breaker element. 
These inputs should be pulsed. If both inputs close at the same time, the breaker will not 
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change state. If it is not desired to have inputs for breaker commands, connect a “Logic 0” 
input object to the open and close command inputs of the breaker block. 

3. Click the Save button when the logic setup is complete. 

4. From the Communication pull-down menu, select Upload Logic to Device to load the logic into the 
DGC-2020ES if connected, or save the settings file if working off line. 

Bus Condition Detection 
(These thresholds determine when the generator and bus are considered to be stable or dead.) 

Set the parameters for detecting stable and failed bus and generator under the BESTCOMSPlus Settings 
Explorer, Breaker Management, Bus Condition Detection. If using the front panel, navigate to Settings > 
Breaker Management > Bus Condition Detection. 

Figure 18 illustrates the BESTCOMSPlus Bus Condition Detection screen. 

1. Generator Sensing 

a. Dead Bus Voltage Threshold and Activation Delay. When the generator voltage is below 
this threshold for the duration of the activation delay, the generator is deemed “Dead”. 

b. Gen Stable Overvoltage and Undervoltage thresholds and Overfrequency and 
Underfrequency thresholds and the Bus Stable and Bus Failed Activation Delay times. 
When the generator voltage frequency is within the specified range for the duration of the 
Bus Stable Activation Delay, the generator is deemed “Stable”. Otherwise, it is deemed 
“Failed”. 

2. Bus Sensing 

a. Dead Bus Voltage Threshold and Activation Delay. When the voltage of the bus is below 
this threshold for the duration of the activation delay, the bus is deemed “Dead”. 

b. Bus Stable Overvoltage and Undervoltage thresholds and Overfrequency and 
Underfrequency thresholds and the Bus Stable and Bus Failed Activation Delay times. 
When the bus voltage and frequencies are within the specified ranges for the duration of 
the Bus Stable Activation Delay, the bus is deemed “Stable”. Otherwise, it is deemed 
“Failed”. 

 

Caution 

The bus condition parameters are critical because they determine 
when a breaker can be closed. The generator breaker can be closed 
when any one of the following is true: 

• The generator is stable, the bus is dead, and both breakers are 
open. 

• The generator is dead, the bus is dead, and both breakers are 
open. 

The mains breaker can be closed only when the bus is stable and both 
breakers are open. 
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Figure 18. Settings Explorer, Breaker Management, Bus Condition Detection 

Place the unit in AUTO. The unit is now configured for generator breaker control. It can be tested by 
driving the RUN WITH LOAD logic element true, setting up the exercise timer for a loaded test, or by 
starting the unit in RUN or AUTO mode and giving it CLOSE and OPEN commands from the physical 
inputs if they are available for breaker control. 

Refer to the Maintenance and Troubleshooting chapter if the breaker does not seem to operate properly. 
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Generator Protection 
DGC-2020ES controllers offer standard protection consisting of undervoltage (27), overvoltage (59), 
overcurrent (50), overfrequency (81O), underfrequency (81U), and phase-imbalance voltage (47) 
elements. 

The description of generator protection is organized as follows: 
• Voltage (27, 59, 47) 
• Frequency (81) 
• Overcurrent (50) 

Voltage 

Voltage protection consists of an undervoltage element, an overvoltage element, and a phase-sequence 
voltage element. 

Undervoltage (27) 
Two sets of undervoltage settings are provided for this element: one for three-phase generator 
connections and one for single-phase generator connections. The pickup setting entered is based on the 
PT secondary side. When a single-phase override contact input is received, the DGC-2020ES 
automatically switches from the three-phase undervoltage settings to the single-phase undervoltage 
settings. 

An undervoltage condition is annunciated when the average of the three-phase (three-phase mode) or 
the line-to-line voltage (single-phase mode) decreases below the corresponding 27 pickup setting for the 
duration of the corresponding 27 activation delay. An undervoltage annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An undervoltage annunciation can also be user-
configured to close a programmable output. 

The hysteresis setting functions as an undervoltage dropout by preventing rapid switching of the pickup 
output. 

A frequency-based inhibit setting prevents a 27 trip from occurring during an undervoltage condition 
associated with system startup. 

A low-line scale factor setting is used to automatically adjust the undervoltage pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogic™Plus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus® automatically recalculates the per unit value 
based on the native unit setting and the rated data parameter (on the System Parameters, Rated Data 
screen) associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates 
the native value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Volts, and the rated data associated with them is 
Rated Secondary Volts (on the System Parameters, Rated Data screen). 

• Undervoltage 27 Three-Phase Pickup 
• Undervoltage 27 Single-Phase Pickup 
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The Undervoltage screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 27 
Undervoltage. The BESTCOMSPlus Undervoltage screen is illustrated in Figure 19. 

 
Figure 19. Settings Explorer, Generator Protection, Voltage, Undervoltage (27) Screen 

Overvoltage (59) 
Two sets of overvoltage settings are provided for this element: one for three-phase generator connections 
and one for single-phase generator connections. The pickup setting entered is based on the PT 
secondary side (DGC-2020ES). When a single-phase override contact input is received, the DGC-
2020ES automatically switches from the three-phase overvoltage settings to the single-phase overvoltage 
settings. 

An overvoltage condition is annunciated when the average of the three-phase (three-phase mode) or the 
line-to-line voltage (single-phase mode) increases above the corresponding 59 pickup setting for the 
duration of the corresponding 59 activation delay. An overvoltage annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An overvoltage annunciation can also be user-
configured to close a programmable output. 

The hysteresis setting functions as an undervoltage dropout by preventing rapid switching of the pickup 
output. 

A low-line scale factor setting is used to automatically adjust the overvoltage pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Volts, and the rated data associated with them is 
Rated Secondary Volts (on the System Parameters, Rated Data screen). 
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• Overvoltage 59 Three-Phase Pickup 
• Overvoltage 59 Single-Phase Pickup 

The Overvoltage screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 59 
Overvoltage. The BESTCOMSPlus Overvoltage screen is illustrated in Figure 20.  

 
Figure 20. Settings Explorer, Generator Protection, Voltage, Overvoltage (59) Screen 

Phase Imbalance (47) 
DGC-2020ES controllers are capable of protecting against voltage imbalances between any of the three 
phases. The pickup setting entered is based on the PT secondary side. A phase imbalance condition is 
annunciated when the difference between any of the three phases of generator voltage increases above 
the 47 pickup setting for the duration of the 47 activation delay setting. A phase imbalance annunciation 
can be user-selected to trigger a pre-alarm (warning) or alarm (shutdown). A phase imbalance 
annunciation can also be user-configured to close a programmable output. 

The hysteresis setting functions as a phase imbalance dropout by preventing rapid switching of the pickup 
output. 

A low-line scale factor setting is used to automatically adjust the phase imbalance pickup setting in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
the low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup setting. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following setting has native units of Secondary Volts, and the rated data associated with it is Rated 
Secondary Volts (on the System Parameters, Rated Data screen). 

• Phase Imbalance 47 Pickup 
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The Phase Imbalance screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 47 
Phase Imbalance. The BESTCOMSPlus Phase Imbalance screen is illustrated in Figure 21. 

 
Figure 21. Settings Explorer, Generator Protection, Voltage, Phase Imbalance (47) Screen 

Frequency 

Two sets of frequency protection settings are provided: one for underfrequency (81U) and one for 
overfrequency (81O). 

Underfrequency (81U) 
An underfrequency condition is annunciated when the generator frequency decreases below the 81U 
pickup setting for the duration of the 81U activation delay setting. An underfrequency annunciation can be 
user-selected to trigger a pre-alarm (warning) or alarm (shutdown). An underfrequency annunciation can 
also be user-configured to close a programmable output. 

A voltage-based inhibit setting prevents an 81U trip from occurring during an underfrequency condition 
associated with system startup. 

The hysteresis setting functions as an underfrequency dropout by preventing rapid switching of the pickup 
output. 

Overfrequency(81O) 
When the generator frequency increases above the 81O pickup setting for the duration of the 81O 
activation delay setting, an overfrequency condition is annunciated. An overfrequency annunciation can 
be user-selected to trigger a pre-alarm (warning) or alarm (shutdown). An overfrequency condition can 
also be user configured to close a programmable output. 

The hysteresis setting functions as an overfrequency dropout by preventing rapid switching of the pickup 
output. 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Alternate Frequency Scale Factor 
An alternate frequency scale factor setting is used for automatic adjustment of the frequency pickup 
settings in applications that may utilize more than one operating frequency. For example, a machine that 
is configurable between 50 or 60 Hz operation. The scale factor setting is implemented when the DGC-
2020ES senses a contact closure at a contact input that is connected to the Alternate Frequency Override 
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logic element in BESTlogicPlus Programmable Logic. When the Alternate Frequency Override is true, the 
scale factor setting serves as a multiplier for the pickup settings. For example, if an alternate frequency 
scale factor contact input is received by the DGC-2020ES and the scale factor setting is 2.000, the pickup 
setting is doubled (2.000 x PU). 

Per Unit 
Settings which are related to machine ratings can be set in either actual units of hertz or in per unit 
values. Per unit settings are available for Pickup (81O/81U) and Inhibit Volts (81U). When a native unit is 
edited, BESTCOMSPlus automatically recalculates the per unit value based on the native unit setting and 
the rated data parameter (on the System Parameters, Rated Data screen) associated with it. When a per 
unit value is edited, BESTCOMSPlus automatically recalculates the native value based on the per unit 
setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Frequency in Hz, and the rated data associated with them is 
Rated Frequency (on the System Parameters, Rated Data screen). 

• 81 U Pickup 
• 81 O Pickup 

The following setting has native units of Secondary Volts, and the rated data associated with it is Rated 
Secondary Volts (on the System Parameters, Rated Data screen). 

• 81 U Inhibit Voltage 

The Frequency screen is found in the BESTCOMSPlus Settings Explorer under the Generator Protection, 
Frequency category. If using the front panel, navigate to Settings > Generator Protection > 81 O/U 
Frequency. The BESTCOMSPlus Frequency screen is illustrated in Figure 22. 

 
Figure 22. Settings Explorer, Generator Protection, Frequency, Frequency (81) Screen 

Overcurrent 

Two sets of overcurrent settings are provided for this element: one for three-phase generator connections 
and one for single-phase generator connections. The pickup setting entered is based on the CT 
secondary side. When a single-phase override contact input is received by the DGC-2020ES, the 
overcurrent protection settings automatically switch from the three-phase settings to the single-phase 
overcurrent protection settings. 
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When any of the phase currents increase above the pickup setting for the duration of the overcurrent time 
delay, an overcurrent condition is annunciated. An overcurrent annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An overcurrent annunciation can also be user-
configured to close a programmable output. 

A low-line scale factor setting is used for automatic adjustment of the overcurrent pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of current or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Amps, and the rated data associated with them is 
Rated Secondary Phase Amps (on the System Parameters, Rated Data screen). 

• Overcurrent 50 Three-Phase Pickup 
• Overcurrent 50 Single-Phase Pickup 

The Overcurrent screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Current category. If using the front panel, navigate to Settings > Generator Protection > 50 
Overcurrent. The BESTCOMSPlus Overcurrent screen is illustrated in Figure 23. 

 

 
Figure 23. Settings Explorer, Generator Protection, Current, Overcurrent 
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Metering 
The DGC-2020ES provides comprehensive metering of internal and system conditions. These capabilities 
include extensive parameter metering, status indication and reporting. 

Metering Explorer 

DGC-2020ES metering is accessed through the metering explorer menu on the front panel display or the 
BESTCOMSPlus® metering explorer. 

Front Panel 
On the front panel, the metering explorer is accessed through the Metering branch of the menu. Refer to 
the Controls and Indicators chapter for more information. 

BESTCOMSPlus® 
In BESTCOMSPlus, the metering explorer is located in the upper left portion of the application window. 

Metering Screen Docking 

A docking feature within the metering explorer allows arrangement and docking of multiple metering 
screens. Clicking and dragging a metering screen tab displays a blue, transparent square, several arrow 
boxes, and a tab box. These docking elements are illustrated in Figure 24 and described in Table 5.  

 

 

 
Figure 24. Metering Screen Docking Options 
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Table 5. Descriptions of Call-outs in Figure 24. 

Call-
Out Symbol Description 

A 

 

Holding the left mouse button down on a metering tab and dragging it to one 
of the four arrow boxes will place the metering tab inside the selected window 
on the location selected. To place the metering tab as a tab inside the 
selected window, drop it on the tabs button in the center of the arrow buttons. 

B  

Holding the left mouse button down on a metering tab and dragging it to this 
arrow box will place it across the top of the screen. Click on the  (thumbtack) 
to dock it on the top bar. To display a screen that is docked, simply use the 
mouse to hover the pointer over the tab on the top bar. 

C  

Holding the left mouse button down on a metering tab and dragging it to this 
arrow box will place it across the side of the screen. Click on the  
(thumbtack) to dock it on the side bar. To display a screen that is docked, 
simply use the mouse to hover the pointer over the tab on the side bar. 

D  

Holding the left mouse button down on a metering tab and dragging it to this 
arrow box will place it across the bottom of the screen. Click on the  
(thumbtack) to dock it on the bottom bar. To display a screen that is docked, 
simply use the mouse to hover the pointer over the tab on the bottom bar. 

E 

 

Holding the left mouse button down on a metering tab and dragging it 
anywhere other than an arrow box will place it as a floating metering screen. 
This floating screen can later be closed by clicking on the  in the upper right 
corner. It can also be dragged to one of the arrow boxes used for docking. 

BESTspace™ 

BESTspace provides the ability to manage customized workspaces. Refer to the BESTCOMSPlus 
chapter for more information on BESTspace. 

Engine 

The Engine metering screen (Figure 25) provides information and metering of engine components. 
Parameters that do not apply to your engine are marked as either NS (not sent) or NA (not applicable). 

The Engine screen is found in the BESTCOMSPlus Metering Explorer. If using the front panel, navigate to 
Metering > Engine. 

 
Figure 25. Metering Explorer, Engine Screen 
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Generator 

This screen provides metering of generator voltages and currents. See Figure 26. 

The Generator screen is found in the BESTCOMSPlus Metering Explorer. If using the front panel, 
navigate to Metering > Generator. 

 
Figure 26. Metering Explorer, Generator Screen 

Power 

This screen provides metering of generator power and power factor. See Figure 27. 

The Power screen is found in the BESTCOMSPlus Metering Explorer. If using the front panel, navigate to 
Metering > Power. 

 
Figure 27. Metering Explorer, Power Screen 

Run Statistics 

This screen provides Cumulative Run Statistics, Session Run Statistics, and Commission Date. See 
Figure 28. 

The Cumulative Run Statistics are tracked from the first time the genset was started. The Session Run 
Statistics are tracked from the last time the genset was started until the following shutdown. 
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The Number of Starts, Hours Until Maintenance, Total kWh, Total Engine Run Time, Loaded Run Time, 
and Unloaded Run time can be changed by clicking the Edit Cumulative Run Statistics button. This is 
helpful when installing the DGC-2020ES into a pre-existing system. This allows the current statistics of 
the genset to be transferred into the DGC-2020ES for uninterrupted tracking. 

The Hours Until Maintenance pre-alarm is configured on the Pre-Alarms screen in the Settings Explorer. 
The Hours Until Maintenance field displays “OFF” when the Maintenance Interval pre-alarm is disabled. 
Clicking Reset Maintenance Interval resets the Hours Until Maintenance to the value set for the 
Maintenance Interval pre-alarm on the Pre-Alarms screen in the Settings Explorer. 

To change the commission date, click Edit DGC Commission Date. The DGC Commission Date dialog 
box appears. Enter the new commission date and click Upload Data to Device. Click Close. Note that the 
Commission Date field on the BESTCOMSPlus screen updates after the Close button is clicked. 

The Run Statistics screen is found in the BESTCOMSPlus Metering Explorer. If using the front panel, 
navigate to Metering > Run Statistics. 

 
Figure 28. Metering Explorer, Run Statistics Screen 

Status Indication 
This screen indicates status of breakers, modes, switches, and I/O connection status. The status is TRUE 
when the corresponding indicator is red. See Figure 29. 

The Status screen is found in the BESTCOMSPlus Metering Explorer. If using the front panel, navigate to 
Metering > Alarms-Status > Status. 
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Figure 29. Metering Explorer, Status Screen 

 

Inputs 

Contact Inputs 
This screen indicates the status of contact inputs, contact input alarms, and contact input pre-alarms. The 
status is TRUE when the corresponding indicator is red. See Figure 30. 

The Contact Inputs screen is found in the BESTCOMSPlus Metering Explorer under the Inputs category. 
If using the front panel, navigate to Metering > Alarms-Status > Inputs. 

 

 
Figure 30. Metering Explorer, Inputs, Contact Inputs Screen 

 

Remote Contact Inputs 
When an optional CEM-2020 (Contact Expansion Module) is connected, the status of the remote contact 
inputs, configurable remote contact input alarms, and remote contact input pre-alarms are shown on this 
screen. The status is TRUE when the corresponding indicator is red. See Figure 31. 

The Remote Contact Inputs screen is found in the BESTCOMSPlus Metering Explorer under the Inputs 
category. If using the front panel, navigate to Metering > Alarms-Status > Inputs. 
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Figure 31. Metering Explorer, Inputs, Remote Contact Inputs Screen 

 

Logic Control Relays 

This screen indicates the status of logic control relays. The status is TRUE when the corresponding 
indicator is green. See Figure 32. 

The Logic Control Relays screen is found in the BESTCOMSPlus Metering Explorer under the Inputs 
category. If using the front panel, navigate to Metering > Alarms-Status > Logic Control Relays. 

 

 
Figure 32. Metering Explorer, Inputs, Logic Control Relays Screen 

Outputs 

Contact Outputs 
This screen indicates the status of contact outputs. The status is TRUE when the corresponding indicator 
is green. See Figure 33. 
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The Contact Outputs screen is found in the BESTCOMSPlus Metering Explorer under the Outputs 
category. If using the front panel, navigate to Metering > Alarms-Status > Outputs. 

 
Figure 33. Metering Explorer, Outputs, Contact Outputs Screen 

 

Remote Contact Outputs 
When an optional CEM-2020 (Contact Expansion Module) is connected, the status of the remote contact 
outputs is shown on this screen. The status is TRUE when the corresponding indicator is green. See 
Figure 34. 

The Remote Contact Outputs screen is found in the BESTCOMSPlus Metering Explorer under the 
Outputs category. If using the front panel, navigate to Metering > Alarms-Status > Outputs. 

 
Figure 34. Metering Explorer, Outputs, Remote Contact Outputs Screen 

Configurable Elements 
This screen indicates the status of configurable elements. It also indicates alarms and pre-alarms of 
configurable elements. The status is TRUE when the corresponding indicator is green. See Figure 35. 
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The Configurable Elements screen is found in the BESTCOMSPlus Metering Explorer under the Outputs 
category. If using the front panel, navigate to Metering > Alarms-Status > Configurable Elements. 

 
Figure 35. Metering Explorer, Outputs, Configurable Elements Screen 

Control 

Controls for stopping/starting the engine, opening/closing breakers, and opening/closing switches are 
accessed using BESTCOMSPlus through the Metering Explorer, Control screen. This set of controls is 
especially useful when commissioning the DGC-2020ES. The PC or laptop running BESTCOMSPlus 
must be connected to the DGC-2020ES via the USB port (see the Communication chapter for details). 
When running BESTCOMSPlus in Live mode, these buttons interact with the DGC-2020ES in real time. 
Otherwise, you will be prompted before the settings are sent.

Using the Metering Explorer in BESTCOMSPlus, open the 
Control branch. Refer to Figure 36. 

Emergency Stop 
The user has control to stop the generator in case of 
emergency by clicking on the Emergency Stop button. 

Engine Control 
The engine can be started and stopped by clicking on the Start 
and Stop buttons. This function requires a connection to a 
properly configured ECU via J1939 (CANbus). 

Run, Auto, Off 
The operating mode can be set to Run, Auto, or Off. 

Generator and Mains Breakers 
There are controls for opening and closing the generator 
breaker and mains breaker. The breaker is open when the 
corresponding indicator is green and closed when red. This 
function requires that the Generator and Mains breakers be 
configured. 

Switches 1 through 4 
Each of these switches can be opened or closed by clicking on 
the Open or Close buttons. The switch is closed when the 
corresponding indicator is red. These buttons control the virtual 
inputs found in BESTLogicPlus Programmable Logic. The 
number of the switch corresponds to the number of the virtual 
input it controls. See the BESTlogicPlus chapter for more 
information. 

 
Figure 36. Metering Explorer,Control 

Screen 
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Auto Export Metering 

This function automatically exports metering data over a user-defined period when a DGC-2020ES 
connection is active. To display the Auto Export Metering screen, click the Tools pull-down menu from the 
upper menu bar and click Auto Export Metering. Specify the Number of Exports and the Interval between 
each export. Enter a filename for the metering data and a folder in which to save. The file is saved in 
.CSV (comma separated values) format. The first export is performed immediately after clicking the Start 
button. Click the Filter button to select specific metering screens. 
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Reporting and Alarms 
The DGC-2020ES monitors ECU data, generator protection functions, and engine senders. An alarm or 
pre-alarm is annunciated when the monitored parameter exceeds its threshold settings. 

When an alarm condition exists, the engine is stopped by opening the Fuel output contact. An existing 
pre-alarm condition is annunciated only. 

When alarms are active, the front panel Overview screen is replaced by the Active Alarms screen. When 
only pre-alarms are active, the front panel Overview screen is alternated with the Active Pre-Alarms 
screen in one-second intervals. Active alarms and pre-alarms can be viewed through BESTCOMSPlus®. 

The front panel Alarm LED is illuminated when alarms are active. When pre-alarms are active, the Alarm 
LED flashes in one-second intervals. 

If programmed and enabled, the horn output is closed when alarms are active. When pre-alarms are 
active, the horn output toggles in one-second intervals. 

Active alarms are also indicated on the optional remote display panel in the form of LEDs and an audible 
horn. Red alarm LEDs light and the horn sounds when the corresponding alarm setting is exceeded. If an 
active alarm condition is not annunciated by the remote display panel, the Switch Not In Auto LED lights 
and the horn sounds. 

Each alarm provides a logic output that can be connected to a physical output or other logic input using 
BESTlogic™Plus Programmable Logic. 

A detailed list of alarms is provided in Table 6. 

Table 6. Available Alarms 

Name Description 
Alarms 
AUTO RESTART FAIL Automatic Restart Failure 
BATT CHRG FAIL Battery Charger Fail 
ECU SHUTDOWN ECU Shutdown 
EMERGENCY STOP Emergency Shutdown 
FUEL LEAK DETECT Fuel Leak Detected 
GEN TRANSFER FL Transfer Fail 
GLBL ALARM Global Alarm 
GLBL SNDR FAIL Global Sender Fail 
HI COOLANT TMP High Coolant Temp 
LOST ECU COMM Loss of ECU Communication 
LOW COOL LEVEL Low Coolant Level 
LOW FUEL LEVEL Low Fuel Level 
LOW OIL PRES Low Oil Pressure 
OVERCRANK Overcrank 
OVERSPEED Overspeed 
UNEXPECTED SHUTDN Unexpected Shutdown 
Pre-alarms 

BATT CHRG FAIL Battery Charger Fail 
BATT OVERVOLT Battery Overvoltage 
BUS REV ROT Reverse Bus Rotation 
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Name Description 
CEM COMM FAIL CEM Communication Failure 
CEM HW MISMATCH CEM Hardware Mismatch 
CHECKSUM FAIL Checksum Failure 
DEF ENGINE DERATE DEF Engine Derate 
DEF FLUID EMPTY DEF Fluid Empty 
DEF FLUID LOW DEF Fluid Low 
DEF INDUCMT O-RIDE DEF Inducement Override 
DEF PRESVR INDUCMT DEF Pre-Severe Inducement 
DEF SEVERE INDUCMT DEF Severe Inducement 
DIAG TRBL CODE Active DTC 
DPF REGEN INHBTD DPF Regenerate Disabled 
DPF REGEN REQD DPF Regenerate Required 
DPF SOOT HIGH DPF Soot Level High 
DPF SOOT LVL EXT HI DPF Soot Level Severely High 
DPF SOOT LVL MOD HI DPF Soot Level Moderately High 
FUEL 1 LEAK Fuel Filter 1 Leak 
FUEL 2 LEAK Fuel Filter 2 Leak 
FUEL LEAK DETECT Fuel Leak Detect 
GEN REV ROT Reverse Generator Rotation 
GN BRK CL FL Breaker Close Failure 
GN BRK OP FL Breaker Open Failure 
HI COOLANT TMP High Coolant Temp 
HIGH EXHAUST TEMP High Exhaust Temperature 
HIGH FUEL LEVEL High Fuel Level 
LOST ECU COMM Loss of ECU Communication 
LOW BATT VOLT Low Battery Voltage 
LOW COOL LEVEL Low Coolant Level 
LOW COOL TMP Low Coolant Temp 
LOW FUEL LEVEL Low Fuel Level 
LOW OIL PRES Low Oil Pressure 
MAINT INTERVAL Maintenance Interval 
MPU FAIL MPU Failure 
MULTIPLE CEM Duplicate CEM 
SERFLASH RD FAIL Serial Flash Read Failure 
WEAK BATTERY Weak Battery Voltage 
Sender Fail 
COOL SNDR FAIL Coolant Temp Sender Fail 
FUEL LEVEL SNDR Fuel Level Sender Fail 
LOSS OF VOLT Voltage Sensing Fail 
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Name Description 
OIL SNDR FAIL Oil Pressure Sender Fail 
SPD SNDR FAIL 
 Speed Sender Fail 

Generator Protection 
27 UNDVOLT TRP Undervoltage (27) 
47 PHS IMBAL TRP Phase Imbalance (47) 
50 OVRCURR TRP Overcurrent (50) 
59 OVRVOLT TRP Overvoltage (59) 
81O OVRFREQ TRP Frequency (81O) 
81U UNDFREQ TRP Frequency (81U) 

Alarm Configuration 

Alarms, pre-alarms, sender failure alarms, and the audible horn can be configured through 
BESTCOMSPlus or the front panel. 

Alarms 
To configure alarms using BESTCOMSPlus, open the Alarm screen (Figure 37). This screen is found in 
the Settings Explorer under the Alarm Configuration category. If using the front panel, navigate to 
Settings > Alarm Configuration > Alarms. 

 
Figure 37. Settings Explorer, Alarm Configuration, Alarms Screen 

The alarm settings are described below. 

High Coolant Temp 

High coolant temperature alarm settings consist of an enable/disable setting, a threshold setting, and an 
arming delay. If enabled, a high coolant temperature alarm is triggered instantaneously when the engine 
coolant temperature exceeds the threshold setting. The arming delay disables the high coolant 
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temperature alarm function for a user-adjustable period after engine startup. System units are configured 
on the System Settings screen. 

Low Oil Pressure 

Low oil pressure alarm settings consist of an enable/disable setting, a threshold setting, and an arming 
delay. If enabled, a low oil pressure alarm is triggered instantaneously when the engine oil pressure 
decreases below the threshold setting. The arming delay disables the low oil pressure alarm function for a 
user-adjustable period after engine startup. System units and metric pressure units are configured on the 
System Settings screen. 

Overspeed 

Overspeed alarm settings include an enable/disable setting, a threshold setting, and an activation delay. 
If enabled, an overspeed alarm occurs when the engine speed (in rpm) exceeds the threshold setting for 
the duration of the activation time delay. 

Low Fuel Level 

Low fuel level alarm settings consist of an enable/disable setting, a threshold setting, and an activation 
delay setting. If enabled, a low fuel level alarm is triggered when the metered fuel level drops below the 
threshold setting for the duration of the activation time delay. 

Low Coolant Level 

Low coolant level alarm settings consist of an enable/disable setting and a threshold setting. If enabled, a 
low coolant level alarm is triggered when the metered coolant level drops below the threshold setting. 
ECU Support must be enabled on the Communications, CAN Bus, CAN Bus Setup screen before this 
alarm can be configured. 

Pre-alarms 
To configure pre-alarms using BESTCOMSPlus, open the Pre-Alarms screen (Figure 38). This screen is 
found in the Settings Explorer under the Alarm Configuration category. If using the front panel, navigate to 
Settings > Alarm Configuration > Pre-alarms. 

The pre-alarm settings are described below. 

High Fuel Level 

High fuel level pre-alarm settings consist of an enable/disable setting, a threshold setting, and an 
activation delay. If enabled, a high fuel level pre-alarm is triggered when the metered fuel level increases 
above the threshold setting for the duration of the activation delay. 

Low Fuel Level 

Low fuel level pre-alarm settings consist of an enable/disable setting and a threshold setting. If enabled, a 
low fuel level pre-alarm is triggered when the metered fuel level decreases below the threshold setting. 

Low Battery Voltage 

Low battery voltage pre-alarm settings consist of an enable/disable setting, a threshold setting, and an 
activation delay. If enabled, a low battery voltage pre-alarm is triggered when the battery voltage 
decreases below the threshold setting for the duration of the activation time delay. The threshold can be 
entered in actual volts or a per-unit value. The per-unit threshold value is based on the nominal battery 
voltage setting found on the System Parameters, Rated Data screen. 

High Coolant Temp 

High coolant temperature pre-alarm settings consist of an enable/disable setting and a threshold setting. 
If enabled, a high coolant temperature pre-alarm is annunciated when the engine coolant temperature 
exceeds the threshold setting for a fixed duration of 60 seconds. System units are configured on the 
System Settings screen. 
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Weak Battery Voltage 

Weak battery voltage pre-alarm settings consist of an enable/disable setting, a threshold setting, and an 
activation time delay. If enabled, a weak battery voltage pre-alarm latches during engine cranking when 
the battery voltage decreases below the threshold setting for the duration of the activation delay. The 
threshold can be entered in actual volts or a per-unit value. The per-unit threshold value is based on the 
nominal battery voltage setting found on the System Parameters, Rated Data screen. 

Low Coolant Temp 

Low coolant temperature pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low coolant temperature pre-alarm occurs when the engine coolant temperature decreases 
below the threshold setting. System units are configured on the System Settings screen. 

Battery Overvoltage 

Battery overvoltage pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a battery overvoltage pre-alarm occurs when the battery voltage increases above the threshold 
setting. The threshold can be entered in actual volts or a per-unit value. The per-unit threshold value is 
based on the nominal battery voltage setting found on the System Parameters, Rated Data screen. 

ECU Coms Fail 

ECU communication failure pre-alarm settings consist of a single enable/disable setting. If enabled, this 
pre-alarm is triggered when the DGC-2020ES detects a problem in its J1939 CAN connection to the ECU. 

Coolant Level 

Low coolant level pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low coolant level pre-alarm is triggered when the metered coolant level decreases below the 
threshold setting. 

Maintenance Interval 

Maintenance interval pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a maintenance interval pre-alarm is annunciated when the DGC-2020ES maintenance timer 
counts down to zero from the threshold time setting. 

Active DTC 

Active DTC (diagnostic trouble code) pre-alarm settings consist of a single enable/disable setting. If 
J1939 CAN and DTC support are both enabled, an “active DTC” pre-alarm can be enabled. This pre-
alarm is triggered when a DTC is sent from the ECU to the DGC-2020ES. 

Low Oil Pressure 

Low oil pressure pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low oil pressure pre-alarm is annunciated when the engine oil pressure decreases below the 
threshold setting for a fixed duration of 10 seconds. System units and metric pressure units are 
configured on the System Settings screen. 

CEM Comm Failure 

CEM-2020 communication failure pre-alarm settings consist of a single enable/disable setting. If enabled, 
this pre-alarm is triggered when communication between the optional CEM-2020 and DGC-2020ES is 
lost. 

Checksum Failure 

When one of the internal checksum calculations, used for data integrity purposes, has failed, the 
checksum failure pre-alarm is triggered. This indicates that some of the user settings or firmware code 
has been corrupted. 

After upgrading firmware through BESTCOMSPlus , the checksum failure pre-alarm may trigger. This pre-
alarm is not indicative of an error in this case. It can be cleared by cycling power to the DGC-2020ES. If 
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the pre-alarm reoccurs, then it is indicative of an error and corrective action should be taken. See 
Resetting Alarms, Checksum Failure, below, for more information. 

Breaker Close Failure 

If enabled, this pre-alarm is triggered when the DGC-2020ES has issued a "breaker close" output and has 
not received "breaker closed" feedback from the breaker within the allowed closing time. The Monitor 
setting determines whether this condition is monitored only during transitions or always. 

Breaker Open Failure 

If enabled, this pre-alarm is triggered when the DGC-2020ES has issued a "breaker open" output and has 
not received "breaker opened" feedback from the breaker within the allowed closing time. The Monitor 
setting determines whether this condition is monitored only during transitions or always. 

Reverse Rotation 

If enabled, this pre-alarm is triggered when the Generator or Bus rotation is opposite of the Phase 
Rotation setting defined on the Rated Data screen. 
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Figure 38. Settings Explorer, Alarm Configuration, Pre-Alarms Screen 

Horn Configuration 
To configure the audible horn using BESTCOMSPlus, open the Horn Configuration screen (Figure 39). 
This screen is found in the Settings Explorer under the Alarm Configuration category. If using the front 
panel, navigate to Settings > Alarm Configuration > Horn Configuration. 

An output contact is configured through programmable logic to energize an audible horn when an alarm 
or pre-alarm condition exists. The horn settings consist of an enable/disable setting and a Not in Auto 
enable/disable setting. If enabled, the contact output is closed when an alarm condition exists. The 
contact output is toggled between open and closed when a pre-alarm condition exists. If the Not in Auto 
setting is enabled, the horn is disabled when the DGC-2020ES is not operating in Auto mode. 
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Figure 39. Settings Explorer, Alarm Configuration, Horn Configuration Screen 

Sender Failure 
To configure sender failure alarms using BESTCOMSPlus, open the Sender Fail screen (Figure 40). This 
screen is found in the Settings Explorer under the Alarm Configuration category. If using the front panel, 
navigate to Settings > Alarm Configuration > Sender Fail. 

Coolant temperature, oil pressure, fuel level, and voltage sensing sender failure settings consist of an 
alarm configuration setting and an activation delay. The alarm configuration setting allows selection of the 
type of alarm to be annunciated when a sender fail condition exists. None, Alarm, and Pre-alarm can be 
selected. The selected alarm type is triggered when a sender failure exists for the duration of the 
activation time delay. 

Speed sender failure settings consist of a single activation delay. An alarm is triggered when a speed 
sender failure exists for the duration of the activation time delay. 

 
Figure 40. Settings Explorer, Alarm Configuration, Sender Fail Screen 

Retrieving Alarm Information 

Alarms can be viewed on the front panel display and through BESTCOMSPlus. 

Front Panel Display 
The lists of active alarms and pre-alarms can be viewed by navigating to Metering > Alarms-Status > 
Active Alarms or Active Pre-alarms. These lists are scrollable by using the Up and Down pushbuttons. 
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BESTCOMSPlus® 
The status of each alarm and pre-alarm is displayed on the Alarms screen (Figure 41). This screen is 
found in the Metering Explorer. Alarms with a red indicator are active. 

 
Figure 41. Metering Explorer, Alarms Screen 

Resetting Alarms and Pre-Alarms 

Most pre-alarms automatically reset when the alarm condition no longer exists. Pre-alarms that do not 
automatically reset are listed below: 

• Weak Battery 
• Breaker Fail to Open 
• Breaker Fail to Close 

These pre-alarms are reset by navigating to the Overview screen on the front panel display and holding 
the Back pushbutton for two seconds. 

Alarms do not automatically reset. Manually reset alarms by pressing the Off pushbutton. 

Horn 
The audible horn can be silenced by simultaneously pressing the Back and Edit pushbuttons. This does 
not reset the alarm or pre-alarm causing the horn to annunciate. 

Maintenance Interval 
To reset the maintenance interval pre-alarm through the front panel, navigate to the Settings > System 
Params > System Settings > Maint Reset screen. Operator, Settings, or OEM access level is required to 
reset the maintenance interval pre-alarm. If the maintenance interval pre-alarm is not enabled, the Maint 
Reset parameter is not visible on the front panel. 

To reset the maintenance interval pre-alarm by using BESTCOMSPlus, use the Metering Explorer to 
open the Run Statistics screen and click on the Reset Maintenance Interval button. 

To reset the maintenance interval pre-alarm from the front panel, navigate to the Overview screen and 
hold the Back pushbutton for 12 seconds. 
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Checksum Failure 
The checksum failure pre-alarm can be cleared by holding the Back pushbutton for two seconds while 
displaying the Overview screen. However, the pre-alarm will reoccur the next time the checksum is 
verified if the data is still corrupted. Some checksum calculations are done only on power-up, so this may 
not occur until the next time operating power is cycled. 

If there are consistent checksum failure pre-alarms, attempt the following actions to correct the problem: 

1. Load default settings by holding the Up and Down pushbuttons on the front panel while cycling 
power. After loading defaults, upload the settings file through BESTCOMSPlus if necessary. 

 

Caution 
Loading default settings will erase all custom settings. All reports and 
events will be cleared. It is recommended that all settings are 
downloaded and saved through BESTCOMSPlus before attempting to 
load defaults. Once defaults are loaded, the saved settings can then 
be uploaded. 

 

2. If the problem persists, reload the firmware file through BESTCOMSPlus. See the 
BESTCOMSPlus chapter for more information. 

3. Contact Basler Electric Technical Support. 

4. The checksum failure pre-alarm can be disabled. This disables only the annunciation of the pre-
alarm and does not correct any error conditions. 

 

 

Reporting and Alarms  DGC-2020ES 



9469200990 Rev B 79 

Event Recording 
An event log retains history of system events in nonvolatile memory. Thirty event records are retained and 
each record contains a time stamp of the first and last event occurrence, and the number of occurrences 
for each event. In addition, each record contains details of the time, date, and engine hours for the most 
recent 30 occurrences of the event. The number of occurrences stops incrementing at 99. If an event 
occurs which is of a type that differs from those in the 30 records in memory, the record that has the 
oldest “last” event occurrence is removed from the log, and the new category takes its place. Since 30 
event records with up to 99 occurrences each are retained in memory, a history of nearly 3,000 specific 
events are retained by the DGC-2020ES. Detailed occurrence information is retained for the most recent 
30 occurrences of each event record, and there are 30 event records. Thus the time, date, and engine 
hours details for up to 900 specific event occurrences are retained in the event log. 

Event Log 

An event log can be downloaded into BESTCOMSPlus® for viewing and storage. The Options button is 
used to save the entire event log to a file, or to save the list to the computer clipboard making it available 
for insertion into other software applications. It is possible to copy a portion of the log to the computer 
clipboard by selecting the desired portion with the mouse then using the Options->Copy Selection feature. 
The Download button refreshes the event log list by performing a fresh download of the list from the DGC-
2020ES. The Clear button gives the user the option of clearing selected or all event logs. Refer to Figure 
42. 

 
Figure 42. Metering Explorer, Event Log Screen (Sorted by Event ID) 
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The event log may also be viewed on the front panel display by navigating to Metering, Alarms-Status, 
Event Log. Use the Up/Down keys to highlight an event and press the Right key to view the summary of 
that event record. The summary contains the description of the event, date, time, and engine hours of the 
first occurrence of the event, along with date, time, and engine hours of the most recent occurrence of the 
event. To view details of specific event occurrences, press the Down key until DETAILS is highlighted and 
then press the Right key. The occurrence number can be changed by pressing the Edit key, Up/Down 
keys to select #, and pressing the Edit key again to exit. Table 7 lists all possible event strings (as shown 
in the event log). 

Table 7. Event List 

Event String Event Description Event Type 
27 UNDVOLT TRP A 27 Undervoltage Trip Alarm 

27 UNDVOLT TRP P 27 Undervoltage Trip Pre-Alarm 

47 PHS IMBAL TRP A 47 Phase Imbalance Trip Alarm 

47 PHS IMBAL TRP P 47 Phase Imbalance Trip Pre-Alarm 

50 OVRCURR TRP A 50 Overcurrent Trip Alarm 

50 OVRCURR TRP P 50 Overcurrent Trip Pre-Alarm 

59 OVRVOLT TRP A 59 Overvoltage Trip Alarm 

59 OVRVOLT TRP P 59 Overvoltage Trip Pre-Alarm 

81O OVRFREQ TRP A 81 Overfrequency Trip Alarm 

81O OVRFREQ TRP P 81 Overfrequency Trip Pre-Alarm 

81U UNDFREQ TRP A 81 Underfrequency Trip Alarm 

81U UNDFREQ TRP P 81 Underfrequency Trip Pre-Alarm 

ATS INPUT CLOSED ATS Input Status 

AUTO RESTART Automatic Restart in Progress Status 

AUTO RESTART FAIL A Automatic Restart Fail Alarm 

BATT CHRG FAIL A Battery Charger Fail Alarm 

BATT CHRG FAIL P Battery Charger Fail Pre-Alarm 

BATT OVERVOLT P Battery Overvoltage Pre-Alarm 

BATTLE OVERRIDE Battle Override Status 

CAN BUS OFF CAN Bus entered Bus Off state Status 

CAN ERROR PASSIVE CAN Bus entered Error Passive state Status 

CEM COMM FAIL P CEM-2020 Communications Failure Pre-Alarm 

CEM HW MISMATCH P Connected CEM-2020 is wrong type Pre-Alarm 

CHECKSUM FAIL P Corrupt user settings or firmware code Pre-Alarm 

COMBINED RED A Combined Red Alarm 

COMBINED YELLOW P Combined Yellow Pre-Alarm 

CONFIG ELEMENT X A (X = 1 to 8) Configurable Element X (X = 1 to 8) Alarm 

CONFIG ELEMENT X P (X = 1 to 8) Configurable Element X (X = 1 to 8) Pre-Alarm 

COOL LVL SNDR FL A Coolant Level Sender Fail Alarm 

COOL SNDR FAIL Coolant Temperature Sender Fail Status 

COOL SNDR FAIL A Coolant Temperature Sender Fail Alarm 

COOL SNDR FAIL P Coolant Temperature Sender Fail Pre-Alarm 

DEF ENGINE DERATE P Diesel Exhaust Fluid Engine Derate Pre-Alarm 

DEF FLUID EMPTY P Diesel Exhaust Fluid Empty Pre-Alarm 

DEF FLUID LOW P Diesel Exhaust Fluid Low Pre-Alarm 

DEF INDUCMT O-RIDE P Diesel Exhaust Fluid Inducement Override Pre-Alarm 
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Event String Event Description Event Type 
DEF PRESVR INDUCMT P Diesel Exhaust Fluid Pre-Severe Inducement Pre-Alarm 

DEF SEVERE INDUCMT P Diesel Exhaust Fluid Severe inducement Pre-Alarm 

DGC HEARTBEAT FAIL P DGC Heartbeat Fail Pre-Alarm 

DIAG TRBL CODE P Diagnostic Trouble Code Pre-Alarm 

DPF REGNRATE DISABLD P Diesel Particulate Filter Regeneration Disabled Pre-Alarm 

DPF REGEN REQD P Diesel Particulate Filter Regeneration Required Pre-Alarm 

DPF SOOT LVL EXT HI P Diesel Particulate Filter Soot Level Extremely High Pre-Alarm 

DPF SOOT LVL MOD HI P Diesel Particulate Filter Soot Level Moderately High Pre-Alarm 

ECU SHUTDOWN A ECU Shutdown Alarm 

EMERGENCY STOP A Emergency Stop Alarm 

ENGINE RUNNING Engine Running Status 

FUEL FLT PRS HI P Fuel Filter Differential Pressure High Pre-Alarm 

FUEL LEAK 1 P Fuel Filter 1 Leak Pre-Alarm 

FUEL LEAK 2 P Fuel Filter 2 Leak Pre-Alarm 

FUEL LEAK DETECT A Fuel Leak Detect Alarm 

FUEL LEAK DETECT P Fuel Leak Detect Pre-Alarm 

FUEL LEVL SENDR A Fuel Level Sender Fail Alarm 

FUEL LEVL SENDR FAIL Fuel Level Sender Fail Status 

FUEL LEVL SENDR P Fuel Level Sender Fail Pre-Alarm 

GEN TEST LOADED Generator Exerciser Test with Load Status 

GEN TEST UNLOADED Generator Exerciser Test without Load Status 

GLBL SNDR FAIL A Global Sender Fail Alarm 

GN BKR CL FL P Generator Breaker Fail to Close Pre-Alarm 

GN BKR OP FL P Generator Breaker Fail to Open Pre-Alarm 

GN BKR SYN FL P Generator Breaker Synchronization Fail Pre-Alarm 

HI COOLANT TMP A High Coolant Temp Alarm 

HI COOLANT TMP P High Coolant Temp Pre-Alarm 

HI DAY TANK LEVEL P High Day Tank Level Pre-Alarm 

HI ECU VOLTS A High ECU Supply Voltage Alarm 

HI EXHAUSE B T P High Exhaust Temp B Pre-Alarm 

HI EXHAUST A T P High Exhaust Temp A Pre-Alarm 

HI PRESSURE IN 1 P High Pressure Input 1 Pre-Alarm 

HI PRESSURE IN 2 P High Pressure Input 2 Pre-Alarm 

HI SUPPLY VOLTS P High Voltage Supply Pre-Alarm 

HI T FUEL P High Fuel Temp Pre-Alarm 

HIGH AMB TEMP P High Ambient Temp Pre-Alarm 

HIGH CHARGE AIR TEMP A High Charge Air Temp Alarm 

HIGH CHARGE AIR TEMP P High Charge Air Temp Pre-Alarm 

HIGH COIL TEMP 1 P High Temp Coil 1 Pre-Alarm 

HIGH COIL TEMP 2 P High Temp Coil 2 Pre-Alarm 

HIGH COIL TEMP 3 P High Temp Coil 3 Pre-Alarm 

HIGH COOLANT TEMP A High Coolant Temp Alarm 

HIGH COOLANT TEMP P High Coolant Temp Pre-Alarm 
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Event String Event Description Event Type 
HIGH ECU TEMPERATURE P High ECU Temp Pre-Alarm 

HIGH EXHAUST TEMP P High Exhaust Temp Pre-Alarm 

HIGH FUEL LEVEL P High Fuel Level Pre-Alarm 

HIGH FUEL RAIL PRESS P High Fuel Rail Pressure Pre-Alarm 

HIGH INTRCOOLER TEMP P High Intercooler Temp Pre-Alarm 

HIGH OIL TEMPERATURE P High Oil Temp Pre-Alarm 

HIGH OIL TERMPERATURE A High Oil Temp Alarm 

HIGH STRG TANK LEVEL P High Storage Tank Level Pre-Alarm 

IDLE SPD LO P Idle Speed Low Pre-Alarm 

INPUT X A (X = 1 to 17) User Configurable Input X (X = 1 to 17) Alarm 

INPUT X P (X = 1 to 17) User Configurable Input X (X = 1 to 17) Pre-Alarm 

LO AFTERCLR COOL LVL A Low After Cooler Cool Level Alarm 

LO CHG AIR CLNT LVL P Low Charge Air Coolant Level Pre-Alarm 

LO DAY TANK LEVEL P Low Day Tank Level Pre-Alarm 

LO ECU VOLTS P Low ECU Supply Voltage Pre-Alarm 

LO FUEL DLV PRESSURE A Low Fuel Delivery Pressure Alarm 

LO SUPPLY VOLTS P Low Voltage Supply Pre-Alarm 

LOAD TAKEOVER Load Takeover Status 

LOGIC OUPUT A Logic Output Alarm 

LOGIC OUPUT P Logic Output Pre-Alarm 

LOSS OF VOLT Voltage Sensing Fail Status 

LOSS OF VOLT A Voltage Sensing Fail Alarm 

LOSS OF VOLT P Voltage Sensing Fail Pre-Alarm 

LOSS REM COMS P Loss of Remote Module Communication Pre-Alarm 

LOST ECU COMM A Loss of ECU Communication Alarm 

LOST ECU COMM P Loss of ECU Communication Pre-Alarm 

LOW BATT VOLT P Low Battery Voltage Pre-Alarm 

LOW CHARGE AIR PRESS P Low Charge Air Pressure Pre-Alarm 

LOW COOL LEVEL A Low Coolant Level Alarm 

LOW COOL LEVEL P Low Coolant Level Pre-Alarm 

LOW COOL TMP A Low Coolant Temperature Alarm 

LOW COOL TMP P Low Coolant Temperature Pre-Alarm 

LOW COOLANT LEVEL P Low Coolant Level Pre-Alarm 

LOW FUEL DELIV PRESS P Low Fuel Delivery Pressure Pre-Alarm 

LOW FUEL LEVEL A Low Fuel Level Alarm 

LOW FUEL LEVEL P Low Fuel Level Pre-Alarm 

LOW FUEL RAIL PRESS P Low Fuel Rail Pressure Pre-Alarm 

LOW OIL PRES A Low Oil Pressure Alarm 

LOW OIL PRES P Low Oil Pressure Pre-Alarm 

LOW OIL PRESSURE A Low Oil Pressure Alarm 

LOW OIL PRESSURE P Low Oil Pressure Pre-Alarm 

LOW STRG TANK LEVEL P Low Storage Tank Level Pre-Alarm 

MAINS FAIL TEST Mains Fail Test Status 
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Event String Event Description Event Type 
MAINT INTERVAL P Maintenance Interval Pre-Alarm 

MF TRANSFER Mains Fail Transfer Complete Status 

MF TRANSFER FAIL Mains Fail Transfer Fail Status 

MN BKR CL FL P Mains Breaker Fail to Close Pre-Alarm 

MN BKR OP FL P Mains Breaker Fail to Open Pre-Alarm 

MPU FAIL P Magnetic Pickup Fail Pre-Alarm 

MULTIPLE CEM P Multiple CEM-2020’s Pre-Alarm 

NORM SHUTDOWN Normal Shutdown Status 

OIL SNDR FAIL Oil Pressure Sender Fail Status 

OIL SNDR FAIL A Oil Pressure Sender Fail Alarm 

OIL SNDR FAIL P Oil Pressure Sender Fail Pre-Alarm 

OVERCRANK A Overcrank Alarm 

OVERSPD TEST ON P Overspeed Test On Pre-Alarm 

OVERSPEED A Overspeed Alarm 

PRIMING FAULT P Priming Fault Pre-Alarm 

PROT SHUTDOWN Protective Shutdown Status 

REV BUS ROT P Reverse Bus Rotation Pre-Alarm 

REV GEN ROT P Reverse Generator Rotation Pre-Alarm 

RUNUP SPD LO P Run Up Speed Low Pre-Alarm 

SERFLASH RD FAIL Serial Flash Read Fail Pre-Alarm 

SPD SNDR FAIL Speed Sender Fail Status 

SPD SNDR FAIL A Speed Sender Fail Alarm 

SPEED DMD FL P Speed Demand Fail Pre-Alarm 

SPEED TOO LOW P Engine Speed Too Low Pre-Alarm 

SS OVERRIDE ON P Shutdown Override Pre-Alarm 

START SPEED LOW P Start Speed Low Pre-Alarm 

VOLTAGE SENSE FAIL Voltage Sensing Fail Status 

VOLTAGE SENSE FAIL A Voltage Sensing Fail Alarm 

VOLTAGE SENSE FAIL P Voltage Sensing Fail Pre-Alarm 

WEAK BATTERY P Weak Battery Pre-Alarm 
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Mounting 
DGC-2020ES controllers are delivered in sturdy cartons to prevent shipping damage. Upon receipt of a 
unit, check the part number against the requisition and packing list for agreement. Inspect for damage, 
and if there is evidence of such, immediately file a claim with the carrier and notify the Basler Electric 
regional sales office or your sales representative. 

If the device is not installed immediately, store it in the original shipping package in a moisture- and dust-
free environment. 

Hardware 

The front panel is resistant to moisture, salt fog, humidity, dust, dirt, and chemical contaminants. DGC-
2020ES controllers are mounted using the four permanently attached 10-24 studs. The torque applied to 
the mounting hardware should not exceed 20 inch-pounds (2.2 newton meters). 

Dimensions 

Panel cutting and drilling dimensions are shown in Figure 43. Overall dimensions are shown in Figure 44. 
All dimensions are shown in inches with millimeters in parenthesis. 

 

 
Figure 43. Panel Cutting and Drilling Dimensions 
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Figure 44. Overall Dimensions 
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Terminals and Connectors 
All DGC-2020ES terminals and connectors are located on the rear panel. DGC-2020ES terminals consist 
of a mini-B USB socket and plug-in connectors with spring clamp terminals. 

Figure 45 illustrates the rear panel terminals. Locator letters in the illustration correspond to the terminal 
block and connector descriptions in Table 8. 

 
Figure 45. Rear Panel 
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Table 8. Rear Panel Terminal and Connector Descriptions 

Locator Description 
A The majority of external, DGC-2020ES wiring is terminated at 8- or 15-position 

connectors with spring clamp terminals. These connectors plug into headers on the 
DGC-2020ES. The connectors and headers have a dovetailed edge that ensures 
proper connector orientation. Each connector and header is uniquely keyed to ensure 
that a connector mates only with the correct header. Spring clamp terminals accept a 
maximum wire size of 12 AWG. 

B The mini-B USB socket mates with a standard USB cable and is used with a PC 
running BESTCOMSPlus® software for local communication with the DGC-2020ES. 

Connections 

DGC-2020ES connections are dependent on the application. Incorrect wiring may result in damage to the 
controller. 

 

Note 

Be sure that the DGC-2020ES is hard-wired to earth ground with no 
smaller than 12 AWG copper wire attached to the chassis ground 
terminal (terminal 1) on the rear of the controller. 

Operating power from the battery must be of the correct polarity. 
Although reverse polarity will not cause damage, the DGC-2020ES will 
not operate. 

For the DGC-2020ES to correctly meter power factor, the generator 
must be rotating clockwise (A-B-C). 

The DGC-2020ES terminals are grouped by function and include operating power, generator current 
sensing, generator voltage sensing, bus voltage sensing, analog engine sender inputs, magnetic pickup 
input, contact sensing inputs, output contacts, USB interface, CAN interface, and Remote Display Panel 
connections. 

DGC-2020ES terminal groups are described in the following paragraphs. 

Operating Power 

The DGC-2020ES operating power input accepts either 12 Vdc or 24 Vdc and tolerates voltage over the 
range of 6 to 32 Vdc. Operating power must be of the correct polarity. Although reverse polarity will not 
cause damage, the DGC-2020ES will not operate. Operating power terminals are listed in Table 9. 

It is recommended that a fuse be added for additional protection for the wiring to the battery input of the 
DGC-2020ES. A fuse helps prevent wire damage and nuisance trips due to initial power supply inrush 
current. To follow UL guidelines, a 5 A maximum, 32 Vdc supplementary fuse must be implemented in the 
battery input circuit to the DGC-2020ES 

Table 9. Operating Power Terminals 

Terminal Description 
16 (CHASSIS) Chassis ground connection 

17 (BATT–) Negative side of operating power input 

18 (BATT+) Positive side of operating power input 
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Generator Current Sensing 

The DGC-2020ES has sensing inputs for A-phase, B-phase, and C-phase generator current. A DGC-
2020ES with a style number of 1xx has a 1 Aac nominal current sensing and a DGC-2020ES with a style 
number of 5xx indicates 5 Aac nominal current sensing. Generator current sensing terminals are listed in 
Table 10. 

Table 10. Generator Current Sensing Terminals 

Terminals Description 
37 (IA–) A-phase current sensing input 

38 (IA+) 
35 (IB–) B-phase current sensing input 

36 (IB+) 

33 (IC–) C-phase current sensing input 

34 (IC+) 

 

Note 
Unused current sensing inputs should be shorted to minimize noise 
pickup. 

 

Caution 
Generator current sensing terminals 37 (IA–), 35 (IB–), and 33 (IC–) 
must be terminated to ground for proper operation. 

Generator Voltage Sensing 

The DGC-2020ES accepts either line-to-line or line-to-neutral generator sensing voltage over the range of 
12 to 576 volts, rms line-to-line. Generator voltage sensing terminals are listed in Table 11. 

Table 11. Generator Voltage Sensing Terminals 

Terminal Description 
40 (GEN VN) Neutral generator voltage sensing input 

41 (GEN VC) C-phase generator voltage sensing input 

43 (GEN VB) B-phase generator voltage sensing input 

45 (GEN VA) A-phase generator voltage sensing input 

Bus Voltage Sensing 

Sensing of bus voltage enables the DGC-2020ES to detect failures of the mains (utility). The DGC-
2020ES senses A-phase, B-phase, and C-phase bus voltage. Bus voltage sensing terminals are listed in 
Table 12. 
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Table 12. Bus Voltage Sensing Terminals 

Terminal Description 
46 (BUS VA) A-phase bus voltage sensing input 

48 (BUS VB) B-phase bus voltage sensing input 

50 (BUS VC) C-phase bus voltage sensing input 

Analog Engine Sender Inputs 

Inputs are provided for oil pressure, fuel level, and coolant temperature senders. For a listing of oil 
pressure, fuel level, and coolant temperature senders that are compatible with the DGC-2020ES, refer to 
the Engine Sender Inputs chapter. Analog engine sender input terminals are listed in Table 13. 

Table 13. Sender Input Terminals 

Terminal Description 
1 (FUEL) Fuel level sender input 

2 (SENDER COM) Sender return terminal 
52 (OIL) Oil pressure sender input 

53 (COOLANT) Coolant temperature sender input 

Magnetic Pickup Input 

The magnetic pickup input accepts a speed signal over the range of 3 to 35 volts peak and 32 to 10,000 
hertz. Magnetic pickup input terminals are listed in Table 14. 

Table 14. Magnetic Pickup Input Terminals 

Terminals Description 
31 (MPU–) Magnetic pickup return input 

32 (MPU+) Magnetic pickup positive input 

Contact Sensing Inputs 

Contact sensing inputs consist of seven programmable inputs. The programmable inputs accept normally 
open, dry contacts. Terminal 17 (BATT–) serves as the common return line for the programmable inputs. 
While input 1 is programmed to recognize an emergency stop input by default, it can be programmed for 
any function. Information about configuring the programmable inputs is provided in the Contact Inputs 
chapter. Contact sensing input terminals are listed in Table 15. 

Table 15. Contact Sensing Inputs 

Terminal Description 
17 (BATT–) Common return line for programmable contact inputs 
3 (INPUT 1) Programmable contact input 1 (ESTOP by default) 
4 (INPUT 2) Programmable contact input 2 
5 (INPUT 3) Programmable contact input 3 
6 (INPUT 4) Programmable contact input 4 
7 (INPUT 5) Programmable contact input 5 
8 (INPUT 6) Programmable contact input 6 
9 (INPUT 7) Programmable contact input 7 
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Output Contacts 

The DGC-2020ES has three sets of fixed-function output contacts: Pre, Start, and Run. The Pre contacts 
supply battery power to the engine glow plugs, the Start contacts supply power to the starter solenoid, 
and the Run contacts supply power to the fuel solenoid. Connections to the three sets of contacts are 
made at terminals 19 through 24. The Pre, Start, and Run relay terminals are listed in Table 16. 

Table 16. Fixed-Function Output Contact Terminals 

Terminal Description 
19 (START) Start output contact (Start solenoid) 

20 (START) 
21 (RUN) Run output contact (Fuel solenoid) 

22 (RUN) 

23 (PRE) Pre-start output contact (Glow plugs) 

24 (PRE) 

 

Four programmable output contacts are provided in two sets. Each set of two output contacts share a 
common terminal. Programmable output contact terminals are listed in Table 17. 

Table 17. Programmable Output Contact Terminals 

Terminal Description 
25 (COM 1, 2) Common connection for outputs 1 and 2 

26 (OUT 1) Programmable output 1 

27 (OUT 2) Programmable output 2 

28 (COM 3, 4) Common connection for outputs 3 and 4 

29 (OUT 3) Programmable output 3 

30 (OUT 4) Programmable output 4 

USB Interface 

A mini-B USB socket enables local communication with a PC running BESTCOMSPlus software. The 
DGC-2020ES is connected to a PC using a standard USB cable equipped with a type A plug on one end 
(PC termination) and a mini-B plug on the other end (DGC-2020ES termination). 

CAN Interface 

These terminals provide communication using the SAE J1939 protocol or the MTU protocol and provide 
high-speed communication between the DGC-2020ES and an ECU on an electronically controlled engine. 
Connections between the ECU and DGC-2020ES should be made with twisted-pair, shielded cable. CAN 
interface terminals are listed in Table 18. For typical CAN connections, refer to the Typical Connections 
chapter. 

Table 18. CAN Interface Terminals 

Terminals Description 
13 (CAN H) CAN high connection 

14 (CAN L) CAN low connection 
15 (SHIELD) CAN drain connection 
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Note 

1. If the DGC-2020ES is providing one end of the J1939 bus, a 
120 Ω, ½ watt terminating resistor should be installed across 
terminals 14 (CANL) and 13 (CANH). 

2. If the DGC-2020ES is not providing one end of the J1939 bus, the 
stub connecting the DGC-2020ES to the bus should not exceed 
914 mm (3 ft) in length. 

3. The maximum bus length, not including stubs, is 40 m (131 ft). 

4. The J1939 drain (shield) should be grounded at one point only. If 
grounded elsewhere, do not connect the drain to the DGC-
2020ES 

Optional Remote Display Panel Connections 

Terminals are provided for connection with the optional Remote Display Panel. These terminals provide 
dc operating power to the Remote Display Panel and enable communication between the DGC-2020ES 
and Remote Display Panel. Twisted-pair conductors are recommended for connecting the communication 
terminals of the DGC-2020ES and Remote Display Panel. Communication may become unreliable if the 
connection wires exceed 1,219 m (4,000 ft). Table 19 lists the DGC-2020ES terminals that connect to the 
Remote Display Panel. 

Table 19. Remote Display Panel Interface Terminals 

Terminal Description 
10 (RDP TxD–) Remote Display Panel terminal (TxD–) 

11 (RDP TxD+) Remote Display Panel terminal (TxD+) 

17 (BATT–) Remote Display Panel terminal DC COM (–) 

18 (BATT+) Remote Display Panel terminal 12/24 (+) 
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Typical Connections 
Typical connection diagrams are provided in this chapter as a guide when wiring the DGC-2020ES for 
communication, mechanical senders, contact inputs and outputs, sensing, and operating power. 

Connections for Typical Applications 

Typical connections for applications using three-phase wye, three-phase delta, single-phase AB, and 
single-phase AC generator voltage sensing are shown on the following pages. 

Figure 46 illustrates typical three-phase wye generator voltage sensing connections. 

 
Figure 46. 3-Phase Wye Connections for Typical Applications 
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Figure 47 illustrates typical three-phase delta generator voltage sensing connections. 

 

 
Figure 47. 3-Phase Delta Connections for Typical Applications 
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Figure 48 illustrates typical single-phase A-B generator voltage sensing connections. 

 

 
Figure 48. Single-Phase A-B Connections for Typical Applications 
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Figure 49 illustrates typical single-phase A-C generator voltage sensing connections. 

 
Figure 49. Single-Phase A-C Connections for Typical Applications 
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CAN Connections 

Typical CAN connections are shown in Figure 50 and Figure 51. 
 

Note 

1. If the DGC-2020ES is providing one end of the J1939 bus, a 
120 Ω, ½ watt terminating resistor should be installed across 
terminals 14 (CANL) and 13 (CANH). 

2. If the DGC-2020ES is not providing one end of the J1939 bus, the 
stub connecting the DGC-2020ES to the bus should not exceed 
914 mm (3 ft) in length. 

3. The maximum bus length, not including stubs, is 40 m (131 ft). 

4. The J1939 drain (shield) should be grounded at one point only. If 
grounded elsewhere, do not connect the drain to the DGC-
2020ES. 

 

 
Figure 50. CAN Interface with DGC-2020ES Providing One End of the Bus 

 
Figure 51. CAN Interface with Other Devices 
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CEM-2020 Connections 

The CEM-2020 (Contact Expansion Module) is an optional module that may be installed with the DGC-
2020ES. It is a remote auxiliary device that provides additional contact inputs and outputs for the DGC-
2020ES. This module interfaces to the DGC-2020ES via CAN, thus the CAN terminals are the only 
common connections (Figure 52) between the DGC-2020ES and CEM-2020. Refer to the CEM-2020 
chapter for more information. 

Refer to Terminals and Connectors for details on DGC-2020ES CAN connections. 

 

 
Figure 52. DGC-2020ES and CEM-2020 CAN Connections 

Installation for CE Systems 

For CE compliant systems, it may be required to route ac voltage and current sensing wires separately 
from other wires. 
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BESTCOMSPlus® 
BESTCOMSPlus® is a Windows®-based, PC application that provides a user-friendly, graphical user 
interface (GUI) for use with Basler Electric communicating products. The name BESTCOMSPlus is an 
acronym that stands for Basler Electric Software Tool for Communications, Operations, Maintenance, and 
Settings. 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the DGC-2020ES. 
The capabilities of BESTCOMSPlus make the configuration of one or several DGC-2020ES controllers 
fast and efficient. A primary advantage of BESTCOMSPlus is that a settings scheme can be created, 
saved as a file, and then uploaded to the DGC-2020ES at the user’s convenience. 

BESTCOMSPlus uses plugins, allowing the user to manage several different Basler Electric products. 
The DGC-2020ES plugin must be activated before use. The plugin can be activated automatically by 
connecting to a DGC-2020ES, or manually by requesting an activation key from Basler Electric. 

The DGC-2020ES plugin opens inside the BESTCOMSPlus main shell. The same default logic scheme 
that is shipped with the DGC-2020ES is brought into BESTCOMSPlus by downloading settings and logic 
from the DGC-2020ES. This gives the user the option of developing a custom setting file by modifying the 
default logic scheme or by building a unique scheme from scratch. 

BESTlogic™Plus Programmable Logic is used to program DGC-2020ES logic for protection elements, 
inputs, outputs, alarms, etc. This is accomplished by drag-and-drop method. The user can drag elements, 
components, inputs, and outputs onto the program grid and make connections between them to create 
the desired logic scheme. 

Figure 53 illustrates the typical user interface components of the DGC-2020ES plugin with 
BESTCOMSPlus. 

 

 
Figure 53. Typical User Interface Components 
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System Recommendations 

BESTCOMSPlus software is built on the Microsoft® .NET Framework. The setup utility that installs 
BESTCOMSPlus on your PC also installs the DGC-2020ES plugin and the required version of .NET 
Framework (if not already installed). BESTCOMSPlus operates with systems using Windows® XP 32-bit 
SP2/SP3, Windows Vista 32-bit (all editions), Windows 7 32-bit (all editions), and Windows 7 64-bit (all 
editions). Microsoft Internet Explorer 5.01 or later must be installed on your PC before installing 
BESTCOMSPlus. System recommendations for the .NET Framework and BESTCOMSPlus are listed in 
Table 20. 

Table 20. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 1.0 GHz 

32/64 bit RAM 512 MB (minimum) 

32 bit Hard Drive 75 MB (if .NET Framework is already installed on PC) 
925 MB (if .NET Framework is not already installed on PC) 

64 bit Hard Drive 75 MB (if .NET Framework is already installed on PC) 

2.1 GB (if .NET Framework is not already installed on PC) 

To install and run BESTCOMSPlus, a Windows user must have Administrator rights. A Windows user with 
limited rights might not be permitted to save files in certain folders. 

Installation 

 

Note 

Do not connect a USB cable until setup completes successfully. 
Connecting a USB cable before setup is complete may result in errors. 

 

1. Insert the BESTCOMSPlus CD-ROM into the PC CD-ROM drive. 

2. When the BESTCOMSPlus Setup and Documentation CD menu appears, click the Install button for 
the BESTCOMSPlus application. The setup utility installs BESTCOMSPlus, the .NET Framework (if 
not already installed), the USB driver, and the DGC-2020ES plugin for BESTCOMSPlus on your PC. 

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts 
BESTCOMSPlus when clicked. 

Activation of the DGC-2020ES Plugin 

The DGC-2020ES plugin is a module that runs inside the BESTCOMSPlus shell. The DGC-2020ES 
plugin contains specific operational and logic settings for only the DGC-2020ES. Uploading settings to the 
DGC-2020ES is possible only after activating the DGC-2020ES plugin. 

The DGC-2020ES plugin can be activated automatically or manually. Automatic activation is achieved by 
using a USB cable to establish communication between the DGC-2020ES and BESTCOMSPlus. Manual 
activation is initiated by contacting Basler Electric for an activation key and entering the key into 
BESTCOMSPlus. Manual activation is useful if you want to create a settings file prior to receiving your 
DGC-2020ES. Refer to Manual Activation of DGC-2020ES Plugin. 

BESTCOMSPlus®  DGC-2020ES 
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Connect a USB Cable 
The USB driver was copied to your PC during BESTCOMSPlus installation and is installed automatically 
after powering the DGC-2020ES. USB driver installation progress is shown in the Windows taskbar area. 
Windows will notify you when installation is complete. 

Connect a USB cable between the PC and your DGC-2020ES. Apply operating power to the DGC-
2020ES. Wait until the boot sequence is complete. 

Start BESTCOMSPlus® and Activate the DGC-2020ES Plugin Automatically 
To start BESTCOMSPlus, click the Windows Start button, point to Programs, Basler Electric, and then 
click the BESTCOMSPlus icon. During initial startup, the BESTCOMSPlus Select Language screen is 
displayed (Figure 54). You can choose to have this screen displayed each time BESTCOMSPlus is 
started, or you can select a preferred language and this screen will be bypassed in the future. Click OK to 
continue. This screen can be accessed later by selecting Tools and Select Language from the menu bar. 

 
Figure 54. BESTCOMSPlus Language Selection Dialog 

The BESTCOMSPlus platform window opens. Select New Connection from the Communication pull-down 
menu and select DGC-2020ES. See Figure 55. The DGC-2020ES plugin is activated automatically after 
connecting to a DGC-2020ES. 

 
Figure 55. Communication Pull-Down Menu 

The DGC-2020ES Connection screen, shown in Figure 56, appears. 
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Figure 56. DGC-2020ES Connection Dialog 

Select USB via Serial RS232, USB, and enter COM Port. The USB drivers are installed automatically 
during the BESTCOMSPlus installation process. To select the correct COM Port, open the Windows 
Device Manager and expand the Ports (COM & LPT) branch. Locate the device named CP2101 USB to 
UART Bridge Controller (COMx). The COM Port number will be displayed in parenthesis (COMx). Be sure 
operating power is applied to the DGC-2020ES and the USB cable is connected before opening the 
Device Manager. See Figure 57. 

 
Figure 57. Device Manager 

The DGC-2020ES plugin opens indicating that activation was successful. You can now configure the 
DGC-2020ES communication ports and other settings. 

Installing the USB Driver if Automatic Installation Fails 
To install the USB driver for the DGC-2020ES: 

1. Apply operating power to the DGC-2020ES and wait for the boot sequence to complete. 
2. Connect a USB cable between the PC and DGC-2020ES. 
3. The Found New Hardware Wizard dialog box appears. 
4. Select “No, not this time” and select Next to continue. 
5. Choose to “Install from a list or specific location (Advanced)” and select Next to continue. 
6. Insert the CD-ROM labeled BESTCOMSPlus into the PC CD-ROM drive. 
7. Navigate to C:\Program Files\Basler Electric\BESTCOMSPlus\USBDeviceDrivers\ and select 

Next to continue. 

When installation of the driver is complete, you may be asked to restart your computer. 
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Manual Activation of the DGC-2020ES Plugin 
Manual activation of the DGC-2020ES plugin is required only if your initial use of BESTCOMSPlus will be 
on a PC that is not connected to a DGC-2020ES. Manual activation is described in the following 
paragraphs. 

Requesting an Activation Key 

When initially running the DGC-2020ES plugin, the Activate Device Plugin pop-up appears. You must 
contact Basler Electric for an activation key before you can activate the DGC-2020ES plugin. You can 
request an activation key through email or the Basler Electric website. Click either the Website or Email 
button. Click the Activate button when you are ready to enter the activation key you received from Basler 
Electric. The Activate Device Plugin pop-up appears. Refer to Figure 58. 

Entering an Activation Key 

Select DGC-2020ES from the Device pull-down menu. Enter your Email Address and Activation Key 
provided by Basler Electric. If you received an email containing the Activation Key, you can select all of 
the text in the email and copy it to the Windows clipboard using normal Windows techniques. The Get 
Data button will extract the Device, Email Address, and Activation Key from the Windows clipboard and 
paste it into the appropriate fields. Click the Activate button to continue. The Activate Device Plugin 
screen is also found by selecting Activate Device from the Tools pull-down menu of the BESTCOMSPlus 
main screen. 

 
Figure 58. Activate Device Plugin 

Menu Bars 

The menu bars are located near the top of the BESTCOMSPlus window (see Figure 53). The upper menu 
bar has five pull-down menus. With the upper menu bar, it is possible to manage settings files, configure 
communication settings, upload and download settings/security files, and compare settings files. The 
lower menu bar consists of clickable icons. The lower menu bar is used to change BESTCOMSPlus 
views, save or load a BESTspace™ workspace, open a settings file, connect/disconnect, preview 
metering printout, export metering, switch to live mode, and send settings to the DGC-2020ES. 

Upper Menu Bar (BESTCOMSPlus® Shell) 
Upper menu bar functions are listed and described in Table 21. 
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Table 21. Upper Menu Bar (BESTCOMSPlus Shell) 

Menu Item Description 
File 

New Create a new settings file 

Open Open an existing settings file 

Open File As Text Generic file viewer for *.csv, *,txt, etc. files 

Close Close settings file 

Save Save settings file 

Save As Save settings file with a different name 

Export To File Save settings as a *.csv file 

Print Print, export, or send a settings file 

Properties View properties of a settings file 

History View history of a settings file 

Recent Files Open a previously opened file 

Exit Close BESTCOMSPlus program 

Communication 
New Connection Choose new device or DGC-2020ES 

Close Connection Close communication between BESTCOMSPlus and DGC-2020ES 

Download Settings and Logic from 
Device 

Download operational and logic settings from the device 

Upload Settings and Logic to Device Upload operational and logic settings to the device 

Upload Settings to Device Upload operational settings to the device 

Upload Logic to Device Upload logic settings to the device 

Download Security from Device Download security settings from the device 

Upload Security to Device Upload security settings to the device 

Upload Device Files Upload firmware to the device 

Tools 
Select Language Select BESTCOMSPlus language 

Activate Device Activate the DGC-2020ES plugin 

Set File Password Password protect a settings file 

Compare Settings Files Compare two settings files 

Auto Export Metering Exports metering data on a user-defined interval 

Event Log - View View the BESTCOMSPlus event log 

Event Log - Clear Clear the BESTCOMSPlus event log 

Event Log - Set New File Name Set a new file name for event log 

Window 
Cascade All Cascade all windows 

Tile Tile horizontally or vertically 

Maximize All Maximize all windows 

Help 
Check for Updates Check for BESTCOMSPlus updates via the internet 

Check for Update Settings Enable or change automatic checking for updates 

About View general, detailed build, and system information 
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Lower Menu Bar (DGC-2020ES Plugin) 
The lower menu bar functions are listed and described in Table 22. 

Table 22. Lower Menu Bar (DGC-2020ES Plugin) 

Menu Button Description 

 Enables you to show/hide the Metering Panel, Settings Panel, or Settings Info 
Panel. 

Opens and saves BESTspace™ workspaces. Customized workspaces make 
switching between tasks easier and more efficient. 

 Opens a saved settings file. 

 Connect: Opens the DGC-2020ES Connection screen which enables you to 
connect to the DGC-2020ES via USB or a modem. This button only appears 
when a DGC-2020ES is not connected. 

 Disconnect: Used to disconnect a connected DGC-2020ES. This button only 
appears when a DGC-2020ES is connected. 

 Displays the Print Preview screen where a preview of the Metering printout is 
shown. Click on the printer button to send to a printer. 

 Enables all metering values to be exported into a *.csv file. 

 Displays a drop-down list entitled Live Mode Settings which enables Live mode 
where settings are automatically sent to the device in real time as they are 
changed. 

 Sends settings to the DGC-2020ES when BESTCOMSPlus is not operating in 
Live Mode. Click this button after making a setting change to send the modified 
setting to the DGC-2020ES. 

Settings Explorer 

The Settings Explorer is a convenient tool within BESTCOMSPlus used to navigate through the various 
settings screens of the DGC-2020ES plugin. 

These screens allow the user to edit general settings, communications, system parameters, 
programmable inputs, programmable outputs, alarm configuration, generator protection, breaker 
management, programmable senders, and BESTlogicPlus programmable logic. 

Logic setup will be necessary after making certain setting changes. For more information, refer to the 
BESTlogicPlus chapter. 

Metering Explorer 

The Metering Explorer is a convenient tool within BESTCOMSPlus used to navigate through the various 
metering screens of the DGC-2020ES plugin. 

These screens allow the user to view real-time system data including generator voltages and currents, 
input/output status, alarms, reports, and other parameters. Refer to the Metering chapter for more 
information on the Metering Explorer. 

DGC-2020ES BESTCOMSPlus® 
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BESTspace™ 

BESTspace provides the ability to manage customized workspaces. A workspace consists of the position 
and size of all open screens within BESTCOMSPlus. Pre-saved workspaces can be quickly loaded to fit 
the specific task at hand. Any number of different workspaces can be saved including a default 
workspace which loads when the DGC-2020ES plug-in is started. The Metering Explorer screens and the 
Settings Explorer screens can be saved independently into the workspace file. A Comments box is 
provided for writing a description or leaving notes for each saved workspace. To access BESTspace, click 
View (on the lower menu bar) and hover over BESTspace. Figure 59 illustrates the BESTspace options 
found under the View pull-down menu. Figure 60 illustrates the options included in the Load/Save 
Workspace File screen. 

 
Figure 59. View Menu, BESTspace™ Options 

 
Figure 60. View Menu, BESTspace™, Save Workspace Screen  

Settings File Management 

A settings file contains all DGC-2020ES settings, including logic. A settings file assumes a file extension 
of “∗.bstx”. It is possible to save the logic only as a separate logic library file on the BESTlogicPlus 
Programmable Logic screen. This function is helpful when similar logic is required for several devices. A 
logic library file assumes a file extension of “∗.bslx”. It is important to note that settings and logic can be 
uploaded to the device together or separately, but are always downloaded together. For more information 
on logic files, refer to the BESTlogicPlus chapter. 
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Opening a Settings File 
To open a DGC-2020ES settings file with BESTCOMSPlus, pull down the File menu and choose Open. 
The Open dialog box appears. This dialog box allows you to use normal Windows techniques to select 
the file that you want to open. Select the file and choose Open. You can also open a file by clicking on the 
Open File button on the lower menu bar. If connected to a device, you will be asked to upload the settings 
and logic from the file to the current device. If you choose Yes, the settings displayed in BESTCOMSPlus 
will be overwritten with the settings of the opened file. 

Saving a Settings File 
Select Save or Save As from the File pull-down menu. A dialog box appears allowing you to enter a 
filename and location to save the file. Select the Save button to complete the save. 

Upload Settings and/or Logic to Device 
To upload a settings file to the DGC-2020ES, open the file through BESTCOMSPlus or create the file 
using BESTCOMSPlus. Then pull down the Communication menu and select Upload Settings and Logic 
to Device. If you want to upload operational settings without logic, select Upload Settings to Device. If you 
want to upload logic without operational settings, select Upload Logic to Device. You are prompted to 
enter the password. The default password is “OEM”. If the password is correct, the upload begins and the 
progress bar is shown. 

Download Settings and Logic from Device 
To download settings and logic from the DGC-2020ES, pull down the Communication menu and select 
Download Settings and Logic from Device. If the settings in BESTCOMSPlus have changed, a dialog box 
will open asking if you want to save the current settings changes. You can choose Yes or No. After you 
have taken the required action to save or discard the current settings, downloading begins. 
BESTCOMSPlus will read all settings and logic from the DGC-2020ES and load them into 
BESTCOMSPlus memory. 

Print a Settings File 
To view a preview of the settings printout, select Print Preview from the File pull-down menu. To print the 
settings, select the printer icon in the upper left corner of the Print Preview screen. 

You can skip the print preview and go directly to print by pulling down the File menu and selecting Print. A 
dialog box opens containing the typical Windows options for setting the properties of the printer. 
Configure these settings as necessary and then select Print. 

Compare Settings Files 
BESTCOMSPlus has the ability to compare two settings files. To compare files, pull down the Tools menu 
and select Compare Settings Files. The BESTCOMSPlus Settings Compare Setup dialog box appears 
(Figure 61). Select the location of the first file under Left Settings Source and select the location of the 
second file under Right Settings Source. If you are comparing a settings file located on your PC hard 
drive or portable media, click the folder button and navigate to the file. If you want to compare settings 
downloaded from a unit, click the Select Unit button to set up the communication port. Click the Compare 
button to compare the selected settings files.   
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Figure 61. Tools, Compare Settings Files Screen 

A dialog box appears, displaying the results of the comparison. The BESTCOMSPlus Settings Compare 
dialog box (Figure 62) is displayed where you can view all settings (Show All Settings), view only the 
differences (Show Settings Differences), view all logic (Show All Logic Paths), or view only logic 
differences (Show Logic Path Differences). Select Close when finished. 

 
Figure 62. Settings Comparison Results Screen 
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Firmware Updates 

Future enhancements to the DGC-2020ES functionality will make a firmware update desirable. Because 
default settings are loaded when DGC-2020ES firmware is updated, your settings should be saved in a 
file prior to upgrading firmware. 

Note 

The latest version of BESTCOMSPlus software should be downloaded 
from the Basler Electric website and installed before performing a 
firmware upgrade. 

A device package contains firmware and a language module. Embedded firmware is the operating 
program that controls the actions of the DGC-2020ES. The DGC-2020ES stores firmware in nonvolatile 
flash memory that can be reprogrammed through the communication ports. It is not necessary to replace 
EPROM chips when updating the firmware with a newer version. 

The language of the front panel LCD can be changed by uploading a different language module into the 
DGC-2020ES. The DGC-2020ES stores the language module in nonvolatile flash memory; the language 
module contains all language translations for the DGC-2020ES. The language module can be 
reprogrammed through the communications port. In general, any time a firmware upgrade is made to the 
DGC-2020ES, the language module should be uploaded as well. 

The DGC-2020ES can be used in conjunction with the Contact Expansion Module (CEM-2020) which 
expands the DGC-2020ES capabilities. When upgrading the firmware in any component of this system, 
the firmware in ALL of the components of the system should be upgraded to ensure compatibility of 
communications between the components. 
 

Caution 

The order in which the components are upgraded is critical. Assuming 
a system of a DGC-2020ES and expansion module is in a state where 
the DGC-2020ES is communicating with the system expansion 
module, the expansion module must be upgraded before the 
DGC-2020ES. This is necessary because the DGC-2020ES must be 
able to communicate with the expansion module before the DGC-
2020ES can send firmware to it. If the DGC-2020ES were upgraded 
first, and the new firmware included a change to the expansion 
module communication protocol, it is possible that the expansion 
module could no longer communicate with the upgraded DGC-
2020ES. Without communications between the DGC-2020ES and the 
expansion module, upgrading the expansion module is not possible. 

 

Note 

If power is lost or communication is interrupted during file transfer to 
the DGC-2020ES, it will cease to operate and will not recover 
automatically. If this occurs or if the front panel HMI becomes blank 
and all LEDs are flashing at a two-second rate, the DGC-2020ES will 
not have valid firmware installed and the firmware must be uploaded 
again. To accomplish this, cycle power to the DGC-2020ES and 
activate the DGC-2020ES plugin in BESTCOMSPlus. Select Upload 
Device Files from the Communication pull-down menu and proceed 
normally. 
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Upgrading Firmware in Expansion Modules 
The following procedure is used to upgrade firmware in the DGC-2020ES expansion module. This must 
be completed before upgrading firmware in the DGC-2020ES. If no expansion module is present, proceed 
to Upgrading Firmware in the DGC-2020ES. 

1. Place the DGC-2020ES in OFF mode. This can be accomplished by clicking the Off button on the 
Control screen inside the Metering Explorer or by pressing the Off button on the DGC-2020ES front 
panel. 

2. Enable the expansion module that is present in the system. If it has not already been enabled, enable 
the expansion module on the SETTINGS->SYSTEM PARAMETERS->REMOTE MODULE SETUP 
screen. 

3. Verify that the DGC-2020ES and the associated expansion module are communicating. This can be 
verified by examining the pre-alarm status using the Metering Explorer in BESTCOMSPlus or from 
the front panel by navigating to METERING->ALARMS-STATUS->PRE-ALARMS. There should be 
no Loss of Comms pre-alarms in the pre-alarm status when communications are functioning properly. 

4. Connect to the DGC-2020ES through the USB port if not already connected. 

5. Select Upload Device Files from the Communication pull-down menu. 

6. You will be asked to save the current settings file. Select Yes or No. 

7. When the Basler Electric Device Package Uploader screen (Figure 63) appears, click on the Open 
button to browse for the device package you have received from Basler Electric. The Package Files 
along with File Details are listed. Place a check in the boxes next to the individual files you want to 
upload. 

 
Figure 63. Basler Electric Device Package Uploader 

8. Click on the Upload button and the Proceed with Device Upload screen will appear. Select Yes or No. 

9. After selecting Yes, the DGC-2020ES Selection screen will appear. Select the communication port to 
begin upload. Refer to Figure 64. 

10. After file(s) have been uploaded, click the Close button on the Basler Electric Device Package 
Uploader screen and disconnect communication to the DGC-2020ES.   
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Figure 64. DGC-2020ES Selection 

Upgrading Firmware in the DGC-2020ES 
Upgrade DGC-2020ES firmware and then load a saved settings file. 

1. Upgrade the DGC-2020ES firmware and language module. 

a. Connect to the DGC-2020ES with BESTCOMSPlus. Check the firmware Application 
Version on the GENERAL SETTINGS-> VERSION INFO->DGC-2020ES screen. 

b. Select Upload Device Files from the Communication pull-down menu. You do not have to 
be connected to the DGC-2020ES at this time. Save settings when prompted, if desired. 

c. Open the desired device package file (∗∗∗∗DGC-2020ES-∗∗∗∗∗_xxyyzz.bef, where ∗∗∗∗ 
may be additional descriptive text of varying length, and xx.yy.zz is the version number of 
the device package file.) 

d. Check the boxes for DGC-2020ES Firmware and DGC-2020ES Language Module. Note 
the version number of the DGC-2020ES firmware; this is the version that will be used to 
set the Application Version in the settings file in a later step. This is NOT the same as the 
version of the package file that is contained in the fields xx.yy.zz in the package file 
name. 

e. Click the Upload button and follow the instructions that appear to begin the upgrade 
process. 

f. After the upload is complete, disconnect communication to the DGC-2020ES. 

2. Load the saved settings file into the DGC-2020ES. 

a. Close all settings files. 

b. From the File pull-down menu, select New, DGC-2020ES. 

c. Connect to the DGC-2020ES. 

d. Once all settings have been read from the DGC-2020ES, open the saved settings file by 
selecting the file with File, Open File in the BESTCOMSPlus menu. 

e. When BESTCOMSPlus asks if you wish to upload settings and logic to the device, click 
Yes. 

f. If you are receiving upload failures and indications that the logic is incompatible with the 
firmware version, check that the DGC-2020ES style number in the saved file matches 
that of the DGC-2020ES into which the file is being uploaded. The style number in the 
settings file is found under GENERAL SETTINGS->STYLE NUMBER in 
BESTCOMSPlus. 

g. If the style number of the settings file does not match that of the DGC-2020ES into which 
it is to be loaded, disconnect from the DGC-2020ES, then modify the style number in the 
settings file. Then repeat the steps titled Load the Settings File into the DGC-2020ES. 
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BESTCOMSPlus® Updates 

Ongoing DGC-2020ES functionality enhancements may make future DGC-2020ES firmware updates 
desirable. Enhancements to DGC-2020ES firmware typically coincide with enhancements to the DGC-
2020ES plugin for BESTCOMSPlus. When a DGC-2020ES is updated with the latest version of firmware, 
the latest version of BESTCOMSPlus should also be obtained. 

• If you obtained a CD-ROM containing a firmware update from Basler Electric, then that CD-ROM 
will also contain the corresponding version of BESTCOMSPlus software. 

• You can check for BESTCOMSPlus updates by visiting www.basler.com. 

• You can use the manual “check for updates” function in BESTCOMSPlus to ensure that the latest 
version is installed by selecting Check for Updates in the Help drop-down menu. (An internet 
connection is required.) 
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BESTlogic™Plus 
BESTlogicPlus Programmable Logic is a programming method used for managing the input, output, 
protection, control, monitoring, and reporting capabilities of Basler Electric's DGC-2020ES Digital Genset 
Controller. Each DGC-2020ES has multiple, self-contained logic blocks that have all of the inputs and 
outputs of its discrete component counterpart. Each independent logic block interacts with control inputs 
and hardware outputs based on logic variables defined in equation form with BESTlogicPlus. 
BESTlogicPlus equations entered and saved in the DGC-2020ES system's nonvolatile memory integrate 
(electronically wire) the selected or enabled protection and control blocks with control inputs and 
hardware outputs. A group of logic equations defining the logic of the DGC-2020ES is called a logic 
scheme. 

One default active logic scheme is preloaded into the DGC-2020ES. This scheme is configured for a 
typical protection and control application and virtually eliminates the need for "start-from-scratch" 
programming. BESTCOMSPlus® can be used to open a logic scheme that was previously saved as a file 
and upload it to the DGC-2020ES. The default logic scheme can also be customized to suit your 
application. Detailed information about logic schemes is provided later in this section. 

BESTlogicPlus is not used to define the operating settings (modes, pickup thresholds, and time delays) of 
the individual protection and control functions. Operating settings and logic settings are interdependent 
but separately programmed functions. Changing logic settings is similar to rewiring a panel and is 
separate and distinct from making the operating settings that control the pickup thresholds and time 
delays of a DGC-2020ES. Detailed information about operating settings is provided in the 
BESTCOMSPlus chapter. 

Overview of BESTlogic™Plus 
Use BESTCOMSPlus to change BESTlogicPlus settings. Use the Settings Explorer to open the 
BESTlogicPlus Programmable Logic tree branch as shown in Figure 65. 

The BESTlogicPlus Programmable Logic screen contains a logic library for opening and saving logic files, 
tools for creating and editing logic documents, and protection settings. 

 
Figure 65. Settings Explorer, BESTlogicPlus Programmable Logic Screen 
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BESTlogic™Plus Composition 

There are three main groups of objects used for programming BESTlogicPlus. These groups are I/O, 
Components, and Elements. For details on how these objects are used to program BESTlogicPlus, see 
the paragraphs on Programming BESTlogicPlus, later in this chapter. 

I/O 
This group contains Input Objects, Output Objects, Alarms, Pre-Alarms, Senders, and Logic Control 
Relays. Table 23 lists the names and descriptions of the objects in the I/O group. 

Table 23. I/O Group, Names and Descriptions 

Name Description Symbol 
Input Objects 
Logic 0 Always false (Low). 

 
Logic 1 Always true (High). 

 
Physical Inputs 
IN1 – IN7 

True when Physical Input x is active. 

 
Remote Inputs 
IN8 – IN17 

True when Remote Input x is active. (Available when 
an optional CEM-2020 is connected.) 

 
Virtual Inputs 
VIN1 – VIN4 

True when Virtual Input x is active. 

 
Status Input 
Alarm Silence 

True when the Alarm Silence logic element is true or 
the Alarm Silence button is pressed on the front panel. 

 
Status Input 
Alternate 
Frequency 
Override 

True when the Alternate Frequency Override logic 
element is true. 

 

Status Input 
ATS Input 

True when the ATS (Auto Transfer Switch) input is true 
or the ATS logic element is true. 

 
Status Input 
Audible Horn 

True when the Audible Horn is active. 

 
Status Input 
Auto Mode 

True when the DGC-2020ES is in Auto Mode or the 
Auto Mode logic element is true. 

 
Status Input 
Auto Restart 

True when the Automatic Restart function is active. 

 
Status Input 
Battery Charger 
Fail 

True when the Battery Charger Fail input is true. 

 
Status Input 
Battle Override 

True when the Battle Override input is true. 

 
Status Input 
Bus Dead 

True when the Bus Dead condition settings have been 
exceeded. 
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Name Description Symbol 
Status Input 
Bus Fail 

True when the Bus Fail condition settings have been 
exceeded. 

 
Status Input 
Bus Forward 
Rotation 

True when the bus rotation matches the Phase 
Rotation setting. 

 

Status Input 
Bus Reverse 
Rotation 

True when the bus rotation is opposite of the Phase 
Rotation setting. 

 
Status Input 
Bus Stable 

True when the Bus Stable condition settings have been 
exceeded. 

 
Status Input 
CANBus Bus 
Off 

True when the CANBus bus is off. 

 

Status Input 
CANBus Error 
Passive 

True when a passive error is annunciated by the 
CANBus. 

 

Status Input 
Configurable 
Elements 1-8 

True when the Configurable Element x logic element is 
true. 

 

Status Input 
Contact 
Expansion 
Module 

Contact Expansion Module Connected. True when an 
optional CEM-2020 is connected to the DGC-2020ES. 

 

Status Input 
Cool Down 
Timer Active 

True when the Cool Down Timer is timing out. The 
Cool Down Timer is true under two circumstances: 
1. The unit is in auto and ATS is removed, causing 

the DGC-2020ES to go into a cooldown state. 
2. The engine is running (in RUN or AUTO mode 

with ATS applied) and the load has been removed 
(i.e. the EPSSUPLOAD status input is false due to 
small load). If the load is reapplied, the Cool Down 
Timer stops and resets, and it will restart when the 
load is removed the next time. 

 

Status Input 
Emergency 
Stop 

True when the Emergency Stop button has been 
pressed. 

 
Status Input 
Engine Running 

True while the Engine is Running. 

 
Status Input 
EPS Supplying 
Load 

True while the EPS is supplying load. 

 
Status Input 
Front Panel 
Buttons 

True while the Auto front panel button is pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Down front panel button is pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Edit front panel button is pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Up and Down front panel buttons are 
simultaneously pressed. 
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Name Description Symbol 
Status Input 
Front Panel 
Buttons 

True while the Off front panel button is pressed. 

 

Status Input 
Front Panel 
Buttons 

True while the Back front panel button is pressed. 

 
Status Input 
Restart Delay 
Active 

True when the restart delay is currently active. 

 

Status Input 
Front Panel 
Buttons 

True while the Run front panel button is pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Back and Edit front panel buttons are 
simultaneously pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Up front panel button is pressed. 

 
Status Input 
Fuel Leak 

True when the Fuel Leak Detect input is true. 

 
Status Input 
Generator 
Breaker Status 

True when the generator breaker is closed. 

 
Status Input 
Generator Dead 

True when the Gen Dead condition settings have been 
exceeded. 

 
Status Input 
Generator Fail 

True when the Gen Fail condition settings have been 
exceeded. 

 
Status Input 
Generator 
Forward 
Rotation 

True when the generator rotation matches the Phase 
Rotation setting. 

 

Status Input 
Generator 
Protection 

True when the 27 element is tripped. 

 

Status Input 
Generator 
Protection 

True when the 59 element is tripped. 

 

Status Input 
Generator 
Protection 

True when the 47 element is tripped. 

 
Status Input 
Generator 
Protection 

True when the 50 element is tripped. 

 

Status Input 
Generator 
Protection 

True when the 81 Over element is tripped. 

 
Status Input 
Generator 
Protection 

True when the 81 Under element is tripped. 
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Name Description Symbol 
Status Input 
Generator 
Reverse 
Rotation 

True when the generator rotation is opposite of the 
Phase Rotation setting. 

 

Status Input 
Generator 
Stable 

True when the Gen Stable condition settings have 
been exceeded. 

 
Status Input 
Generator Test 
Loaded 

True when the Exercise Timer has started the 
generator and run with load is selected. 

 
Status Input 
Generator Test 

True when the Exercise Timer has started the 
generator. 

 
Status Input 
Global Low 
Coolant Level 

True when the Low Coolant Level input is true. 

 
Status Input 
Ground Delta 
Override 

True when the Grounded Delta Override input is true. 

 
Status Input 
Idle Request 

True when the Idle Request logic element is true. 

 
Status Input 
In Alarm State 

True when the DGC-2020ES is in the alarm state. 

 
Status Input 
In Connecting 
State 

True when the DGC-2020ES is in the connecting state. 

 

Status Input 
In Cooling State 

True when the DGC-2020ES is in the cooling state. 

 
Status Input 
In Cranking 
State 

True when the DGC-2020ES is in the cranking state. 

 

Status Input 
In Disconnect 
State 

True when the DGC-2020ES is in the disconnect state. 

 

Status Input 
In Prestart State 

True when the DGC-2020ES is in the pre-start state. 

 
Status Input 
In Pulsing State 

True when the DGC-2020ES is in the pulsing state. 

 
Status Input 
In Ready State 

True when the DGC-2020ES is in the ready state. 

 
Status Input 
In Resting State 

True when the DGC-2020ES is in the resting state. 

 
Status Input 
In Running 
State 

True when the DGC-2020ES is in the running state. 

 

Status Input 
Lamp Test 

True when the Lamp Test logic element is true or the 
Lamp Test button is pressed on the front panel. 
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Name Description Symbol 
Status Input 
Load Take Over 

True when the Load Take Over logic element is true. 

 
Status Input 
Low Line 
Override 

True when the Low Line Override input is true. 

 
Status Input 
Mains Breaker 
Status 

True when the mains breaker is closed. 

 

Status Input 
Mains Fail Test 

True when the Mains Fail Test logic element is true. 

 
Status Input 
Mains Fail 
Transfer 
Complete 

True when the DGC-2020ES is configured for mains 
fail transfers and has successfully transferred to the 
generator from the utility. It remains true until the utility 
power is deemed good and the DGC-2020ES transfers 
the load back to utility power. 

 

Status Input 
Off Mode 

True when the DGC-2020ES is in Off Mode or the Off 
Mode logic element is true. 

 
Status Input 
Off Mode 
Cooldown 

True when the DGC-2020ES is in Off Mode and 
cooling down. 

 

Status Input 
Pre Start 
Condition in 
Effect 

True while in the Pre Start state. 

 

Status Input 
Pre Start Input 

True when the DGC-2020ES is indicating that the Pre 
Start relay should be closed. 

 
Status Input 
Reset Active 

True when the Reset logic element is true or when the 
Reset key on the front panel is pressed. 

 
Status Input 
Restart Delay 
Active 

True when the Restart Delay timer is timing out. 

 
Status Input 
Run Input 

True when the DGC-2020ES is indicating that the Run 
relay should be closed. 

 
Status Input 
Run Mode 

True when the DGC-2020ES is in Run Mode or the 
Run Mode logic element is true. 

 
Status Input 
Single Phase 
Connection 
Override 

True when the Single Phase Override input is true. 

 

Status Input 
Switch not in 
Auto 

True when the DGC-2020ES is not in Auto Mode. 

 
Status Input 
Start Input 
 
 
 
 
 

True when the DGC-2020ES is indicating that the Start 
relay should be closed to start the engine. 
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Name Description Symbol 
Output Objects 

Physical 
Outputs 
OUT1 – OUT4 

Physical Outputs 1 through 4. 

 

Remote Outputs 
OUT5 – OUT28 

Remote Outputs 5 through 28. 
(Available when an optional CEM-2020 is connected.) 

 
Alarms 

Auto Restart 
Fail 

True after the Automatic Restart function fails to restart 
the generator. 

 
Battery Charger 
Fail 

True when the Battery Charger Fail function is 
configured as an alarm and the activation delay has 
expired.  

Coolant Level 
Sender Fail 

True when a low coolant level error status code is 
received from the ECU. CANBus must be enabled. 

 

Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is configured 
as an alarm and the activation delay has expired. 

 
ECU Comm 
Loss 

True when communication to ECU has been lost. 

 
ECU Shutdown True when ECU has Shutdown the engine. 

 
Emergency 
Stop 

True when the Emergency Stop button has been 
pressed. 

 
Fuel Leak True when the Fuel Leak Detect function is configured 

as an alarm and the activation delay has expired. 
 

Fuel Level 
Sender Fail 

True when the Fuel Level Sender Fail is configured as 
an alarm and the activation delay has expired. 

 
Generator 
Protection 
27 

True when the 27 element is configured as an alarm 
and has tripped. 

 

Generator 
Protection 
59 

True when the 59 element is configured as an alarm 
and has tripped. 

 

Generator 
Protection 
47 

True when the 47 element is configured as an alarm 
and has tripped. 

 
Generator 
Protection 
50 

True when the 50 element is configured as an alarm 
and has tripped. 

 

Generator 
Protection 
81 Over 

True when the 81 Over element is configured as an 
alarm and has tripped. 

 
Generator 
Protection 
81 Under 

True when the 81 Under element is configured as an 
alarm and has tripped. 
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Name Description Symbol 
Global Alarm True when one or more alarms are set. 

 
Global Sender 
Fail 

True when one or more of the Sender Fails are 
configured as alarms and are true. 

 
Hi Coolant 
Temp 

True when the High Coolant Temp Alarm settings have 
been exceeded. 

 
Low Coolant 
Level 

True when the Low Coolant Level function is 
configured as an alarm and the activation delay has 
expired. In addition, true when CANBus is enabled and 
the Low Coolant Level Alarm threshold has been 
exceeded. 

 

Low Fuel Level True when the Low Fuel Level Alarm settings have 
been exceeded. 

 
Low Oil 
Pressure 

True when the Low Oil Pressure Alarm settings have 
been exceeded. 

 
Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is configured 
as an alarm and the activation delay has expired. 

 
Overcrank True when an Overcrank condition exists. 

 
Overspeed True when the Overspeed Alarm settings have been 

exceeded. 
 

Speed Sender 
Fail 

True when the Speed Sender Fail activation delay has 
expired. 

 
Unexpected 
Shutdown 
Alarm 

True when the metered engine speed (RPM) 
unexpectedly drops to 0 while the engine is running. 

 

Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is configured as 
an alarm and the activation delay has expired. 

 
Pre-Alarms 

Battery Charger 
Fail 

True when the Battery Charger Fail function is 
configured as a pre-alarm and the activation delay has 
expired.  

Battery 
Overvoltage 

True when the Battery Overvoltage pre-alarm threshold 
has been exceeded. 

 
Checksum 
Failure 

True when some of the user settings or firmware code 
has been corrupted. Refer to the Reporting and Alarms 
chapter for more details.  

Contact 
Expansion 
Module 
Multiple Contact 
Expansion 
Modules 
Connected 

True when more than one CEM-2020 is connected. 
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Name Description Symbol 
Contact 
Expansion 
Module 
Contact 
Expansion 
Module Comm 
Fail 

True when communication from the CEM-2020 to the 
DGC-2020ES has been lost. 

 

Contact 
Expansion 
Module 
Contact 
Expansion 
Modules 
Hardware 
Mismatch 

True when the connected CEM-2020 does not have 
the same number of outputs as  defined on the System 
Parameters, Remote Module Setup screen in 
BESTCOMSPlus. 

 

Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is configured 
as a pre-alarm and the activation delay has expired. 

 
DEF Engine 
Derate 

This is the lowest level of inducement not to operate 
the engine when Diesel Exhaust Fluid (DEF) is low or 
of poor quality or there is a problem with the Exhaust 
After Treatment System (EATS). The engine is 
operating in a reduced power mode. Eventually the 
level of inducement will be increased unless the 
problem with the DEF or malfunction in the EATS is 
corrected. 

 

DEF Fluid 
Empty 

True when the engine ECU reports via CANBus that 
Diesel Exhaust Fluid (DEF) is at a level below 8%. 

 
DEF Fluid Low True when the engine ECU reports via CANBus that 

the Diesel Exhaust Fluid (DEF) is at a level between 8 
and 23%.  

DEF 
Inducement 
Override 

This pre-alarm indicates a temporary override of 
inducement not to operate the engine. This is set by 
the ECU and is not a user setting.   

DEF Pre-severe 
Inducement 

This pre-alarm indicates a high level of inducement not 
to operate the engine due to low or poor quality Diesel 
Exhaust Fluid (DEF), or a malfunction in the Exhaust 
After Treatment System (EATS). The engine may 
operate in a reduced power mode, or for a limited time, 
after which it will enter a state of severe inducement 
unless the problem with the DEF or malfunction in the 
EATS is corrected. 

 

DEF Severe 
Inducement 

This pre-alarm indicates the highest level of 
inducement not to operate the engine due to low or 
poor quality Diesel Exhaust Fluid (DEF), or a 
malfunction in the Exhaust After Treatment System 
(EATS). The engine may operate in a reduced power 
mode, or for a limited time, or may be prevented from 
starting by the ECU until the problem is corrected. A 
service tool may be required to restart the engine. 

 

Diag Trouble 
Code 

True when a Diagnostic Trouble Code exists. 

 
DPF 
Regenerate 
Disabled 

True when the Diesel Particulate Filter (DPF) lamp 
status broadcast over CANBus indicates that DPF 
regeneration is inhibited.  
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Name Description Symbol 
DPF 
Regenerate 
Required 

True when the Diesel Particulate Filter (DPF) lamp 
status broadcast over CANBus indicates that DPF 
regeneration is required.  

DPF Soot Level 
High 

True when the engine ECU reports via CANBus that 
Diesel Particulate Filter (DPF) soot level is high. 

 
DPF Soot Level 
Moderately High 

True when Diesel Particulate Filter (DPF) lamp status 
(yellow warning) broadcast over CANBus indicates that 
the soot level is moderately high.  

DPF Soot Level 
Severely High 

True when Diesel Particulate Filter (DPF) lamp status 
(red warning) broadcast over CANBus indicates that 
the soot level is severely high.  

ECU Comm 
Loss 

True when communication to ECU has been lost. 

 
Fuel Leak True when the Fuel Leak Detect function is configured 

as a pre-alarm and the activation delay has expired. 
 

Fuel Level 
Sender Fail 

True when the Fuel Level Sender Fail is configured as 
a pre-alarm and the activation delay has expired. 

 
Generator 
Breaker Close 
Fail 

True when a generator breaker close fail pre-alarm 
occurs. The pre-alarm occurs when the DGC-2020ES 
has issued a generator breaker close output but does 
not receive a generator breaker status input that 
indicates the breaker has closed before the breaker 
close wait time has expired. 

 

Generator 
Breaker Open 
Fail 

True when a generator breaker open fail pre-alarm 
occurs. The pre-alarm occurs when the DGC-2020ES 
has issued a generator breaker open output but does 
not receive a generator breaker status input that 
indicates the breaker has opened before the breaker 
close wait time has expired. 

 

Generator 
Protection 
27 

True when the 27 element is configured as a pre-alarm 
and has tripped. 

 

Generator 
Protection 
59 

True when the 59 element is configured as a pre-alarm 
and has tripped. 

 

Generator 
Protection 
47 

True when the 47 element is configured as a pre-alarm 
and has tripped. 

 
Generator 
Protection 
50 

True when the 50 element is configured as a pre-alarm 
and has tripped. 

 

Generator 
Protection 
81 Over 

True when the 81 Over element is configured as a pre-
alarm and has tripped. 

 
Generator 
Protection 
81 Under 

True when the 81 Under element is configured as a 
pre-alarm and has tripped. 

 
Global Pre-
Alarm 

True when one or more pre-alarms are set. 
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Name Description Symbol 
Hi Coolant 
Temp 

True when the High Coolant Temp Pre-Alarm threshold 
has been exceeded. 

 
High Exhaust 
Temperature 

True when Diesel Particulate Filter (DPF) lamp status 
broadcast over CANBus indicates high exhaust 
temperature.  

High Fuel Level True when the High Fuel Level Pre-Alarm settings 
have been exceeded. 

 
Low Battery 
Voltage 

True when the Low Battery Voltage Pre-Alarm settings 
have been exceeded. 

 
Low Coolant 
Level 

True when the Low Coolant Level function is 
configured as a pre-alarm and the activation delay has 
expired. In addition, true when CANBus is enabled and 
the Low Coolant Level Pre-Alarm threshold has been 
exceeded. 

 

Low Coolant 
Temp 

True when the Low Coolant Temp Pre-Alarm threshold 
has been exceeded. 

 
Low Fuel Level True when the Low Fuel Level Pre-Alarm threshold has 

been exceeded. 
 

Low Oil 
Pressure 

True when the Low Oil Pressure Pre-Alarm threshold 
has been exceeded. 

 
Mains Breaker 
Close Fail 

True when a mains breaker close fail pre-alarm occurs. 
The pre-alarm occurs when the DGC-2020ES has 
issued a mains breaker close output but does not 
receive a mains breaker status input that indicates the 
breaker has closed before the breaker close wait time 
has expired. 

 

Mains Breaker 
Open Fail 

True when a mains breaker open fail pre-alarm occurs. 
The pre-alarm occurs when the DGC-2020ES has 
issued a mains breaker open output but does not 
receive a mains breaker status input that indicates the 
breaker has opened before the breaker close wait time 
has expired. 

 

Mains Fail 
Transfer Failed 

True when a mains fail transfer fail pre-alarm occurs. 
The pre-alarm occurs when the DGC-2020ES is 
configured for mains fail transfers, but has not 
transferred to the generator from the utility before the 
Mains Fail Max Transfer Time has expired. It remains 
true until the pre-alarm is cleared by pressing the 
Reset button on the front panel. 

 

Maintenance 
Interval 

True when the Maintenance Interval Pre-Alarm 
threshold has been exceeded. 

 
MPU Fail True when the MPU has failed. 

 
Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is configured 
as a pre-alarm and the activation delay has expired. 

 
Reverse 
Rotation 

True when the generator rotation is opposite of the 
Phase Rotation setting. 
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Name Description Symbol 
Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is configured as a 
pre-alarm and the activation delay has expired. 

 
Weak Battery True when the Weak Battery Voltage Pre-Alarm 

settings have been exceeded. 
 

Senders 
Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is configured 
as either a pre-alarm or alarm and the activation delay 
has expired.  

Fuel Level 
Sender Fail 

True when the Fuel Level Sender Fail is configured as 
either a pre-alarm or alarm and the activation delay 
has expired.  

Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is configured 
as either a pre-alarm or alarm and the activation delay 
has expired.  

Speed Sender 
Fail 

True when the Speed Sender Fail activation delay has 
expired. 

 
Voltage Sensing 
Fail 
 

True when the Voltage Sensing Fail is configured as 
either a pre-alarm or alarm and the activation delay 
has expired.  

Logic Control Relays 

The logic control relays (LCR) consist of LCR outputs and LCR inputs. The output can be used to terminate the 
“output” end of a logic network, and then use the corresponding input as an input to logic elsewhere in the logic 
scheme. When a given LCR output is true the corresponding LCR input is true. In other words, when LCR Output 
N (N being a number from 1 to 16) becomes true, then LCR Input N is true also. 
If you get a “too many logic levels” error while building a logic network, LCR outputs and inputs can be used as a 
solution to this problem. Place an LCR output on the end of the partial logic network and then use the 
corresponding LCR input to build more logic than was previously possible. 
Inputs 
Input 1-16 

See description above. 

 
Outputs 
Output 1-16 

See description above. 

 

Components 
This group contains Logic Gates, Pickup and Dropout Timers, Latches, and Comment Blocks. Table 24 
lists the names and descriptions of the objects in the Components group. 

 

Table 24. Components Group, Names and Descriptions 

Name Description Symbol 
Logic Gates 
AND Input Output 

0 0 0 
0 1 0 
1 0 0 
1 1 1 
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Name Description Symbol 
NAND Input Output 

0 0 1 
0 1 1 
1 0 1 
1 1 0 

 

 

OR Input Output 
0 0 0 
0 1 1 
1 0 1 
1 1 1 

 

 

NOR Input Output 
0 0 1 
0 1 0 
1 0 0 
1 1 0 

 

 

XOR Input Output 
0 0 0 
0 1 1 
1 0 1 
1 1 0 

 

 

XNOR Input Output 
0 0 1 
0 1 0 
1 0 0 
1 1 1 

 

 

NOT 
(INVERTER) 

Input Output 
0 1 
1 0 

  
Pickup and Dropout Timers 
Drop Out 
Timer 

Used to set a delay in the logic. 
For more information, refer to Programming BESTlogicPlus, Pickup 
and Dropout Timers, later in this section. 

 
Pickup Up 
Timer 

Used to set a delay in the logic. 
For more information, refer to Programming BESTlogicPlus, Pickup 
and Dropout Timers, later in this section. 

 
Latches 
Reset Priority 
Latch 

When the Set input is on and the Reset input is off, the latch will go to 
the SET (ON) state. When the Reset input is on and the Set input is 
off, the latch will go to the RESET (OFF) state. If both the Set and 
Reset inputs are on at the same time, a reset priority latch will go to the 
RESET (OFF) state. 
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Name Description Symbol 
Set Priority 
Latch 

When the Set input is on and the Reset input is off, the latch will go to 
the SET (ON) state. When the Reset input is on and the Set input is 
off, the latch will go to the RESET (OFF) state. If both the Set and 
Reset inputs are on at the same time, a set priority latch will go to the 
SET (ON) state. 

 
Other 
Comment 
Block 

Enter user comments. 

 

Elements 
This group contains elements for the 27, 47, 50, 59, and 81. It also contains elements for Generator 
Breaker, Mains Breaker, Logic Alarm, Logic Pre-Alarm, Configurable Elements, AUTO Mode, OFF Mode, 
RUN Mode, Run with Load, Engine Run, ATS, Run Inhibit, Test Inhibit, Pre-Start Output, Start Output, 
Run Output, Cool Stop Request, Cool Down Request, External Start Delay, Start Delay Bypass, Alternate 
Frequency Override, Mains Fail Test, Load Take Over, Reset, Alarm Silence, Lamp Test, Idle Request, 
Low Fuel Pre-Alarm, Diesel Particulate Filter Manual Regeneration, Diesel Particulate Filter Regeneration 
Inhibit, Emergency Stop, Speed Raise, Speed Lower, MTU Cylinder Cutout Disable, and Automatic 
Breaker Operation Inhibit from PLC. 

Table 25 lists the names and descriptions of the elements in the Elements group. 

 

Table 25. Elements Group, Names and Descriptions 

Name Description Symbol 
Protection 
27TRIP True when the 27-1 undervoltage is in a TRIP condition. 

Connect to another logic block input. 

 
47TRIP True when the 47 phase imbalance is in a TRIP condition. 

Connect to another logic block input. 

 
50TRIP True when the 50 overcurrent is in a TRIP condition. Connect 

to another logic block input. 

 
59TRIP True when the 59-1 overvoltage is in a TRIP condition. 

Connect to another logic block input. 

 
81TRIP 
 
 
 
 
 
 
 
 

True when the 81 frequency is in a TRIP condition. Connect to 
another logic block input. 
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Name Description Symbol 
Other 
ALARMSILENCE The alarm will be silenced when this element is true. The alarm 

can also be silenced by pressing the Alarm Silence button on 
the front panel of the DGC-2020ES. 

 
ALTFREQOVER When this logic element is true, protection and bus condition 

detection is forced to operate at the Alternate Frequency 
instead of the Rated Frequency. 

 
ATS When this logic element is true, and the DGC-2020ES is in 

AUTO mode, the generator will run. This can be used in place 
of the ATS programmable function if it is desired to generate 
the ATS signal as a combination of programmable logic rather 
than a simple contact input. If either the ATS logic element is 
true or the contact mapped to the ATS programmable function 
is true, and the DGC-2020ES is in AUTO mode, the generator 
will run. If both the ATS logic element and the ATS 
programmable function are false, and the DGC-2020ES is in 
AUTO mode, the generator will cool down and stop. 

 

AUTOMODE When this input is true, and the DGC-2020ES is in OFF mode, 
the DGC-2020ES will switch to AUTO mode. This is a pulsed 
input. It does not need to be held after the desired mode switch 
has occurred. 

 
AUTOBRKOP-
INHIBIT 

Automatic breaker operation is inhibited when the Set input is 
true. 

 
CONFELMNTX 
(X = 1 to 8) 

Configurable elements (CONFELMNT1-8) are connected to 
the logic scheme as outputs. These elements are configurable 
in BESTCOMSPlus under Programmable Outputs, 
Configurable Elements. The user can assign a string of up to 
16 characters, configure whether the element should generate 
an alarm or pre-alarm. If used for alarm or pre-alarm, the user's 
text is what will appear in the alarm or pre-alarm annunciation 
and in the DGC-2020ES event log. 
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Name Description Symbol 
COOLSTOPREQ RUN Mode 

If the unit is in RUN mode when the Cool Stop Request is 
received, the unit will unload, open its breaker, and go into a 
cooldown cycle. While in the cooldown cycle, the unit will 
display “COOL & STOP REQ” in addition to displaying the 
cooldown timer. After the cooldown timer expires, the unit will 
go to OFF mode. The Cool Stop Request must be removed 
before the unit can be run again. 
If the Cool Stop Request is removed during the cooldown 
process, the unit will remain running. Furthermore, if a 
condition occurs that normally causes the unit to close its 
breaker in RUN mode, the unit will close its breaker and 
reload. 
AUTO Mode 
If the unit is in AUTO mode when the Cool Stop Request is 
received, all conditions that would normally cause the unit to 
run in AUTO mode are cleared. Since all conditions that cause 
the unit to run have been removed, the unit goes into a 
cooldown cycle. While in the cooldown cycle, the unit will 
display “COOL & STOP REQ” in addition to displaying the 
cooldown timer. After the cooldown timer expires, the unit will 
shut down, remaining in AUTO. The Cool Stop Request must 
be removed before the unit can be run again. 
If the Cool Stop Request is removed during the cooldown 
process and some condition that would normally cause the unit 
to run in AUTO mode is true, the unit will remain running. 
Furthermore, if a condition occurs that normally causes the unit 
to close its breaker, the unit will close its breaker and reload. 

 

COOLDOWNREQ RUN Mode 
If the unit is in RUN mode when the Cool Down Request is 
received, the unit is forced to unload and open its breaker and 
then go into a cooldown cycle. While in the cool down cycle, 
the unit will display “COOLDOWN REQ” in addition to 
displaying the cooldown timer. After the cooldown timer 
expires, the unit will remain running in RUN mode. The Cool 
Down Request must be removed before the breaker can be 
closed again; this element blocks breaker closures. 
If the Cool Down Request is removed during the cool down 
process, the unit will remain running in RUN mode. 
Furthermore, if a condition occurs that normally causes the unit 
to close its breaker in RUN mode, the unit will close its breaker 
and reload. 
AUTO Mode 
If the unit is in AUTO mode and the Cool Down Request is 
received, the unit is forced to unload and open its breaker and 
go into a cooldown cycle. While in the cooldown cycle, the unit 
will display “COOLDOWN REQ” in addition to displaying the 
cooldown timer. After the cool down timer expires, the unit will 
remain running in AUTO mode, unless there are no conditions 
that cause the unit to run in AUTO mode, in which case it will 
shut down and remain in AUTO mode. The Cool Down 
Request must be removed before the breaker can be closed 
again; this element blocks breaker closures. 
If the Cool Down Request is removed during the cool down 
process and some condition that would normally cause the unit 
to run in AUTO mode is true, the unit will remain running in 
AUTO mode. Furthermore, if a condition occurs that normally 
causes the unit to close its breaker, the unit will close its 
breaker and reload. 
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Name Description Symbol 
DPFMANREGEN Diesel Particulate Filter Regeneration is forced manually when 

the Set input is true. 

 
DPFREGENINHIBIT Diesel Particulate Filter Regeneration is inhibited when the Set 

input is true. 

 
ESTOP When this element is true, an Emergency Shutdown alarm is 

annunciated and the Emergency Stop LED on the RDP-110 is 
illuminated. 

 
ENGINERUN The Start input starts the generator. No load is applied. The 

breaker remains open. The Stop input stops the generator. The 
DGC-2020ES only responds to this logic element when in 
AUTO mode. 

 
EXTSTARTDEL If the Set input is true while the DGC-2020ES is in the Pre 

Start state, the DGC-2020ES will remain in the Pre Start state 
until the Set input is false. 
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Name Description Symbol 
GENBRK This element is used to connect the breaker open and close 

output signals from the DGC-2020ES to physical output 
contacts to open and close the generator breaker, and map 
breaker status feedback to a contact input. In addition, contact 
inputs can be mapped to allow switches to be implemented to 
manually initiate breaker open and close requests. 
Inputs 
Status: This input allows a contact input to be mapped that will 
provide breaker status feedback to the DGC-2020ES. When 
the contact input is closed, the breaker is indicated to be 
closed. When the contact input is open, the breaker is 
indicated to be open. 
Open: This input allows a contact input to be mapped that can 
be used to initiate a manual breaker open request. When this 
input is pulsed closed while the DGC-2020ES is in RUN or 
AUTO mode, the breaker will open. 
Close: This input allows a contact input to be mapped that can 
be used to initiate a manual breaker close request. When this 
input is pulsed and the DGC-2020ES is in AUTO or RUN 
mode, and the generator is stable, a close request will be 
initiated. If bus is dead, the breaker will close; if the bus is not 
dead the generator breaker will not be closed. 
Outputs 
The outputs must be mapped to the contact outputs of the 
DGC-2020ES that will be used to drive the breaker. 
Open: This output is pulsed true (closes the output contact it is 
mapped to) when the DGC-2020ES is providing a signal to the 
breaker to open. It will be a pulse if the Breaker Output Contact 
Type is set to Pulse on the Breaker Hardware screen under 
Breaker Management in the Settings Explorer, and the length 
is determined by the Open Pulse Time. It will be a constant 
output if the Generator Breaker Hardware Contact Type is set 
to continuous. Note the pulse time must be set long enough for 
the breaker to actually open before the pulse is removed. 
Close: This output is pulsed true (closes the output contact it is 
mapped to) when the DGC-2020ES is providing a signal to the 
breaker to close. It will be a pulse if the Breaker Output 
Contact Type is set to Pulse on the Breaker Hardware screen 
under Breaker Management in the Settings Explorer, and the 
length is determined by the Open Pulse Time. It will be a 
constant output if the Generator Breaker Hardware Contact 
Type is set to continuous. Note the pulse time must be set long 
enough for the breaker to actually open before the pulse is 
removed. 

 

IDLEREQUEST When this element is true, the DGC-2020ES sends an idle 
request to the ECU on J1939 engines that are equipped to 
receive such a request. The request consists of an enable bit 
command and an idle RPM setting. At this time, only Volvo and 
Cummins are implemented. ECUs that accept the idle RPM 
setting set the engine to the requested RPM. ECUs that accept 
only the enable bit command, set the engine to their internal 
idle speed setting, ignoring the requested idle RPM from the 
DGC-2020ES. 

 

LAMPTEST The lamp test will be performed when this element is true. The 
lamp test can also be accomplished by simultaneously 
pressing the Up and Down buttons on the front panel of the 
DGC-2020ES. 
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Name Description Symbol 
LOADTAKEOVER When this logic element is true, the generator is forced to start, 

assume load, and disconnect from the mains, in an open 
transition. 

 
LOGICALM When this input is true, the DGC-2020ES goes into an alarm 

condition. 

 
LOGICPALM When this input is true, the DGC-2020ES goes into a Pre-

alarm condition. 

 
LOWFUELPALM When this element is true, a Low Fuel Pre-Alarm is 

annunciated and the Low Fuel Level LED on the RDP-110 is 
illuminated. 

 
MAINSFAILTEST When this element is true, the DGC-2020ES will exercise its 

mains fail transfer function exactly as it would if the mains were 
to fail on a mains fail machine. This can be used as a test of 
the mains fail transfer capability of the unit without having to 
cause a true mains failure.  

MAINSFLTRINHIBIT The mains fail transfer function is inhibited when the Set input 
is true. 
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Name Description Symbol 
MAINSBRK This element is used to connect the breaker open and close 

output signals from the DGC-2020ES to physical output 
contacts to open and close the mains breaker and map 
breaker status feedback to a contact input. In addition, contact 
inputs can be mapped to allow switches to be implemented to 
manually initiate breaker open and close requests. 
This element is only available when the Mains Breaker 
Hardware in configured on the Breaker Hardware screen via 
the Breaker Management tree branch. 
Inputs 
Status: This input allows a contact input to be mapped that will 
provide breaker status feedback to the DGC-2020ES. When 
the contact input is closed, the breaker is indicated to be 
closed. When the contact input is open, the breaker is 
indicated to be open. 
Open: This input allows a contact input to be mapped that can 
be used to initiate a manual breaker open request. When this 
input is pulsed closed while the DGC-2020ES is in RUN or 
AUTO mode, the breaker will open. 
Close: This input allows a contact input to be mapped that can 
be used to initiate a manual breaker close request. When this 
input is pulsed, the mains is stable, and both breakers are 
open, a close request will be initiated. 
Outputs 
The outputs must be mapped to the contact outputs of the 
DGC-2020ES that will be used to drive the breaker. 
Open: This output is pulsed true (closes the output contact it is 
mapped to) when the DGC-2020ES is providing a signal to the 
breaker to open. It will be a pulse if the Breaker Output Contact 
Type is set to Pulse on the Breaker Hardware screen under 
Breaker Management in the Settings Explorer, and the length 
is determined by the Open Pulse Time. It will be a constant 
output if the Mains Breaker Hardware Contact Type is set to 
continuous. Note the pulse time must be set long enough for 
the breaker to actually open before the pulse is removed. 
Close: This output is pulsed true (closes the output contact it is 
mapped to) when the DGC-2020ES is providing a signal to the 
breaker to close. It will be a pulse if the Breaker Output 
Contact Type is set to Pulse on the Breaker Hardware screen 
under Breaker Management in the Settings Explorer, and the 
length is determined by the Open Pulse Time. It will be a 
constant output if the Mains Breaker Hardware Contact Type is 
set to continuous. Note the pulse time must be set long enough 
for the breaker to actually open before the pulse is removed. 

 

MTUCYLCUTOUT-
DISABLE 
(MTU Cylinder Cutout 
Disable) 

When this logic element is true, Cylinder Cutout Disable 1 and 
Cylinder Cutout Disable 2 are both sent to the engine ECU with 
true status. When this logic element is false, Cylinder Cutout 
Disable 1 and Cylinder Cutout Disable 2 are sent to the engine 
ECU with states set by the values programmed for the Cylinder 
Cutout Disable 1 and Cylinder Cutout Disable 2 DGC-2020ES 
settings which are configured on the ECU Setup screen in 
BESTCOMSPlus. 

 

OFFMODE When this input is true, the DGC-2020ES will switch to OFF 
mode. This is a pulsed input. It does not need to be held after 
the desired mode switch has occurred. 
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Name Description Symbol 
PRESTARTOUT This element is used to drive the prestart output relay from 

logic when the Prestart Output Relay configuration is set to 
“Programmable”. When the Prestart Output Relay configuration 
is set to “Programmable”, the prestart relay will not close 
unless logic is used to drive this element. When the Prestart 
Output Relay configuration is set to “Predefined”, the prestart 
relay is closed according to the predefined prestart functionality 
of the DGC-2020ES. When the “Predefined” functionality is 
selected, the relay will not respond to this element. 

 

RDPPROGALM1 When true, this element illuminates the Fuel Leak/Sender 
Failure LED on the Remote Display Panel RDP-110. When this 
element is connected in logic, it overrides all other commands 
to the LED. Otherwise, the LED operates as normal.  

RDPPROGALM2 When true, this element illuminates the Sender Failure LED on 
the Remote Display Panel RDP-110. When this element is 
connected in logic, it overrides all other commands to the LED. 
Otherwise, the LED operates as normal. 

 
RDPPROGPREALM1 When true, this element illuminates the Battery Overvoltage 

LED on the Remote Display Panel RDP-110. When this 
element is connected in logic, it overrides all other commands 
to the LED. Otherwise, the LED operates as normal.  

RDPPROGPREALM2 When true, this element illuminates the Battery Charger Failure 
LED on the Remote Display Panel RDP-110. When this 
element is connected in logic, it overrides all other commands 
to the LED. Otherwise, the LED operates as normal.  

RESET Reset will be active when this element is true. Reset can also 
be accomplished by pressing the Reset button on the front 
panel of the DGC-2020ES. 

 
RUNINHIBIT When this logic element is true, the DGC-2020ES is prevented 

from starting and running the generator, regardless of any 
condition that would normally cause the generator to run. If this 
element is false and there is any condition in effect which will 
cause the generator to run, the DGC-2020ES will start and run 
the generator. 

 

RUNMODE When this input is true, and the DGC-2020ES is in OFF mode, 
the DGC-2020ES will switch to RUN mode. This is a pulsed 
input. It does not need to be held after the desired mode switch 
has occurred. 

 
RUNOUTPUT This element is used to drive the run output relay from logic 

when the Run Output Relay configuration is set to 
“Programmable”. When the Run Output Relay configuration is 
set to “Programmable”, the run relay will not close unless logic 
is used to drive this element. When the Run Output Relay 
configuration is set to “Predefined”, the run relay is closed 
according to the predefined run functionality of the DGC-
2020ES. When the “Predefined” functionality is selected, the 
relay will not respond to this element. 

 

RUNWLOAD The Start input starts the generator and closes the Gen 
breaker. The Stop input stops the generator and opens the 
Gen breaker. The DGC-2020ES only responds to this logic 
element when in AUTO mode. 

 

DGC-2020ES BESTlogic™Plus 



134  9469200990 Rev B 

Name Description Symbol 
SPEEDLOWER This element lowers the speed setting of the DGC-2020ES by 

up to 2 rpm per second. After the speed has not been lowered 
for 30 seconds, the modified speed is saved to nonvolatile 
memory. 

 
SPEEDRAISE This element raises the speed setting of the DGC-2020ES by 

up to 2 rpm per second. After the speed has not been raised 
for 30 seconds, the modified speed is saved to nonvolatile 
memory. 

 
STARTDELBYP This element allows the Pre Start state to be skipped based on 

logic. For example, a start delay may not be necessary when 
the engine is warm. This also allows an external device, such 
as an ECU, to control the pre start interval.  

 
STARTOUTPUT This element is used to drive the start output relay from logic 

when the Start Output Relay configuration is set to 
“Programmable”. When the Start Output Relay configuration is 
set to “Programmable”, the start relay will not close unless 
logic is used to drive this element. When the Start Output 
Relay configuration is set to “Predefined”, the start relay is 
closed according to the predefined start functionality of the 
DGC-2020ES. When the “Predefined” functionality is selected, 
the relay will not respond to this element. 

 

TESTINHIBIT When this logic element is true, the generator exercise timer 
cannot start the generator. If the TESTINHIBIT logic function is 
false during an exercise period, or transitions from true to false 
at any time during an exercise period, the DGC-2020ES will 
start and run the generator for the duration of the exercise 
period. 

 

Logic Schemes 

A logic scheme is a group of logic variables written in equation form that defines the operation of a DGC-
2020ES Digital Genset Controller. Each logic scheme is given a unique name. This gives you the ability to 
select a specific scheme and be confident that the selected scheme is in operation. One logic scheme is 
configured for typical control applications and is the default active logic scheme. Only one logic scheme 
can be active at a given time. In most applications, preprogrammed logic schemes eliminate the need for 
custom programming. Preprogrammed logic schemes may provide more inputs, outputs, or features than 
are needed for a particular application. This is because a preprogrammed scheme is designed for a large 
number of applications with no special programming required. Unneeded logic block outputs may be left 
open to disable a function or a function block can be disabled through operating settings. 

When a custom logic scheme is required, programming time is reduced by modifying the default logic 
scheme. 

The Active Logic Scheme 
Digital Genset Controllers must have an active logic scheme in order to function. All Basler Electric DGC-
2020ES units are delivered with a default, active logic scheme pre-loaded in memory. If the function block 
configuration and output logic of the default logic scheme meets the requirements of your application, 
then only the operating settings (power system parameters and threshold settings) need to be adjusted 
before placing the DGC-2020ES in service. 

Copying and Renaming Preprogrammed Logic Schemes 
Copying a saved logic scheme to the active logic and assigning a unique name is accomplished by 
loading the saved logic scheme into BESTCOMSPlus and then typing over the logic scheme's name. 
Changes are not activated until the new settings have been saved and uploaded to the device. 
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Sending and Retrieving Logic Schemes 
To retrieve settings from the DGC-2020ES, it must be connected to a computer through a 
communications port. Once the necessary connections are made, settings can be downloaded from the 
DGC-2020ES by selecting Download Settings and Logic on the Communication pull-down menu. 

To send settings to the DGC-2020ES, it must be connected to a computer through a communications 
port. Once the necessary connections are made, settings can be uploaded to the DGC-2020ES by 
selecting Upload Settings and Logic on the Communication pull-down menu. 

 

Caution 
Always remove the DGC-2020ES from service prior to changing or 
modifying the active logic scheme. Attempting to modify a logic 
scheme while the DGC-2020ES is in service could generate 
unexpected or unwanted outputs. 

Modifying a logic scheme in BESTCOMSPlus does not automatically 
make that scheme active in the DGC-2020ES. The modified scheme 
must be uploaded into the DGC-2020ES. 

 

Programming BESTlogic™Plus 

Use BESTCOMSPlus to program BESTLogicPlus. Using BESTCOMSPlus is analogous to physically 
attaching wire between discrete DGC-2020ES terminals. To program BESTLogicPlus, use the Settings 
Explorer within BESTCOMSPlus to open the BESTLogicPlus Programmable Logic tree branch as shown 
in Figure 65. 

The drag and drop method is used to connect a variable or series of variables to the logic inputs, outputs, 
components, and elements. To draw a wire/link from port to port (triangles), click the left mouse button on 
a port, pull the wire onto another port, and release the left mouse button. A red port indicates that a 
connection to the port is required or missing. A black port indicates that a connection to the port is not 
required. Drawing wires/links from input to input or output to output is not allowed. Only one wire/link can 
be connected to any one output. If the proximity of the endpoint of the wire/link is not exact, it may attach 
to an unintended port. 

If an object or element is disabled, it will have a yellow X on it. To enable the element, navigate to the 
settings page for that element. A red X indicates that an object or element is not available per the style 
number of the DGC-2020ES. 

The view of the Main Logic, Physical Outputs, Remote Outputs, and LCR Outputs can be automatically 
arranged by clicking the right mouse button on the window and selecting Auto-Layout. 

The following must be met before BESTCOMSPlus will allow logic to be uploaded to the DGC-2020ES: 

• A minimum of two inputs and a maximum of four inputs on any multi-port (AND, OR, NAND, 
NOR, XOR, and XNOR) gate. 

• A maximum of five logic levels for any particular path. A path being an input block or an output 
side of an element block through gates to an output block or an input side of an element block. 
This is to include any OR gates on the Physical Output or Remote Output tab/pages, but not the 
matched pairs of Physical Output blocks or Remote Output blocks. 

• Only 10 gates per logic level. All output blocks and input sides of element blocks are at the 
maximum logic level of the diagram. All gates are pushed forward/upwards in logic levels and 
buffered to reach the final output block or element block if needed. A maximum of 50 gates 
allowed per diagram. 
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• At all levels there can only be 64 used link/wired or endpoints. Endpoints being inputs, outputs, 
both sides of element blocks. 

Three status LEDs are located in the lower right corner of the BESTlogicPlus window. These LEDs show 
the Logic Save Status, Logic Diagram Status, and Logic Layer Status. Table 26 defines the colors for 
each LED. 

Table 26. Status LEDs 

LED Color Definition 

Logic Save Status 
(Left LED) 

  Orange Logic has changed since last save. 

  Green Logic has NOT changed since last save. 

Logic Diagram Status 
(Center LED) 

  Red Requirements NOT met as listed above. 

  Green Requirements met as listed above. 

Logic Layer Status 
(Right LED) 

  Red Requirements NOT met as listed above. 

  Green Requirements met as listed above. 

Pickup and Dropout Timers 
A pickup timer produces a true output when the elapsed time is greater than or equal to the Pickup Time 
setting after a false to true transition occurs on the Initiate input from the connected logic. Whenever the 
Initiate input status transitions to false, the output transitions to false immediately. 

A drop out timer produces a true output when the elapsed time is greater than or equal to the Dropout 
Time setting after a true to false transition occurs on the Initiate input from the connected logic. Whenever 
the Initiate input transitions to true, the output transitions to false immediately. 

Refer to Figure 66. 

To program logic timer settings, use the Settings Explorer within BESTCOMSPlus to open the 
BESTlogicPlus Programmable Logic/Logic Timers tree branch. Enter a Name label that you want to 
appear on the timer logic block. The Time Delay value range is 0 to 250 hours in 1 hour increments, 0 to 
250 minutes in 1 minute increments, or 0 to 1,800 seconds in 0.1 second increments. 

Next, open the Components tab inside the BESTlogicPlus window and drag a timer onto the program 
grid. Right click on the timer to select the timer you want to use that was previously set on the Logic 
Timers tree branch. The Logic Timer Properties Dialog Box will appear. Select the timer you want to use. 

Timing accuracy is ±15 milliseconds. 

 
Figure 66. Pickup and Dropout Timer Logic Blocks 

 

Initiate

Pickup Time

Output

Initiate

Dropout Time

Output

Pickup 
Timer

Dropout 
Timer

Output

Output

Initiate

Initiate

P0048-03

BESTlogic™Plus  DGC-2020ES 



9469200990 Rev B 137 

BESTlogic™Plus File Management 

To manage BESTlogicPlus files, use the Settings Explorer to open the BESTlogicPlus Programmable 
Logic tree branch. Use the BESTlogicPlus Programmable Logic toolbar to manage BESTlogicPlus files. 
Refer to Figure 67. For information on Settings Files management, refer to the BESTCOMSPlus chapter. 

 
Figure 67. BESTlogicPlus Programmable Logic Toolbar 

Saving a BESTlogicPlus File 
After programming BESTlogicPlus settings, click on the Save button to save the settings to memory.  

Before the new BESTlogicPlus settings can be uploaded to the DGC-2020ES, you must select Save from 
the File pull-down menu located at the top of the BESTCOMSPlus main shell. This step will save both the 
BESTlogicPlus settings and the operating settings to a file. 

The user also has the option to save the BESTlogicPlus settings to a unique file that contains only 
BESTlogicPlus settings. Click on the Logic Library drop-down button and select Save Logic Library File. 
Use normal Windows® techniques to browse to the folder where you want to save the file and enter a 
filename. 

Opening a BESTlogicPlus File 
To open a saved BESTlogicPlus file, click on the Logic Library drop-down button on the BESTlogicPlus 
Programmable Logic toolbar and select Open Logic Library File. Use normal Windows techniques to 
browse to the folder where the file is located. 

Protecting a BESTlogicPlus File 
Objects in a logic diagram can be locked so that when the logic document is protected these objects 
cannot be changed. Locking and protecting is useful when sending logic files to other personnel to be 
modified. The locked object(s) cannot be changed. To view the lock status of the object(s), select Show 
Lock Status from the Protection drop-down menu. To lock object(s), use the mouse to select object(s) to 
be locked. Right click on the selected object(s) and select Lock Object(s). The gold colored padlock next 
to the object(s) will change from an open to a locked state. To protect a logic document, select Protect 
Logic Document from the Protection drop-down button. A password is optional.  

Uploading a BESTlogicPlus File 
To upload a BESTlogicPlus file to the DGC-2020ES, you must first open the file through BESTCOMSPlus 
or create the file using BESTCOMSPlus. Then pull down the Communication menu and select Upload 
Logic. 

Downloading a BESTlogicPlus File 
To download a BESTlogicPlus file from the DGC-2020ES, you must pull down the Communication menu 
and select Download Logic. If the logic in your BESTCOMSPlus has changed, a dialog box will open 
asking you if want to save the current logic changes. You may choose Yes or No. After you have taken 
the required action to save or not save the current logic, the downloading is executed. 

Printing a BESTlogicPlus File 
To view a preview of the printout, click on the Print Preview icon located on the BESTlogicPlus 
Programmable Logic toolbar. If you wish to print to a printer, select the printer icon in the upper left corner 
of the Print Preview screen. 

You may skip the print preview and go directly to print by clicking on the Printer icon on the 
BESTlogicPlus Programmable Logic toolbar. A dialog box, Select Views to Print opens allowing you to 
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check which views you would like to print. Next, the Print dialog box opens with the typical Windows 
choice to setup the properties of printer. Execute this command, as necessary, and then select Print. 

A Page Setup icon is also provided on the BESTlogicPlus Programmable Logic toolbar allowing you to 
select Paper Size, Paper Source, Orientation, and Margins. 

Clearing the On-Screen Logic Diagram 
Click on the Clear button to clear the on-screen logic diagram and start over. 

BESTlogic™Plus Examples 

Example 1 - GENBRK Logic Block Connections 
Figure 68 illustrates the GENBRK logic block, three input logic blocks, and two output logic blocks. Output 
3 is active while the GENBRK is sending an “open breaker” command and Output 4 is active while the 
GENBRK is sending the “close breaker” command. 

 
Figure 68. Example 1 – GENBRK Logic Block Connections 

Example 2 - AND Gate Connections 
Figure 69 illustrates a typical AND gate connection. In this example, Output 11 will become active when 
the Low Fuel alarm AND the Low Oil Pressure alarm are true. 

 
Figure 69. Example 2 – AND Gate Connections 

Example 3 - Multiple Logic Connections 
In this example, there are two comment boxes, which may be placed on the logic diagram. Double-click a 
comment box to modify the inside text. Output 3 becomes true when the 27TRIP is true. Output 1 
becomes true when the High Coolant Temp is true. Output 2 becomes true when the DGC-2020ES is in 
RUN mode (RUN Mode true). Refer to Figure 70. 
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Figure 70. Example 3 – Multiple Logic Connections 
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Communication 
DGC-2020ES communication ports include a mini-B USB port, CAN terminals, and provisions for an 
optional Remote Display Panel. The following paragraphs describe the DGC-2020ES communication 
ports in detail. 

USB 

The rear-panel, mini-B USB port enables local communication with a PC running BESTCOMSPlus® 
software. The DGC-2020ES is connected to a PC using a standard USB cable. BESTCOMSPlus is a 
Windows®-based communication software package that is supplied with the DGC-2020ES. A detailed 
description of BESTCOMSPlus is provided in the BESTCOMSPlus chapter. 

CAN 

A Controller Area Network (CAN) is a standard interface that enables communication between multiple 
controllers on a common network using a standard message protocol. DGC-2020ES controllers have a 
CAN interface that supports the SAE J1939 protocol and the MTU protocol. 

Applications using an engine-driven generator set controlled by a DGC-2020ES may also have an Engine 
Control Unit (ECU). The CAN interface allows the ECU and DGC-2020ES to communicate. The ECU 
reports operating information to the DGC-2020ES through the CAN interface. Operating parameters and 
diagnostic information, if supported by the ECU, are decoded and displayed for monitoring. 

The primary use of the CAN interface is to obtain engine operating parameters for monitoring speed, 
coolant temperature, oil pressure, coolant level, and engine hours without the need for direct connection 
to individual senders. Table 27 lists the ECU parameters and Table 28 lists the engine configuration 
parameters supported by the DGC-2020ES CAN interface. These parameters are transmitted via the 
CAN interface at preset intervals. See the column labeled Update Rate in Table 27 for transmission rates. 

CAN interface connections are made at 13 (CAN H), 14 (CAN L), and 15 (SHIELD). 

Table 27. ECU Parameters Obtained from CAN Interface 

ECU Parameter Metric 
Units 

English 
Units Update Rate ∗ 

SPN 
Actual Engine Percent Torque % % Engine Speed 

Dependent 
513 

Air Filter Differential Pressure kPa psi 500 ms 107 

Air Inlet Temperature kPa °F 1 s 172 

Alarm Reset Feedback Binary (0 or 1) 1 s 2815 

Ambient Air Temperature °C °F 1 s 171 

Auxiliary Pressure 1 kPa psi On Request 1387 

Auxiliary Pressure 2 kPa psi On Request 1388 

Barometric Pressure kPa psi 1 s 108 

Battery Voltage Vdc Vdc 1 s 168 

Boost Pressure kPa psi 500 ms 102 

Charge Air Temperature °C °F 1 s 2629 

Coolant Level % % 500 ms 111 

Coolant Pressure kPa psi 500 ms 109 

ECU Temperature °C °F 1 s 1136 

Engine Coolant Temperature °C °F 1 s 110 

Engine Intercooler Temperature °C °F 1 s 52 
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ECU Parameter Metric 
Units 

English 
Units Update Rate ∗ 

SPN 
Engine Oil Level % % 500 ms 98 

Engine Oil Pressure kPa psi 500 ms 100 

Engine Oil Temperature °C °F 1 s 175 

Engine Speed rpm rpm Engine Speed 
Dependent 

190 

Exhaust Gas Temperature °C °F 500 ms 173 

Exhaust Temperature A °C °F 500 ms 2433 

Exhaust Temperature B °C °F 500 ms 2434 

Fuel Delivery Pressure kPa psi 500 ms 94 

Fuel Leak Filter 1 Binary (0 or 1) 1 s 1239 

Fuel Leak Filter 2 Binary (0 or 1) 1 s 1240 

Fuel Rate liter/hr gal/hr 100 ms 183 

Fuel Temperature °C °F 1 s 174 

High Exhaust System Temp (HEST) 
Lamp/Indicator 

— — 500 ms 3698 

Injection Control Pressure MPa psi 500 ms 164 

Injector Metering Rail Pressure MPa psi 500 ms 157 

Intake Manifold Temperature °C °F 500 ms 105 

Particulate Filter (DPF) Lamp/Indicator — — 500 ms 3697 

Percent Load at Current rpm % % 50 ms 92 

Rated Power watts watts On Request 166 

Rated rpm rpm rpm On Request 189 

Regeneration Disabled (Inhibit) Lamp/Indicator — — 500 ms 3703 

Shutdown from ECU Binary (0 or 1) 1 s 1110 

Switched Battery Voltage (at ECU) Vdc Vdc 1 s 158 

Throttle (Accelerator Pedal) Position % % 50 ms 91 

Total Engine Hours hours hours Requested 1.5 s 247 

Total Fuel Used liters gallons Requested 1.5 s 250 

Transmission Oil Pressure kPa psi 1 s 127 

Transmission Oil Temperature °C °F 1 s 177 

Trip Fuel liters gallons Requested 1.5 s 182 

Winding 1 Temperature °C °F 1 s 1124 

Winding 2 Temperature °C °F 1 s 1125 

Winding 3 Temperature °C °F 1 s 1126 

∗  SPN is suspect parameter number. 
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Table 28. Engine Configuration Parameters Obtained from CAN Interface 

ECU Parameter Metric Units English Units Update Rate ∗ 
SPN 

Engine Speed at High Idle Point 6 rpm rpm 5 s 532 

Engine Speed at Idle Point 1 rpm rpm 5 s 188 

Engine Speed at Point 2 rpm rpm 5 s 528 

Engine Speed at Point 3 rpm rpm 5 s 529 

Engine Speed at Point 4 rpm rpm 5 s 530 

Engine Speed at Point 5 rpm rpm 5 s 531 

Gain (Kp) of End Speed Governor %/rpm %/rpm 5 s 545 

Maximum Momentary Engine Override Speed Point 7 rpm rpm 5 s 533 

Maximum Momentary Engine Override Time Limit seconds seconds 5 s 534 

Percent Torque at Idle Point 1 % % 5 s 539 

Percent Torque at Point 2 % % 5 s 540 

Percent Torque at Point 3 % % 5 s 541 

Percent Torque at Point 4 % % 5 s 542 

Percent Torque at Point 5 % % 5 s 543 

Reference Engine Torque N•m ft-lb 5 s 544 

Requested Speed Control Range Lower Limit rpm rpm 5 s 535 

Requested Speed Control Range Upper Limit rpm rpm 5 s 536 

Requested Torque Control Range Lower Limit % % 5 s 537 

Requested Torque Control Range Upper Limit % % 5 s 538 

∗  SPN is suspect parameter number. 

 

Caution 
When the CAN is enabled, the DGC-2020ES ignores the following 
sender inputs: oil pressure, coolant temperature, and magnetic pickup. 

 

Under certain circumstances, the following strings may be displayed on the front panel HMI and in the 
Metering Explorer of BESTCOMSPlus: 

• NC (Not Connected) - String displayed for a J1939 parameter when the engine ECU is not connected 
to the DGC-2020ES. 

• SF (Sender Fail) - String displayed for a J1939 parameter when the engine ECU sends a special 
code indicating a measurement failure for the parameter. For example, if oil sender is determined to 
be bad by the ECU, it sends a special code in place of the J1939 oil pressure data indicating a sender 
fail condition. 

• NS (Not Sent) - String displayed for a J1939 parameter when the J1939 parameter has not been sent 
to the DGC-2020ES by the engine ECU. 

• NA (Not Applicable) - String displayed for a J1939 parameter when the engine ECU sends a special 
code for the parameter indicating that the parameter is not implemented or not applicable in the ECU. 

• UF (Unknown Failure) - String displayed when the J1939 parameter data received by the ECU is not 
within the valid J1939 data range for the parameter but is not one of the special codes above. 

Table 29 lists the J1939 data transmitted from the DGC-2020ES. 
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Table 29. J1939 Data Transmitted from the DGC-2020ES 

ECU Parameter Update Rate ∗ 
SPN 

Battle Override Switch 100 ms 1237 

Speed Request 10 ms 518 

Note: Requests from the DGC-2020 to the Engine ECU for various parameters are made by issuing the request. 

Address Claim Request Once on power up, and any time a Global Request for 
Address Claim (GRAC) PGN is received. 

NA 

Currently Active Diagnostic Trouble Codes 
Request 

Whenever a refresh of Currently Active Diagnostic 
Trouble Code Requests is received. 

NA 

Previously Active Diagnostic Trouble Codes 
Request 

2 s NA 

Clear Currently Active Diagnostic Trouble 
Codes Request 

Whenever a request to reset Currently Active Diagnostic 
Trouble Code Request is made. 

NA 

Clear Previously Active Diagnostic Trouble 
Codes Request 

Whenever a request to reset Previously Active Diagnostic 
Trouble Code Request is made. 

NA 

Engine Hours/Revolutions Request 2 s NA 

Fuel Consumption Request 2 s NA 

Electronic Engine Controller #4 (Rated 
Speed and Power) Request 

2 s NA 

Auxiliary Analog Information 2 s N/A 

CAN Setup 
The following paragraphs describe the settings found on the CAN Setup screen. This screen is found in 
the BESTCOMSPlus Settings Explorer, under the Communications, CAN Bus category. If using the front 
panel, navigate to Settings > Communications > CAN Bus Setup > CAN Bus Setup. Figure 71 illustrates 
the BESTCOMSPlus CAN Bus Setup screen. 

Enable ECU Support  

Set to Enabled for the DGC-2020ES to communicate with the ECU. 

Enable DTC (Diagnostic Trouble Code) Support 

If the ECU is a J1939 ECU, enable DTC support. If the ECU does not support it, no diagnostic trouble 
codes will be logged by the DGC-2020ES. 

SPN Conversion Method 

The most common SPN conversion method is 4 and is the default for the DGC-2020ES. Refer to ECU 
manufacturer documentation to determine the correct SPN conversion method of the ECU and set the 
SPN Conversion Method setting in the DGC-2020ES accordingly. 

CAN bus Address 

This parameter sets a unique address number for the DGC-2020ES operating on a CAN. The CAN 
Address is set internally by the DGC-2020ES when certain types of ECUs are selected on the ECU Setup 
screen, and in this case, the user-entered value does not apply. 

ECU Contact Control - Output Select 

Select whether the RUN output relay or the PRE (Prestart) output relay closes to give the ECU its 
“energize to run” signal. In some implementations, this relay may actually be providing ECU power. 

ECU Contact Control - Pulsing Enable 

Select if the ECU is not to be on line at all times. Often ECUs are allowed to go “off line” to conserve 
battery drain when the engine is not running. The DGC-2020ES will “pulse” it periodically to force it to be 
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active to allow the DGC-2020ES to read data such as coolant temperature and coolant level. This is 
required if the DGC-2020ES is to report low coolant temperature conditions (which may indicate a failure 
of a block heater), or low coolant level conditions (if a leak occurs while the machine is not running). 
Pulsing is also used to check the integrity of CAN communications when the machine is not running. 

ECU Related Time Values - Engine Shut Down 

Set this parameter for a value longer than the duration required to stop the engine after being shut down. 
The ECU is pulsed after this time expires. If the time is too short, the pulse may occur while the engine is 
still turning which could cause a brief re-start and possibly damage the flywheel and starter system. 

ECU Related Time Values - Pulse Cycle Time 

Set this parameter for the desired time between ECU pulse cycles. 

ECU Related Time Values - Settling Time 

This parameter is the duration of the “on line” time of the pulse cycle during which the DGC-2020ES 
reads data from the ECU. The settling time should be set long enough so that any ECU parameters that 
require time to “settle down” after the ECU is on line can do so. Since the DGC-2020ES may use some of 
the ECU data for alarm or pre-alarm annunciation, it is important that the data have time to settle. 

ECU Related Time Values - Response Timeout 

This setting defines the amount of time that the DGC-2020ES will wait to receive data from the ECU 
during a pulse cycle or start attempt. If no data is received during this time in a pulse cycle, a LOSS OF 
ECU COMMS pre-alarm is annunciated. If no data is received in this time during an engine starting 
attempt, a LOSS OF ECU COMMS alarm is annunciated. 

 
Figure 71. Settings Explorer, Communications,  CAN bus, CAN bus Setup 

ECU Setup 
The following paragraphs describe the settings on the ECU Setup screen. This screen is found in the 
BESTCOMSPlus Settings Explorer, under the Communications, CAN Bus category. If using the front 
panel, navigate to Settings > Communications > CAN Bus Setup > ECU Setup. Refer to Figure 72. 

ECU Type 

The DGC-2020ES can be configured for Standard, Volvo Penta, MTU MDEC, MTU ADEC, MTU 
ECU7/ECU8, GM/Doosan, Cummins, or MTU Smart Connect. 

Generator Parameter Transmit 

When the Generator Parameter Transmit setting is enabled, the DGC-2020ES broadcasts generator 
metered parameters over CAN as listed in Table 30. The Generator Parameter Transmit setting is not 
used when ECU Type is set for MTU MDEC, MTU ECU7/ECU8, or MTU Smart Connect. 

DGC-2020ES Communication 



146  9469200990 Rev B 

Engine Parameter Transmit 

When the Engine Parameter Transmit setting is enabled, the DGC-2020ES broadcasts engine metered 
parameters over CAN. When the Engine Parameter Transmit setting is disabled, transmission of J1939 
commands from the DGC-2020ES to the engine are disabled, but commands from the engine to the 
DGC-2020ES are allowed. 

Table 30. Generator Parameter Transmit 

PGN Name PGN Hex SPN Parameter 

Bytes 
Within PGN 

Data 

Generator Total 
AC Energy 

65018 FDFA 
2468 Generator Total kW Hours Export 1 to 4 

2469 Generator Total kW Hours Import 5 to 8 

Generator Total 
AC Reactive 
Power 

65028 FE04 

2456 Generator Total Reactive Power 1 to 4 

2464 Generator Overall Power Factor  5 to 6 

2518 Generator Overall Power Factor Lagging 7, bits 1 & 2 

Generator Total 
AC Power 

65029 FE05 
2452 Generator Total Real Power 1 to 4 

2460 Generator Total Apparent Power 5 to 8 

Generator 
Average Basic AC 
Quantities 

65030 FE06 

2440 Generator Average L-L AC RMS Voltage 1 to 2 

2444 Generator Average L-N AC RMS Voltage 3 to 4 

2436 Generator Average AC Frequency 5 to 6 

2448 Generator Average AC RMS Current 7 to 8 

Engine 
Temperature 65262 FEEE 110 Engine Coolant Temperature (Not sent 

when CAN is enabled.) 1 

Engine Fluid 
Level/Pressure 65263 FEEF 100 Engine Oil Pressure (Not sent when CAN 

is enabled. 4 

Dash Display 65276 FEFC 96 Fuel Level 2 

Diesel Particulate Filter (DPF) 

The diesel particulate filter settings are used when the ECU is configured for Standard, Volvo Penta, MTU 
ADEC, GM/Doosan, Cummins, or MTU Smart Connect. The DGC-2020ES supports the CAN parameters 
that are related to the diesel particulate filter implemented on certain engines to meet Tier 4 emission 
requirements. 

Two parameters are provided to initiate or disable DPF regeneration. The first, Manual Regeneration, is 
transmitted to the engine via CAN to initiate DPF regeneration. The second, Disable Regeneration, is 
transmitted to the engine via CAN to disable DPF regeneration. Extended operation with regeneration 
disabled is not recommended. 

Speed Setup 

Speed control over J1939 and ECU7/ECU8 is implemented over CAN when the CAN bus RPM Request 
setting is enabled. This is implemented for all ECUs. The Engine RPM setting defines the nominal 
requested engine rpm. The Idle RPM setting is the requested rpm when the IDLE REQUEST logic 
element is true.  
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Figure 72. Settings Explorer, CAN bus, ECU Setup 

Volvo Penta 

Configuring the DGC-2020ES for Volvo Penta* necessitates the configuration of two additional settings: 
Speed Select and Accelerator Position. The Speed Select setting configures the Volvo Penta ECU to 
operate the engine at the primary or secondary base speed. If the engine is configured by Volvo for 60 Hz 
applications, the primary base speed is 1,800 rpm and the secondary base speed is 1,500 rpm. If the 
engine is configured by Volvo for 50 Hz applications, the primary base speed is 1,500 rpm and the 
secondary base speed is 1,800 rpm. The Accelerator Position setting is expressed as a percentage and 
tells the Volvo Penta ECU where to set the engine speed (trim) relative to the base speed. The range of 
the setting is the base speed ±120 rpm. A setting of 0% will cause the engine to run at 120 rpm below the 
base speed, a setting of 50% will cause the engine to run at the base speed, and a setting of 100% will 
cause the engine to run at 120 rpm above the base speed. The Accelerator Position setting is linear with 
a gain of 2.4 rpm/percentage. This setting is not saved in nonvolatile memory and defaults back to 50% 
after DGC-2020ES operating power is cycled. 

The DGC-2020ES sends the following parameters to a Volvo Penta ECU through Volvo Proprietary 
J1939 communications: 

• Start Request - sent when starting the engine. 
• Stop Request - sent when shutting down the engine. 
• Idle Request - sent when the Idle Request logic element is true in BESTLogicPlus. 
• Preheat Request - sent anytime the DGC-2020ES would normally have its PRE relay closed for 

engines requiring a preheat contact. 
• Accelerator Pedal Position - sent based on the Accelerator Position setting. 
• Primary/Secondary Engine Speed - sent based on the Speed Select setting and the state of the 

Alternate Frequency Override element in BESTLogicPlus. Primary speed is sent when the Speed 
Select setting is set for Primary and Secondary speed is sent when the Speed Select setting is 
set for Secondary. However, these are reversed if the Alternate Frequency Override is true. A 
setting of Primary results in Secondary being sent and a setting of Secondary results in Primary 
being sent when the Alternate Frequency Override is true. 
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∗ The Volvo Penta ECU configuration is applicable only to the EDC3 and EMS2 models of Volvo Penta 
engine controllers. 

Cummins 

When Cummins is selected as the ECU type, the following parameters are sent to the engine via 
Cummins Proprietary J1939 communications: 

• Start Request - sent when starting or running the engine. 
• Stop Request - sent when stopping the engine. 
• Idle Request - sent when the Idle Request logic element is true in BESTLogicPlus. 
• Rated Speed (50 or 60 Hz) - sent based on the Rated Speed setting of the DGC-2020ES. 

However, these are reversed if the Alternate Frequency Override is true. A setting of 60 Hz Rated 
Speed results in 50 Hz being sent and a setting of 50 Hz Rated Speed results in 60 Hz being sent 
when the Alternate Frequency Override is true. 

MTU 

If the engine is configured as MTU MDEC, the configuration of the following settings is necessary: 
• MDEC Module Type - Specifies the type of MDEC module. 
• Speed Demand Switch - Specifies speed demand source for the MTU engine ECU. 
• NMT Alive Transmit Rate - Specifies the rate at which messages are transmitted to the MTU 

engine. 

If the engine is configured as MTU ADEC, the configuration of the following settings is necessary: 
• Speed Demand Switch - Specifies speed demand source for the MTU engine ECU.  
• Overspeed Test - Temporarily drives an MTU ECU into overspeed for testing overspeed. 
• Governor Param Switch Over - Specifies which governor parameters an MTU ECU should use. 
• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an MTU ECU engine to perform an internal lubrication cycle. 

If the engine is configured as MTU ECU7/ECU8, the configuration of the following settings is necessary: 
• Speed Demand Switch - Specifies speed demand source for the MTU engine ECU. 
• Overspeed Test - Temporarily drives an MTU ECU into overspeed for testing overspeed. 
• Speed Up - Increases speed of the MTU ECU. 
• Speed Down - Decreases speed of the MTU ECU. 
• Idle Request - Turns the idle request on or off. 
• Increased Idle - Sets the MTU ECU idle. 
• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an MTU ECU engine to perform an internal lubrication cycle. 
• MTU 50 Hz 60 Hz Switch Setting - Set automatically based on rated frequency of the DGC-

2020ES and the state of the alternate frequency override. 
• Engine Start Prime - Turns the engine start prime on or off. 
• Fan Override - Turns the fan override on or off. 
• Mode Switch - Turns the mode switch on or off. 
• Governor Param Set Select - Sets the governor parameter set select. 
• CAN Rating Switch 1 & 2 - Turns the CAN rating switch 1 & 2 on or off. 
• Cylinder Cutout Disable 1 & 2 - Turns the cylinder cutout disable 1 & 2 on or off. 
• MTU ECU7/ECU8 Module Type - Specifies ECU7/ECU8 Module type. 
• NMT Alive Transmit Rate - Specifies the rate at which messages are transmitted to the MTU 

engine. 

If the engine is configured as MTU Smart Connect, the configuration of the following settings is 
necessary: 

• Speed Demand Switch - Specifies speed demand source for the MTU engine ECU. 
• Overspeed Test - Temporarily drives an MTU ECU into overspeed for testing overspeed. 
• Speed Up - Increases speed of the MTU ECU. 
• Speed Down - Decreases speed of the MTU ECU. 
• Idle Request - Turns the idle request on or off. 
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• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an MTU ECU engine to perform an internal lubrication cycle. 
• Governor Param Switch Over - Specifies which governor parameters an MTU ECU should use. 
• Cylinder Cutout Disable 2 - Turns the cylinder cutout disable 2 on or off. 
• Engine Operating Mode - Selects engine operating mode 1 or 2. 

Remote Display Panel (optional) 

Applications that require remote annunciation can use Basler Electric’s Remote Display Panel. This 
device provides remote indication of many pre-alarm and alarm conditions. 

Remote Display Panel connections are made at 10 (RDP TxD–), 11 (RDP TxD+), 17 (BATT–), and 18 
(BATT+). 

The following pre-alarm conditions are indicated by LEDs on the Remote Display Panel: 
• High coolant temperature 
• Low coolant temperature 
• Low oil pressure 
• Low fuel level∗ 
• Weak battery 
• Battery overvoltage† 
• Battery charger failure∗† 

The following alarm conditions are indicated by LEDs and an audible alarm on the Remote Display Panel: 
• Low coolant level∗ 
• High coolant temperature 
• Low oil pressure 
• Overcrank 
• Overspeed 
• Emergency stop activated 
• Fuel leak/Sender failure∗† 
• Sender failure† 

∗ This can be configured in the DGC-2020ES as None, Alarm, or Pre-alarm. See the Contact Inputs 
chapter for more information. The LED on the Remote Display Panel illuminates when the input that is 
assigned to the programmable function is closed, whether the function is configured as None, Alarm, or 
Pre-alarm. 

† This LED can be reprogrammed in the DGC-2020ES to suit the needs of a particular application. The 
condition listed above is annunciated by default. 

Additionally, the Remote Display Panel indicates when the DGC-2020ES is not operating in Auto mode 
and when the generator is supplying load or when the DGC-2020ES is in an alarm state not listed above. 

Refer to Basler Publication 9318100990 for more information on the Remote Display Panel. 

See the Terminals and Connectors chapter for more information on connecting the Remote Display Panel 
to the DGC-2020ES. 
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Configuration 
System parameters configure the DGC-2020ES for operation with a specific application. This chapter lists 
items to consider when configuring the DGC-2020ES. These items consist of system settings and rated 
data, remote module setup, crank settings, automatic restart settings, exercise timer settings, sensing 
transformer ratings, relay control settings, and system configuration detection settings. 

System Settings 

The System Settings parameters consist of number of fly wheel teeth, speed signal source, power-up 
delay, fuel level function, NFPA compliance level, EPS supplying load, system units, and metric pressure 
units. The System Settings screen is found in the BESTCOMSPlus® Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > System 
Settings. 

Number Flywheel Teeth 
The Number Fly Wheel Teeth setting accepts a value from 1 to 500, in increments of 0.1. This value is 
used when calculating engine rpm. 

Speed Signal Source 
The DGC-2020ES can be configured to detect engine speed from a magnetic pickup (MPU), the genset 
frequency, or both the MPU and genset frequency. On engines with CAN ECUs, if MPU or MPU Freq is 
selected as the Speed Signal Source, the DGC-2020ES uses CAN as the speed source when CAN is 
enabled. If Gen Freq is set as the Speed Signal Source, the DGC-2020ES uses the generator frequency. 

When engine speed is obtained from the genset frequency, the DGC-2020ES uses the rated (nominal) 
genset frequency and nominal rpm rating when calculating engine rpm. 

When engine speed is obtained from an MPU, the DGC-2020ES uses the nominal rpm rating and the 
number of flywheel teeth when calculating engine rpm. 

The speed signal from the MPU takes priority when both the genset frequency and MPU are selected as 
the engine speed source. If both MPU and genset frequency are selected and the MPU fails, the DGC-
2020ES automatically switches to the genset frequency as the engine speed source. 

Power Up Delay 
In some cases, the ECU takes longer than the DGC-2020ES to power up. The power up delay setting is 
used to delay the initial pulsing of the ECU for data on DGC-2020ES power up. This setting ranges from 0 
to 60 seconds in 1 second increments. 

Fuel Level Function 
This setting determines whether the fuel level indications and the related alarm and pre-alarm are 
enabled or disabled. Setting selections include, Fuel Lvl (Fuel Level), Natural Gas, Liquid Propane, or 
Disabled. Selecting a fuel type other than Fuel Lvl disables any fuel level indication, alarm, or pre-alarm. 
This includes the Fuel Level value on the Metering Explorer, Engine screen in BESTCOMSPlus. 

NFPA Compliance Level 
The DGC-2020ES can be used in an application requiring compliance with NFPA Standard 110. Levels 1 
and 2 of Standard 110 are supported. Selecting level 1 or 2 affects DGC-2020ES operation in the 
following ways: 

• The number of crank cycles is fixed at 3 
• Crank cycle time is fixed at 15 seconds 
• Continuous crank time is fixed at 45 seconds 
• The low coolant temperature pre-alarm setting is fixed at 70°F 
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EPS Supplying Load 
EPS Supplying Load settings consist of Low Line Scale Factor and EPS Threshold. These settings are 
described in the following paragraphs. 

Low Line Scale Factor 

Low Line Scale Factor automatically adjusts the EPS threshold setting in applications utilizing more than 
one type of genset connection. The scale factor setting is implemented when the DGC-2020ES senses a 
contact closure at a contact input programmed to activate scaling of the settings. The value of the scale 
factor setting serves as a multiplier for the threshold setting. For example, if a scale factor contact input is 
received by the DGC-2020ES and the scale factor setting is 2.000, the threshold setting is doubled (2.000 
x Threshold setting). 

EPS Threshold 

Indication that the emergency power system is supplying load is determined by a user-adjustable 
threshold setting. This setting is expressed as a percentage of the genset CT (nominal) primary rating. 

This setting accepts values from 3 to 10, in increments of 1%. 

System Units 
Engine oil pressure and coolant temperature can be displayed in English or metric units of measure. 

Metric Pressure Units 
This setting allows engine oil pressure to be displayed in bar or kPa/MPa. 

 

 
Figure 73. Settings Explorer, System Parameters, System Settings Screen 

 

Rated Data 

Rated Data parameters consist of sensing transformer ratings, voltage, power factor, kW, engine RPM, 
frequency, battery volts, generator and bus connection types, and phase rotation. The Rated Data screen 
is found in the BESTCOMSPlus Settings Explorer under the System Parameters category. If using the 
front panel, navigate to Settings > System Parameters > System Settings. 

Click the Edit button on the BESTCOMSPlus Rated Data settings screen to adjust values. Click OK to 
accept the changes, and Cancel to discard them. 

Sensing Transformers 
For information on sensing transformers settings, see Sensing Transformers, below. 
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Rated Data 
Genset nameplate data used by the DGC-2020ES includes the rated voltage, power factor, kW, and 
engine RPM. 

Rated Volts (V L-L) 

This setting accepts values from 1 to 99,999, in increments of 1. 

Rated Power Factor (PF) 

This setting accepts values from -1 to 1, in increments of 0.001. 

Genset kW Rating 

This setting accepts values from 5 to 9,999, in increments of 1. 

Rated Engine RPM 

This setting accepts values from 750 to 3,600, in increments of 1. 

Calculated Rated Data 

Rated Secondary Volts, Rated Phase Amps, Rated Secondary Phase Amps, Rated kVA, and Rated kvar 
are calculated automatically. The equations used for these calculations are listed below. 
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Frequency 
The frequency settings allow selection of the rated frequency of the generator and an alternate frequency. 

Rated Frequency of the Unit 

Rated frequency settings consist of 50 and 60 Hz. 

Alternate Frequency 

This setting accepts values from 10 to 450, in increments of 0.01. 

Battery Volts 
The nominal voltage of the starter battery is used by the DGC-2020ES to detect and annunciate battery 
overvoltage and low or weak battery voltage. The Battery Volts settings consist of 12 V and 24 V. 
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Generator Connection 
Genset connection types accommodated by the DGC-2020ES include three, three-phase connections 
(delta, wye, and grounded delta) and a single-phase configuration (sensing across phases A and B.) 

Bus Connection 
Bus connection types consist of single- and three-phase. Single-phase bus voltage is sensed across 
phases A and B. 

Phase Rotation 
The Phase Rotation setting allows selection of ABC or CBA rotation according to the phase rotation 
connection of the machine. The DGC-2020ES calculates the power angle as the angle between the 
Phase AB voltage and phase B current. An angle compensation factor, determined by the phase rotation 
setting, is then applied. If the actual phase rotation connection of the machine does not match the phase 
rotation setting, calculation of the power angle will be incorrect, which may result in a miscalculation of 
kW, kvar, and power factor. 

 

 
Figure 74. Settings Explorer, System Parameters, Rated Data Screen 
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Remote Module Setup 

When the optional CEM-2020 is enabled, a J1939 address must be entered. Select the appropriate 
number of outputs available on the CEM-2020. The low current module (CEM-2020) provides 24 contact 
outputs and the high current module (CEM-2020H) provides 18 contact outputs. 

The Remote Module Setup screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Remote 
Module Setup. 

The BESTCOMSPlus Remote Module Setup screen is illustrated in Figure 75. 

 
Figure 75. Settings Explorer, System Parameters, Remote Module Setup Screen 

 

Crank Settings 

The Crank Settings consist of pre-start, restart, cranking, crank disconnect, and cooldown. These settings 
are described in the paragraphs below. 

The Crank Settings screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Crank 
Settings. 

The BESTCOMSPlus Crank Settings screen is illustrated in Figure 76. 

Pre-Start 
If desired, cycle or continuous cranking can be delayed after initiating engine startup. During this delay, 
the Pre-Start output closes to energize glow plugs or pre-start the lubrication pump. The Pre-crank Delay 
setting accepts values from 0 to 30, in increments of 1 second. 

The Pre-Start output can be configured to open upon the conclusion of engine cranking or remain closed 
as long as the engine is running. 

The Pre-Start output can be configured during the resting state. If Preheat Before Crank is selected, the 
Pre-Start output is closed for the duration of the Pre-crank Delay time prior to re-entering the cranking 
state. If the Pre-crank delay setting is longer than the rest interval, the Pre-Start output is closed for the 
entire duration of the rest time. 

Restart 
Attempting to start an engine after a normal shutdown but before the engine RPM has settled to zero can 
stress an engine in certain situations. The Restart Delay inhibits attempts to start the engine immediately 
after a normal shutdown for the duration of the Restart Delay timer. This delay should allow an engine to 
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properly spin down before attempting to restart. This setting accepts values from 0 to 120, in increments 
of 1 second. 

Cranking 
The DGC-2020ES can be programmed for either cycle or continuous cranking. 

Cycle cranking provides multiple engine starting attempts. Each starting attempt consists of a fixed 
interval of engine cranking followed by a rest interval of the same duration. The Number of Crank Cycles 
setting accepts values from 1 to 7, in increments of 1. The Cycle Crank Time setting accepts values from 
5 to 15, in increments of 1 second.  

Continuous cranking provides a single, extended engine-starting attempt. The Continuous Crank Time 
setting accepts values from 5 to 60, in increments of 1 second. 

Crank Disconnect 
Under normal operation, engine rpm is used to determine crank disconnect. The Crank Disconnect Limit 
setting establishes the engine rpm percentage at which the starter is disconnected. This setting accepts 
values from 10 to 100, in increments of 1 percent. 

The Oil Pressure Crank Disconnect provides a secondary indication that the engine is running. This 
ensures that the starter is disconnected, even if no engine rpm sources are functioning. When enabled, oil 
pressure is used to determine if the engine is running. If the engine oil pressure is above the threshold, 
the starter is disconnected from the engine. The Crank Disconnect Pressure threshold setting accepts 
values from 2.9 to 150 psi, 0.2 to 10.3 bar, and 20 to 1,034.5 kPa, in increments of 0.1. 

Cool Down 
After the load is removed from a genset, the DGC-2020ES implements a smart cooldown function. This 
function ensures that the engine and turbocharger properly cool down by maintaining engine operation for 
a user-defined duration. The No Load Cool Down Time setting accepts values from 0 to 60, in increments 
of 1 minute. 

This cooldown function is initiated for any one of the following conditions: 
• Genset load is removed and engine shutdown is permitted while in AUTO mode 
• Auto Transfer switch (ATS) opens while operating in AUTO mode 
• Remote shutdown is initiated while in AUTO mode 
• Off Mode Cooldown is initiated 
• The Cooldown Request logic element is initiated 
• The Cool and Stop Request logic element is initiated 

Smart Cooldown Function 

The smart cooldown function reduces unnecessary fuel expenditure by considering overall cooldown time 
through multiple requests. For example, a new cooldown request is initiated after a previous cooldown 
sequence has already started. The cooldown timer is not simply reset with each new request. Instead, the 
amount of time that the engine has spent cooling down is factored into the new request. This saves time 
and fuel by running the engine no longer than necessary to achieve proper cooldown. 
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Figure 76. Settings Explorer, System Parameters, Crank Settings Screen 

 

Automatic Restart 

When enabled, the Automatic Restart clears all alarms automatically if the DGC-2020ES shuts down due 
to an alarm condition. An attempt to restart the engine is made, after a predetermined time delay, if the 
ATS contact input is closed. If an ATS contact is not present, the unit remains in the READY state with 
alarms cleared. A restart is not attempted if a low fuel alarm or emergency stop is present. The number of 
restart attempts is programmable. Automatic restart attempts are recorded in the event log. 

The Auto Restart Interval setting accepts values from 0.5 to 30, in increments of 0.5 minutes. The Auto 
Restart Attempts setting accepts values from 1 to 10, in increments of 1. 

The Automatic Restart screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Automatic 
Restart. 

The BESTCOMSPlus Automatic Restart screen is illustrated in Figure 77. 

 
Figure 77. Settings Explorer, System Parameters, Automatic Restart Screen 
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Exercise Timer 

The exercise timer is used to start the genset at a predetermined time and run for a user-defined period. 
The mode defines how often the genset will run. If monthly is selected, the day of the month to start must 
also be selected. If weekly is selected, the day of the week to start must also be selected. Settings for 
Start Hour and Start Minute can also be defined. The Run Period Hours and Minutes define how long the 
genset will run each session. The Start Hour and Run Period Hours settings accept values from 0 to 23, 
in increments of 1 hour. The Start Minute and Run Period Minutes settings accept values from 0 to 59, in 
increments of 1. If Run with Load is enabled, the DGC-2020ES closes the generator breaker during the 
run time. 

Contact inputs and outputs can be assigned to this function. Refer to the BESTlogicPlus chapter for more 
information. 

The Exercise Timer screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Exercise 
Timer. 

The BESTCOMSPlus Exercise Timer screen is illustrated in Figure 78. 

 
Figure 78. Settings Explorer, System Parameters, Exercise Timer Screen 

Sensing Transformers 

Three sets of transformer settings configure the DGC-2020ES for operation with a specific system. These 
settings, along with the generator voltage, generator current, and bus voltage detected by the DGC-
2020ES, enable it to accurately meter system values and offer generator protection. 

The Sensing Transformers screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Sensing 
Transformers. 

When adjusting these settings using BESTCOMSPlus, click the Rated Data button. See Rated Data, 
above, for more information. 

Generator PT 
The generator PT settings establish the nominal primary (generator side) and secondary (DGC-2020ES 
side) voltage levels at the generator voltage-sensing transformer. The Generator PT Primary setting 
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accepts values from 1 to 99,999, in increments of 1. The Generator PT Secondary setting accepts values 
from 1 to 480, in increments of 1. 

Bus PT 
Primary and secondary bus transformer ratings are used by the optional automatic transfer switch 
function. This function monitors a three-phase bus input to detect mains failure. The primary setting 
establishes the nominal voltage present at phases A, B, and, C of the bus. This setting accepts values 
from 1 to 99,999, in increments of 1. The secondary setting establishes the nominal voltage detected at 
the bus voltage input of the DGC-2020ES. This setting accepts values from 1 to 480, in increments of 1. 

Generator CT 
The generator CT setting establishes the nominal, primary (generator side) current level at the generator 
current sensing transformer. This setting accepts values from 1 to 9,999, in increments of 1. The 
secondary value of the generator CT is dictated by the style number of the controller. A DGC-2020ES 
with a style number of 1xx uses a nominal CT secondary rating of 1 Aac. A DGC-2020ES with a style 
number of 5xx uses a nominal CT secondary rating of 5 Aac. 

The Gen CT Low Line Scale Factor setting is used to automatically adjust the Gen CT Primary Amps 
setting in applications that may utilize more than one type of genset connection. This setting accepts a 
value from 0.001 to 3, in increments of 0.001. The scale factor setting is implemented when the DGC-
2020ES senses a contact closure at a contact input programmed to activate scaling of the settings. The 
value of the scale factor setting serves as a multiplier for the Gen CT Primary Amps setting. For example, 
if a scale factor contact input is received by the DGC-2020ES and the scale factor setting is 2.000, the 
Gen CT Primary Amps setting is doubled (2.000 x Gen CT Primary Amps). 

Relay Control 

The default operational setting for the Start, Run, and Pre-start relays is Predefined or standard. Any of 
these relays can be logic driven by selecting the Programmable setting. Logic driven (programmable 
relays must be set up using BESTlogicPlus. 

The Relay Control screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Relay Control. 

The BESTCOMSPlus Relay Control screen is illustrated in Figure 79. 

 
Figure 79. Settings Explorer, System Parameters, Relay Control Screen 

 

System Configuration Detection 

When enabled, this feature allows the DGC-2020ES to automatically detect its sensing configuration in 
relation to the generator. Upon starting the genset, the configuration of the generator is automatically 
detected. The Single Phase Override and Low Line Override programmable function settings are then 
adjusted accordingly. 
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There is a one-second delay in the detection to prevent the DGC-2020ES from alternating between 
detected configurations. When the DGC-2020ES is in the Off mode or the engine is not running, the 
Automatic Configuration Detection function is disabled. The DGC-2020ES is assumed to be in the last 
valid automatically detected configuration. 

It is recommended that the Single Phase Override and Low Line Override programmable functions are 
not assigned to contact inputs when Automatic Configuration Detection is enabled. 

Single Phase Detect Threshold 
If the difference between the maximum and minimum line-to-line voltage exceeds this threshold, the unit 
is determined to be in single-phase configuration. If determined to be in single-phase configuration, the 
Single Phase Override programmable function forces the DGC-2020ES into single-phase mode. The 
single-phase mode connection is determined by the Single Phase Detect Generator Connection, below. 

If the Single Phase Override function is assigned to a contact output, the state of the contact output and 
the detected configuration are ORed. This means, if one or both are true, then the system is determined 
to be configured for single phase. 

Low Line Detect Threshold 
If the average of the valid line-to-line voltages for the detected configuration is above this threshold, the 
unit is determined to be in a high-line configuration. If the average is below this threshold, it is determined 
to be in a low-line configuration. If determined to be in low-line configuration, the Low-Line Override 
function forces the DGC-2020ES into the low-line configuration. 

If the Low-Line Override function is assigned to a contact output, the state of the contact output and the 
detected configuration are ORed. This means, if one or both are true, then the system is determined to be 
configured for low-line. 

Single Phase Detect Generator Connection 
This setting specifies which single-phase connection to use when the system is determined to be single-
phase. Single-phase AB or Single-phase AC can be selected. 

The Auto Config Detection screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Auto Config 
Detect. The BESTCOMSPlus Auto Config Detection screen is illustrated in Figure 80. 

 
Figure 80. Settings Explorer, System Parameters, Auto Config Detection Screen 
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Security 
Password protection guards against unauthorized changing of DGC-2020ES settings. Three levels of 
password protection are available. Each level is described in the following paragraphs. 
• OEM Access. This password level allows access to all settings. The default, OEM-access password 

is OEM. 
• Settings Access. This password level allows all except uploading of firmware and clearing of device 

event log. The default, settings-access password is SET. 
• Operator Access. The default, operator-access password is OP. This password level allows all 

settings to be read and allows changes to be made to the following: 
o LCD Contrast 
o Sleep Mode 
o Date/Time 
o All Sender Fail Time Delays 
o Metric Conversion 
o Low Fuel Pre-Alarm Level 
o Low Fuel Alarm Level 
o Pre-Start Contact after Cranking 
o Cooldown Time 
o Pre-Crank Time Delay 
o Reset of Maintenance Interval 
o All controls on the Control screen available via the Metering Explorer in BESTCOMSPlus® 

Changing Passwords 

Passwords can be changed only after communication between the PC and DGC-2020ES is established. 
Changes to passwords are made through the Device Security Setup screen. Use the Settings Explorer in 
BESTCOMSPlus to open the General Settings, Device Security Setup screen. 

The content of the Device Security Setup screen depends on the password level used when accessing 
the screen. For example, someone logged in with a settings-access password will be able to change only 
the settings-access and operator-access passwords - not the OEM-access password. 

The BESTCOMSPlus Device Security Setup screen is illustrated in Figure 81. All three access levels are 
shown. 

A password is changed by clicking on the access level, entering the new password, and then clicking on 
the Save Password button. DGC-2020ES passwords are case sensitive. 

Saving Passwords in a DGC-2020ES Settings File 

The passwords can be modified while BESTCOMSPlus is connected to a DGC-2020ES. The settings 
from the BESTCOMSPlus session can then be saved into a settings file. The settings file will contain the 
new passwords. Also, the passwords in a settings file can be modified off line, saved with the file, and 
then later loaded into a DGC-2020ES. 

Saving Passwords to a Settings File when On Line. 
The following procedure describes how to save passwords to a settings file when BESTCOMSPlus is 
connected to a DGC-2020ES (on line): 

1. When connected to a DGC-2020ES with BESTCOMSPlus, click on SETTINGS 
EXPLORERGENERAL SETTINGSDEVICE SECURITY. 

2. You will be prompted to enter a password. 
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3. Enter a password that is of a level as high as or higher than the password you wish to modify. 
BESTCOMSPlus will display all passwords of a level equal to and below the level of the password 
that was entered. 

4. Click on the password you wish to modify. Type in the new password under the “Password” setting 
that became active when the password to modify was clicked. 

5. Click the “Save” button to save the new password into BESTCOMSPlus memory (it’s not in the DGC-
2020ES yet). 

6. Repeat steps 4 and 5 for all password levels you with to modify. 

7. Once all password modifications are complete, in the main menu of BESTCOMSPlus, select Upload 
Security from the Communications pull-down menu. This is the step where passwords are sent to the 
DGC-2020ES. Failure to perform this step might cause all password modifications to be lost. 

8. Close the Device Security tab in BESTCOMSPlus. 

9. Re-open the Device Security tab in BESTCOMSPlus. This will read the passwords back out of the 
DGC-2020ES. 

10. Verify the passwords obtained from the DGC-2020ES are correct. 

11. Once all desired settings have been loaded into the DGC-2020ES, save the settings file. The 
resulting settings file has the passwords saved as part of the saved settings. 

12. At this point, the password information has been successfully saved in the settings file. The process 
of saving the passwords into the settings file is complete. 

Saving Passwords to a Settings File when Off Line 
The following procedure describes how to save passwords to a settings file when working off line: 

1. When the settings file is open in BESTCOMSPlus, click on SETTINGS EXPLORERGENERAL 
SETTINGSDEVICE SECURITY. 

2. You will be prompted to enter a password. 

3. Enter a password that is of a level as high as or higher than the password you wish to modify. 
BESTCOMSPlus will display all passwords of a level equal to and below the level of the password 
that was entered. 

4. Click on the password you wish to modify. Type in the new password under the “Password” setting 
that became active when the password to modify was clicked. 

5. Click the “Save” button to save the new password into BESTCOMSPlus memory. 

6. Repeat steps 4 and 5 for all password levels you wish to modify. 

7. Close the Device Security tab in BESTCOMSPlus. 

8. Save the settings file. 

9. Close the settings file by clicking on the X in the upper right-hand corner of the settings file, or close 
BESTCOMSPlus. 

10. Restart BESTCOMSPlus if you have shut it down. 

11. Re-open the settings file that you have saved with the password information. 

12. When the settings file is open in BESTCOMSPlus, click on SETTINGS EXPLORERGENERAL 
SETTINGSDEVICE SECURITY. 

13. You will be prompted to enter a password. 

14. Enter the password for the highest level of password modified; it should be the new modified 
password. 

15. When passwords are shown, verify they are correct. 
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16. At this point the password information has been successfully saved in the settings file. The process of 
saving the passwords into the settings file is complete. 

Loading Passwords from a Settings File into the DGC-2020ES 

1. Connect to the DGC-2020ES with BESTCOMSPlus. 
2. Once connected, click the “Open File” button that is used to load a settings file into the DGC-2020ES. 
3. You will be prompted asking if you wish to load settings and logic into the DGC-2020ES. Select Yes if 

you need to upload settings logic. Select No if all you need to do is update security. If you select No, 
the settings file opens into BESTCOMSPlus memory. 

4. Whether you have loaded settings and logic to the DGC-2020ES or not, the next step is to select 
Upload Security from the Communications pull-down menu. 

5. DO NOT try to view the passwords before performing step 4. This would download the existing 
passwords from the DGC-2020ES and they will overwrite the new passwords that were loaded into 
BESTCOMSPlus memory from opening the settings file. 

6. If you are prompted for a password, enter a password of a level equal to that of the highest level 
password you wish to modify. 

7. The passwords are uploaded to the DGC-2020ES. 
8. After you have uploaded the new passwords, select GENERAL SETTINGSDEVICE SECURITY 

SETUP in the settings explorer of BESTCOMSPlus. Verify the passwords are correct. 
9. This concludes loading passwords from a settings file into the DGC-2020ES. 
 

 
Figure 81. Settings Explorer, General Settings, Device Security Setup Screen 
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Timekeeping 
The DGC-2020ES provides a real-time clock with capacitor backup that is capable of operating the clock 
for up to 24 hours after power is removed from the controller. As the capacitor nears depletion, an internal 
backup battery takes over and maintains timekeeping. The battery will maintain the clock for 
approximately ten years depending on conditions. The battery is not replaceable. 

The clock is used by the events recorder function to time-stamp events and the exercise timer to start and 
stop the genset when the exercise feature is utilized. 

Clock Setup 

Clock settings are made through the communication ports using BESTCOMSPlus® or through the front-
panel interface. Write access to ports is required to program the clock. An alarm is provided to detect 
when the DGC-2020ES has powered up and the clock has not been set. 

The clock settings are made through BESTCOMSPlus by selecting Clock Setup under General Settings. 
If using the front panel, navigate to Settings > General Settings > Configure Date/Time. 

The BESTCOMSPlus Clock Setup screen is illustrated in Figure 82. Settings are listed in Table 31. 

The local time zone is configured on this screen. The Time Zone Offset is the local offset to UTC 
(Coordinated Universal Time). The Time Zone Offset is required when the Start/End Time Reference is 
set to UTC (Coordinated Universal Time). The Start/End Time Reference is set to UTC time if required by 
local daylight savings time rules. The Start/End Hour/Minute settings determine the time when the DST 
will go into effect. The Bias setting is the amount of time that the clock moves forward or backward. The 
user is notified when the clock is not set when the Clock Not Set Warning is enabled. 

 
Figure 82. Settings Explorer, General Settings, Clock Setup Screen 
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Table 31. Settings for Clock 

Setting Range Increment Unit Default 
UTC Offset –1,440 to 1,440 1 minutes –6 

DST Configuration Floating Dates or Fixed Dates n/a n/a Disabled 
Start/End Time 

Reference 
Respective to Local Time or 

Respective to UTC Time n/a n/a Respective to 
Local Time 

Bias Setup (Hour) –12 to 12 1 hours Disabled 

Bias Setup (Minute) –59 to 59 1 minutes 0 

Clock Not Set 
Warning Disable or Enable n/a n/a Disable 

Setting the Time and Date 

Time and date settings are made through BESTCOMSPlus on the Real Time Clock screen (Figure 83) of 
the Metering Explorer. Settings can also be made through the front panel. 

 
Figure 83. Metering Explorer, Real Time Clock Screen 

Real-Time Clock Specifications 

Resolution ................................................................. 1 s 
Accuracy.................................................................... ±1.73 s/d at 25°C 

Clock Holdup 
Capacitor Holdup Time ............................................. Up to 24 hours depending on conditions 
Battery Holdup Time ................................................. Approximately ten years depending on conditions 
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Maintenance and Troubleshooting 
Maintenance 

Preventive maintenance consists of periodically checking that the connections between the DGC-2020ES 
and the system are clean and tight. Periodically check that the mounting hardware is clean and fastened 
with the proper amount of torque. DGC-2020ES units are manufactured using state-of-the-art, surface-
mount technology. These components are encased in potting material. As such, Basler Electric 
recommends that no repair procedures be attempted by anyone other than Basler Electric personnel. 

Storage 

This device contains long-life aluminum electrolytic capacitors. For devices that are not in service (spares 
in storage), the life of these capacitors can be maximized by energizing the device for 30 minutes once 
per year. 

Troubleshooting 

If you do not get the results that you expect from the DGC-2020ES, first check the programmable settings 
for the appropriate function. Use the following troubleshooting procedures when difficulties are 
encountered in the operation of your genset control system. 

Communications 

USB Port Does Not Operate Properly 

Step 1. Verify that the proper port of your computer is being used. For more information, refer to the 
Communication chapter. 

CAN Communication Does Not Operate Properly 

Step 1: Verify that there is a 120-ohm termination resistor on each end of the bus section of the wiring, 
and that there are not any termination resistors at any node connections that are on stubs from 
the main bus. 

Step 2: Check all CAN wiring for loose connections and verify that the CAN H and CAN L wires have 
not gotten switched somewhere on the network. 

Step 3: Verify that the cable length of the bus section of the wiring does not exceed 40 meters (131 
feet), and verify that any stubs from the main bus do not exceed 3 meters (9.8 feet) in length. 

Step 4: If the engine is equipped with a Volvo or MTU ECU, verify that the ECU Configuration setting is 
set to match the actual ECU configuration. 

Inputs and Outputs 

Programmable Inputs Do Not Operate as Expected 

Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 

Step 2. Confirm that the inputs are programmed properly. 

Step 3. Ensure that the input at the DGC-2020ES is actually connected to the BATT– terminal (17). 

Programmable Outputs Do Not Operate as Expected 

Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 

Step 2. Confirm that the outputs are programmed properly. 
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Metering/Display 

Incorrect Display of Battery Voltage, Coolant Temperature, Oil Pressure, or Fuel Level 

Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 

Step 2. Confirm that the SENDER COM terminal (2) is connected to the negative battery terminal and 
the engine-block side of the senders. Current from other devices sharing this connection can 
cause erroneous readings. 

Step 3. If the displayed battery voltage is incorrect, ensure that the proper voltage is present between 
the BATT+ terminal (18) and the SENDER COM terminal (2). 

Step 4. Verify that the correct senders are being used. 

Step 5. Use a voltmeter connected between the BATT– terminal (17) and the SENDER COM terminal 
(2) on the DGC 2020 to verify that there is no voltage difference at any time. Any voltage 
differences may manifest themselves as erratic sender readings. Wiring should be corrected so 
that no differences exist. 

Step 6: Check the sender wiring and isolate sender wiring from any of the ac wiring in the system. The 
sender wiring should be located away from any power ac wiring from the generator and any 
ignition wiring. Separate conduits should be used for sender wiring and any ac wiring. 

Incorrect Display of Generator Voltage 

Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 

Step 2. Ensure that the proper voltage is present at the DGC-2020ES voltage sensing inputs (40, 41, 
43, and 45). 

Step 3. Verify that the voltage transformer ratio and sensing configuration is correct. 

Step 4. Confirm that the voltage sensing transformers are correct and properly installed. 

Incorrect Measurement or Display of Generator Current 

Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 

Step 2. Ensure that the proper current is present at the DGC-2020ES current sensing inputs 33, 34, 35, 
36, 37, and 38. 

Step 3. Verify that the current sensing transformer ratios are correct. 

Step 4. Confirm that the current sensing transformers are correct and properly installed. 

Incorrect Display of Engine RPM 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter. 
Step 2. Verify that the flywheel teeth setting is correct. 
Step 3. Verify that the prime mover governor is operating properly. 
Step 4. Verify that the measured frequency of the voltage at the MPU input (31 and 32) is correct. 
Step 5. If the MPU is shared with the governor, verify that the polarity of the MPU input to the governor 

matches the polarity of the MPU input to the DGC-2020ES. 

DGC-2020ES Indicates Incorrect Power Factor 

Check the rotation of the machine and the labeling of the A-B-C terminals. The machine must be rotating 
in the same phase sequence as dictated by the generator phase rotation setting for correct power factor 
metering. A power factor indication of 0.5 with resistive load present is a symptom of incorrect phase 
rotation. 

LCD is Blank and all LEDs are Flashing at Approximately 2 Second Intervals 

This indicates that the DGC-2020ES does not detect that valid application firmware is installed. The unit is 
running its boot loader program, waiting to accept a firmware upload. 
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Step 1. Start BESTCOMSPlus®. Use the top pull-down menu and select FILE NEW DGC-2020ES. 

Step 2. Select COMMUNICATIONS UPLOAD DEVICE FILES and select the device package file that 
contains the firmware and language you want to upload. 

Step 3. Check the boxes for DGC-2020ES Firmware and DGC-2020ES Language Module. Click the 
UPLOAD button to start the upload process. 

Generator Breaker and Mains Breaker 

Generator Breaker Will Not Close to a Dead Bus 

Step 1: Review the description of how the generator breaker logic element functions contained in the 
GENBRK logic element description in the BESTlogic™Plus chapter. 

Step 2: Review the section on breaker close requests in the Breaker Management chapter. 

Step 3: Navigate to the SETTINGSBREAKER MANAGEMENTBREAKER HARDWAREGEN 
BREAKER screen and set DEAD BUS CL ENBL to ENABLE. 

Step 4: Verify that the Generator status is stable. The breaker will not close if the generator status is 
not stable. Check status by using the Metering Explorer in BESTCOMSPlus and verify that 
when the generator is running, the GEN STABLE status LED is lit. If necessary, modify the 
settings on the SETTINGSBREAKER MANAGEMENTBUS CONDITION DETECTION 
screen. 

Step 5: Verify the bus status is DEAD. Check status by using the Metering Explorer in BESTCOMSPlus 
and verify that when the generator is running, the BUS DEAD status LED is lit. If necessary, 
modify the settings on the SETTINGSBREAKER MANAGEMENTBUS CONDITION 
DETECTION screen. 

Step 6: Verify the connections in BESTlogicPlus Programmable Logic to the generator breaker logic 
element. The Status input must be driven by an “A” or normally open contact from the generator 
breaker. The OPEN and CLOSE command inputs on the left side of the logic block are inputs 
for open and close commands. These can be wired to physical inputs if it is desired to have 
open and close command switches. If they are wired, they must either be pulsed inputs, or 
some logic must be employed so that the open and close command inputs are never driven at 
the same time. If these are both driven at the same time, the breaker is receiving open and 
close commands simultaneously. The breaker will not change state if it is being commanded to 
open and close at the same time. 

Step 7: Verify the breaker is receiving a close command. Breaker close command sources are: 
• The DGC-2020ES itself when the automatic mains fail transfer (ATS) feature is enabled. 
• The DGC-2020ES itself when the RUN WITH LOAD logic element receives a Start pulse in 

the programmable logic. 
• The DGC-2020ES itself when started from the Exercise Timer and the Run with Load box 

is checked in the Generator Exerciser settings. 
• Manual Breaker Close Input Contacts applied to the Open and Close inputs on the left side 

of the Generator Breaker logic element in the programmable logic. 

Step 8: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 
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Generator Breaker Does Not Open When It Should 

Step 1: Review the description of how the generator breaker logic element functions contained in the 
GENBRK logic element description in the BESTlogicPlus chapter. 

Step 2: Review the section on breaker operation requests in the Breaker Management chapter. 

Step 3: Verify the connections in BESTlogicPlus Programmable Logic to the generator breaker logic 
element. The Status input must be driven by an “A” or normally open contact from the generator 
breaker. The OPEN and CLOSE command inputs on the left side of the logic block are inputs 
for open and close commands. These can be wired to physical inputs if it is desired to have 
open and close command switches. If they are wired, they must either be pulsed inputs, or 
some logic must be employed so that the open and close command inputs are never driven at 
the same time. If these are both driven at the same time, the breaker is receiving open and 
close commands simultaneously. The breaker will not change state if it is being commanded to 
open and close at the same time. 

Step 4: Verify the breaker is receiving an open command. Breaker open command sources are: 

• The DGC-2020ES itself when the automatic transfer (ATS) feature is enabled. 

• The DGC-2020ES itself when the RUN WITH LOAD logic element receives a Stop pulse in 
the programmable logic. 

• The DGC-2020ES itself when shutting down the engine due to an active alarm. 

• The DGC-2020ES itself when ending a run session from the Exercise Timer and the Run 
with Load box is checked in the Generator Exerciser settings. 

• Manual Breaker Open Input Contacts applied to the Open and Close inputs on the left side 
of the Generator Breaker logic element in the programmable logic. 

Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Mains Breaker Does Not Open When Mains Fails 

Step 1: Verify that a Mains Breaker has been configured by examining the settings on the 
SETTINGSBREAKER MANAGEMENTBREAKER HARDWARE screen. 

Step 2: Verify the mains breaker has been correctly included in the programmable logic. 

Step 3: Verify that the MAINS FAIL TRANSFER parameter is set to ENABLE on the 
SETTINGSBREAKER MANAGEMENTBREAKER HARDWARE screen. 

Step 4: Verify that a failure of the mains is detected by the DGC-2020ES. Check status using the 
Metering Explorer in BESTCOMSPlus and verify that the MAINS FAIL status LED is lit when 
the power on the DGC-2020ES bus voltage input is either out of voltage or frequency range. If 
necessary, modify the settings on the SETTINGSBREAKER MANAGEMENTBUS 
CONDITION DETECTION screen to achieve correct detection. 

Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker close output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
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breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Mains Breaker Does Not Close After Mains Returns 

Step 1: Verify that a Mains Breaker has been configured by examining the settings on the 
SETTINGSBREAKER MANAGEMENTBREAKER HARDWARE screen. 

Step 2: Verify the mains breaker has been correctly included in the programmable logic. 

Step 3: Verify that the MAINS FAIL TRANSFER parameter is set to ENABLE on the 
SETTINGSBREAKER MANAGEMENTBREAKER HARDWARE screen. 

Step 4: Verify that stable mains power is detected by the DGC-2020ES. Check status using the 
Metering Explorer in BESTCOMSPlus and verify that the MAINS STABLE status LED is lit 
when the power on the DGC-2020ES bus voltage input is good. If necessary, modify the 
settings on the SETTINGSBREAKER MANAGEMENTBUS CONDITION DETECTION 
screen to achieve correct detection. 

Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

DGC-2020ES Front Panel Debug Screen 
There is one debug screen in the DGC-2020ES that can be useful for debugging I/O module related 
issues. The following debug screen is available: CEM DEBUG 

CEM DEBUG 

This screen shows the binary data that is being sent between the CEM-2020 (Contact Expansion Module) 
and the DGC-2020ES. 

The CEM DEBUG screen is located on the front panel at SETTINGSSYSTEM PARAMSREMOTE 
MODULE SETUPCEM SETUPCEM DEBUG MENU. 

The following parameters are visible on the CEM DEBUG screen: 

• DGC TO CEM BP: DGC-2020ES to CEM-2020 Binary Points. This is the status of the CEM-2020 
output relays being transmitted from the DGC-2020ES to the CEM-2020. This is a 32-bit, bit packed 
number representing the desired states of the CEM-2020 outputs. The left most bit is the first output, 
etc. 

• CEM TO DGC BP: CEM-2020 to DGC-2020ES Binary Points. This is the status of the CEM-2020 
inputs being transmitted from the CEM-2020 to the DGC-2020ES. This is a 32-bit, bit packed number 
representing the metered states of the CEM-2020 inputs. The left most bit is the first input, etc. 
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Specifications 
DGC-2020ES electrical and physical characteristics are listed in the following paragraphs. 

Operating Power 

Nominal ............................................ 12 or 24 Vdc 
Range ............................................... 6 to 32 Vdc 
Terminals.......................................... 18 (+), 17 (–), 16 (chassis ground) 

Power Consumption 
Sleep Mode ...................................... 4.5 W - LCD heater off, all relays de-energized 
Normal Operational Mode ................ 6.5 W - Run mode, LCD heater off, 3 relays energized 
Maximum Operational Mode ............ 14 W - Run mode, LCD heater on, 7 relays energized 

Battery Ride Through 

Starting at 10 Vdc, withstands cranking ride-through down to 0 Vdc for 50 ms 

Current Sensing 

Burden .............................................. 1 VA 
Terminals.......................................... 38, 37 (A-phase) 
   36, 35 (B-phase) 
   34, 33 (C-phase) 

1 Aac Current Sensing 
Continuous Rating ............................ 0.02 to 1.0 Aac 
1 Second Rating ............................... 5 Aac 
0.050 Second Rating ........................ 10 Aac 

5 Aac Current Sensing 
Continuous Rating ............................ 0.1 to 5.0 Aac 
1 Second Rating ............................... 25 Aac 
0.050 Second Rating ........................ 50 Aac 

Voltage Sensing 

Range ............................................... 12 to 576 V rms, line-to-line 
Frequency ........................................ 50/60 Hz 
Frequency Range ............................. 10 to 72 Hz 
Burden .............................................. 1 VA  
1 Second Rating ............................... 720 V rms 

Generator Sensing 
Configuration .................................... Line-to-line or line-to-neutral 
Generator Sensing Terminals .......... 45 (A-phase) 
 43 (B-phase) 
 41 (C-phase) 
 40 (Neutral) 
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Bus Sensing 
Configuration .................................... Line-to-line 
Bus Sensing Terminals .................... 46 (A-phase) 
(Optional with style number xx2) 48 (B-phase) 
 50 (C-phase) 

Contact Sensing 
Contact sensing inputs include seven programmable inputs. All inputs accept dry contacts. 

Time from a DGC-2020ES input application to: 
• Shutdown the generator via an alarm = 490 ms max 
• Close a relay on board the DGC-2020ES = 215 ms max 
• Close a relay on board the CEM-2020 = 400 ms max 

Terminals 
Input 1 .............................................. 3, 17 
Input 2 .............................................. 4, 17 
Input 3 .............................................. 5, 17 
Input 4 .............................................. 6, 17 
Input 5 .............................................. 7, 17 
Input 6 .............................................. 8, 17 
Input 7 .............................................. 9, 17 

Engine System Inputs 
Stated accuracies are subject to the accuracy of the senders used. Values within these ranges are 
deemed “good” and the DGC-2020ES will use them for the appropriate calculation and protection. Values 
outside these ranges are deemed “bad” and the DGC-2020ES will begin timing towards a sender failure 
condition. 

Fuel Level Sensing 
Resistance Range ............................ 5 to 250 Ω nominal 
Terminals.......................................... 1, 2 (sender common) 

Coolant Temperature Sensing 
Resistance Range ............................ 5 to 2,750 Ω nominal 
Terminals.......................................... 53, 2 (sender common) 

Oil Pressure Sensing 
Resistance Range ............................ 5 to 250 Ω nominal 
Terminals.......................................... 52, 2 (sender common) 

Engine Speed Sensing 

Magnetic Pickup 
Voltage Range ................................. 3 to 35 V peak (6 to 70 V peak-peak) 
Frequency Range ............................. 32 to 10,000 Hz  
Terminals.......................................... 32 (+), 31 (–) 

Generator Voltage 
Range ............................................... 12 to 576 V rms 
Terminals.......................................... 45 (A-phase) 
   43 (B-phase) 
   41 (C-phase) 
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Output Contacts 

Start, Run, and Prestart Relays 
Rating ............................................... 5 A, 28 Vdc—general purpose, 1.2 A pilot duty, the load must be in 

parallel with a diode rated at least 3 times the coil current and 3 
times the coil voltage. 

Terminals 
START .............................................. 19, 20 
RUN .................................................. 21, 22 
PRE .................................................. 23, 24 

Programmable Relays (4) 
Rating ............................................... 2 A, 28 Vdc—general purpose, 1.2 A pilot duty, the load must be in 

parallel with a diode rated at least 3 times the coil current and 3 
times the coil voltage. 

Terminals 
Output 1............................................ 26, 25 (common) 
Output 2............................................ 27, 25 (common) 
Output 3............................................ 29, 28 (common) 
Output 4............................................ 30, 28 (common) 
The programmable relays share common terminals: terminal 25 is used for outputs 1 and 2, terminal 28 is 
used for outputs 3 and 4. 

Metering 

Generator and Bus Voltage (rms) 
Metering Range ................................ 0 to 576 Vac (direct measurement) 
   577 to 9,999 Vac (through VT using VT ratio setting) 
VT Ratio Range ................................ 1:1 to 125:1 in primary increments of 1 
Accuracy* ......................................... ±3.0% of programmed rated voltage or ±3 Vac 
Display Resolution ........................... 1 Vac 

* Voltage metering indicates 0 V when generator voltage is below 2% of the full-scale rating. 

Generator Current (rms) 
Generator current is measured at the secondary windings of user-supplied 1 A or 5 A CTs. 
Metering Range ................................ 0 to 5,000 Aac 
CT Primary Range ........................... 1 to 5,000 Aac in primary increments of 1 Aac 
Accuracy* ......................................... ±3.0% of programmed rated current or ±3 Aac 
Display Resolution ........................... 1 Aac 

* Current metering indicates 0 A when generator current is below 2% of the full-scale rating. 

Generator and Bus Frequency 
Frequency is sensed through the generator and bus voltage inputs (phases A and B). 
Metering Range ................................ 10 to 72 Hz 
Accuracy........................................... ±0.25% or 0.05 Hz 
Display Resolution ........................... 0.1 Hz 

Apparent Power 
Indicates total kVA and individual line kVA (4-wire, line-to-neutral or 3-wire, line-to-line). 

DGC-2020ES Specifications 



176  9469200990 Rev B 

Measurement/Calculation Methods 
Total ................................................. kVA = (VL-L × IL ×√3) ÷ 1000 
4-Wire, Line-to-Neutral ..................... kVA calculated with respect to neutral 
3-Wire, Line-to-Line .......................... A-phase kVA = VAB × IA ÷ 1000 ÷ √3 
   B-phase kVA = VBC × IB ÷ 1000 ÷ √3 
   C-phase kVA = VCA × IC ÷ 1000 ÷ √3 
Accuracy........................................... ±5% of the full-scale indication or ±6 kVA ∗ 

∗  Applies when temperature is between −40°C to +70°C. KVA metering indicates 0 kVA when the 
generator kVA is below 2% of the full-scale rating. 

Power Factor 
Metering Range ................................ 0.2 leading to 0.2 lagging 
Calculation Method .......................... PF = cosine of the angle between phase AB voltage (Vab) and 

phase A current (Ia) * 
Accuracy........................................... ±0.02 † 

*  In single-phase AC-connected machines, it is the cosine of the angle between phase CA voltage 
(Vca) and phase C current (Ic). 

†  Applies when temperature is between –40°C to +70°C (–40°F to +158°F). 

NOTE 

For the DGC-2020ES to correctly meter power factor, the generator must be 
rotating in the same phase sequence as dictated by the generator phase 
rotation setting. 

Real Power 
Indicates total kW and individual line kW (4-wire, line-to-neutral or 3-wire line-to-line) 

Measurement/Calculation Methods 
Total ................................................. PF × Total kVA 
4-Wire, Line-to-Neutral ..................... kW calculated with respect to neutral 
3-Wire, Line-to-Line .......................... A-phase kW = VAB × IA × PF ÷ 1000 ÷ √3 
   B-phase kW = VBC × IB × PF ÷ 1000 ÷ √3 
   C-phase kW = VCA × IC × PF ÷ 1000 ÷ √3 
Accuracy........................................... ±5% of the full-scale indication or ±4 kW ∗ 

∗  Applies when temperature is between –40°C to +70°C. KW metering indicates 0 kW when the 
generator kW is below 2% of the full-scale rating. 

Oil Pressure 
Metering Range ................................ 0 to 150 psi, 0 to 10.3 bar, or 0 to 1,034 kPa 
Accuracy........................................... ±3% of actual indication or ±2 psi, ±0.12 bar, or ±12 kPa (subject to 

accuracy of sender) 
Display Resolution ........................... 1 psi, 0.1 bar, or 1 kPa 

Coolant Temperature 
Metering Range ................................ 32 to 410°F or 0 to 204°C 
Accuracy........................................... ±3% of actual indication or ±2° (subject to accuracy of sender) 

Battery Voltage 
Metering Range ................................ 6 to 32 Vdc 
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Accuracy........................................... ±3% of actual indication or ±0.2 Vdc 
Display Resolution ........................... 0.1 Vdc 

Engine RPM 
Metering Range ................................ 0 to 4,500 rpm 
Accuracy* ......................................... ±2% of actual indication or ±2 rpm 
Display Resolution ........................... 2 rpm 

* When engine speed is below 2% of full-scale, reported rpm is 0. 

Engine Run Time 
Engine run time is retained in nonvolatile memory. 
Metering Range ................................ 0 to 99,999 hours 
Update Interval ................................. 6 min 
Accuracy........................................... ±1% of actual indication or ±12 min 
Display Resolution ........................... 1 minute 

Maintenance Timer 
Maintenance timer indicates the time remaining until genset service is due. Value is retained in 
nonvolatile memory. 
Metering Range ................................ 0 to 5,000 hours 
Update Interval ................................. 6 min 
Accuracy........................................... ±1% or actual indication or ±12 min 
Display Resolution ........................... 1 minute 

Fuel Level 
Metering Range ................................ 0 to 100% 
Accuracy........................................... ±3% (subject to accuracy of sender) 
Display Resolution ........................... 1.0% 

Generator Protection Functions 

Overvoltage (59) and Undervoltage (27) 
Pickup Range ................................... 70 to 576 Vac 
Pickup Increment ............................. 1 Vac 
Inhibit Frequency Range .................. 20 to 66 Hz (27 function only) 
Activation Delay Range .................... 0 to 30 s 
Activation Delay Increment .............. 0.1 s 

Underfrequency (81U) and Overfrequency (81O) 
Pickup Range ................................... 45 to 66 Hz 
Pickup Increment ............................. 0.1 Hz 
Activation Delay Range .................... 0 to 30 s 
Activation Delay Increment .............. 0.1 s 
Inhibit Voltage Range ....................... 70 to 576 Vac (81U function only) 

Overcurrent (50) 
Pickup Range ................................... 0.18 to 1.18 Aac (1 A current sensing) 
   0.9 to 7.75 Aac (5 A current sensing) 
Time Dial Range .............................. 0 to 7,200 s (fixed time curve) 
Time Dial Increment ......................... 0.1 
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Phase Imbalance (47) 
Pickup Range ................................... 5 to 100 Vac 
Pickup Increment ............................. 1 Vac 
Activation Delay Range .................... 0 to 30 s 
Activation Delay Increment .............. 0.1 s 

Logic Timers 

Hours Setting Range ........................ 0 to 250 
Hours Setting Increment .................. 1 
Minutes Setting Range ..................... 0 to 250 
Minutes Setting Increment ............... 1 
Seconds Setting Range ................... 0 to 1,800 
Seconds Setting Increment .............. 0.1 
Accuracy........................................... ±15 ms 

Communication Interface 

USB 
Specification Compatibility ............... USB 2.0 
Data Transfer Speed ........................ 115,200 baud 
Connector Type ................................ Mini-B jack 

RDP-110 
Minimum Wire Size .......................... 20 AWG 
Maximum Wire Length ..................... 4,000 feet (1,219 meters) 
Terminals.......................................... 11 (RDP TxD+), 10 (RDP TxD–) 

CAN 
Differential Bus Voltage .................... 1.5 to 3 Vdc 
Maximum Voltage ............................ –32 to +32 Vdc with respect to negative battery terminal 
Communication Rate ........................ 250 kb/s 
Terminals.......................................... 14 (low), 13 (high), and 15 (shield) 
 

NOTES 

1. If the DGC-2020ES is providing one end of the J1939 bus, a 120 Ω, ½ watt 
terminating resistor should be installed across terminals 14 (CANL) and 13 
(CANH). 

2. If the DGC-2020ES is not part of the J1939 bus, the stub connecting the 
DGC-2020ES to the bus should not exceed 914 mm (3 ft) in length. 

3. The maximum bus length, not including stubs, is 40 m (131 ft). 

4. The J1939 drain (shield) should be grounded at one point only. If 
grounded elsewhere, do not connect the drain to the DGC-2020ES. 
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Real-Time Clock 

Clock has leap year and selectable daylight saving time correction. Backup capacitor and backup battery 
sustain timekeeping during losses of DGC-2020ES operating power. 
Resolution ........................................ 1 s 
Accuracy........................................... ±1.73 s/d at 25°C 

Clock Holdup 
Battery Holdup Time ........................ Approximately 10 yrs 

Liquid Crystal Display (LCD) 

Display  ............................................ 128 by 64 dot pixels LCD with LED Backlight 
Operating Temperature .................... –40 to +70°C (–40 to +158°F) 
Storage Temperature ....................... –40 to +80°C (–40 to +176°F) 

LCD Heater 
The ambient temperature is monitored by a temperature sensor located near the LCD inside the DGC-
2020ES. The LCD heater turns on when the ambient temperature falls below 0°C (32°F). The heater turns 
off when the ambient temperature rises above 5°C (41°F). This range of operation implements 5°C (9°F) 
of hysteresis between heater turn-on and turn-off. 

Type Tests 

Shock and Vibration ......................... EN60068-2-6 
Dielectric Strength ............................ IEC 255-5 
Impulse  ............................................ EN60664-1 
Transients......................................... EN61000-4-4 
Static Discharge ............................... EN61000-4-2 

Shock 
Withstands 15 G in three perpendicular planes. 

Vibration 
Tested in three mutually perpendicular planes for 8 hours over the following ranges: 
3 to 25 Hz at 1.6 mm (0.063 inches), peak amplitude 
25 to 2,000 Hz at 5G 

Radio Interference 
Type tested using a 5 W, hand-held transceiver operating at random frequencies centered around 144 
and 440 MHz with the antenna located within 150 mm (6”) of the device in both vertical and horizontal 
planes. 

HALT (Highly Accelerated Life Testing) 
HALT is used by Basler Electric to prove that our products will provide the user with many years of 
reliable service. HALT subjects the device to extremes in temperature, shock, and vibration to simulate 
years of operation, but in a much shorter period span. HALT allows Basler Electric to evaluate all possible 
design elements that will add to the life of this device. As an example of some of the extreme testing 
conditions, the DGC-2020ES was subjected to temperature tests (tested over a temperature range of 
–100°C to +130°C), vibration tests (of 5 to 50 G at +20°C), and temperature/vibration tests (tested at 50 G 
over a temperature range of –95°C to +125°C). Combined temperature and vibration testing at these 
extremes proves that the DGC-2020ES is expected to provide long-term operation in a rugged 
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environment. Note that the vibration and temperature extremes listed in this paragraph are specific to 
HALT and do not reflect recommended operation levels. 

Ignition System 
Tested in close proximity to an unshielded, unsuppressed Altronic DISN 800 Ignition System. 

Environment 
Operating Temperature .................... –40 to +70°C (–40 to +158°F) 
Storage Temperature ....................... –40 to +85°C (–40 to +185°F) 
Humidity ........................................... IEC 68-2-38  
Salt Spray ......................................... IEC 68-2-52 
Ingress Protection ............................ IEC IP56 for front panel 

UL Approval 
The DGC-2020ES is recognized to applicable Canadian and US safety standards and requirements by 
UL. 

Standards used for evaluation: 
• UL6200 
• CSA C22.2 No. 14 

CSA Certification 
The DGC-2020ES was tested and has met the certification requirements for electrical, plumbing and/or 
mechanical products. 

Standards used for evaluation: 

• CSA C22.2 No. 14 

NFPA Compliance 
Complies with NFPA Standard 110, Standard for Emergency and Standby Power. 

CE Compliance 
This product has been evaluated and complies with the relevant essential requirements set forth by the 
EU legislation. 

EC Directives: 
• Low Voltage Devices (LVD) - 73/23/EEC as amended by 93/68/EEC 
• Electromagnetic Compatibility (EMC) - 89/336/EEC as amended by 92/31/EEC and 93/68/EEC 

Harmonized Standards used for evaluation: 
• EN 50178 - Electronic Equipment for use in Power Installations 
• EN 61000-6-4 - Electromagnetic Compatibility (EMC), Generic Standards, Emission Standard for 

Industrial Environments 
• EN 61000-6-2 - Electromagnetic Compatibility (EMC), Generic Standards, Immunity for Industrial 

Environments 

Physical 
Weight .............................................. 1.9 lb (0.86 kg) 
Dimensions....................................... See the Mounting chapter. 
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CEM-2020 
General Information 

The optional CEM-2020 is a remote auxiliary device that provides additional DGC-2020ES contact inputs 
and outputs. Two types of modules are available. A low current module (CEM-2020) provides 24 contact 
outputs and high current module (CEM-2020H) provides 18 contact outputs. 

Features 

CEM-2020s have the following features: 
• 10 Contact Inputs 
• 18 Contact Outputs (CEM-2020H) or 24 Contact Outputs (CEM-2020) 
• Functionality of Inputs and Outputs assigned by BESTlogic™Plus Programmable Logic 
• Communications via CAN 

Specifications 

Operating Power 
Nominal  .................................................. 12 or 24 Vdc 
Range  ..................................................... 8 to 32 Vdc (Withstands cranking ride-through down to  

6 Vdc for 500 ms) 

Maximum Power Dissipation 
CEM-2020 ............................................... 14 W 
CEM-2020H............................................. 8 W 

Contact Inputs 
The CEM-2020 contains 10 programmable inputs that accept dry contacts. 

Time from a CEM-2020 input application to: 
• Shut down the generator via an alarm = 700 ms max 
• Close a relay on board the DGC-2020ES = 300 ms max 
• Close a relay on board the CEM-2020 = 550 ms max 

Contact Outputs 

Ratings 

CEM-2020 
Outputs 5 through 16 .............................. 1 Adc at 30 Vdc, Form C, gold contacts 
Outputs 17 through 28 ............................ 4 Adc at 30 Vdc, Form C 

CEM-2020H 
Outputs 5 through 16 .............................. 2 Adc at 30 Vdc, Form C, gold contacts 
Outputs 17 through 22 ............................ 10 Adc at 30 Vdc, Form C 

Communications Interface 

CAN 
Differential Bus Voltage ........................... 1.5 to 3 Vdc 
Maximum Voltage ................................... –32 to +32 Vdc with respect to negative battery terminal 
Communication Rate ............................... 250 kb/s 
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Type Tests 

Shock 

Withstands 15 G in three perpendicular planes. 

Vibration 

Swept over the following ranges for12 sweeps in each of three mutually perpendicular planes with each 
15-minute sweep consisting of the following: 
5 to 29 to 5 Hz ......................................... 1.5 G peak for 5 min. 
29 to 52 to 29 Hz ..................................... 0.036” Double Amplitude for 2.5 min. 
52 to 500 to 52 Hz ................................... 5 G peak for 7.5 min. 

Ignition System 

Tested in close proximity to an unshielded, unsuppressed Altronic DISN 800 ignition system. 

HALT (Highly Accelerated Lift Testing) 

HALT is used by Basler Electric to prove that our products will provide the user with many years of 
reliable service. HALT subjects the device to extremes in temperature, shock, and vibration to simulate 
years of operation, but in a much shorter period span. HALT allows Basler Electric to evaluate all possible 
design elements that will add to the life of this device. As an example of some of the extreme testing 
conditions, the CEM-2020 was subjected to temperature tests (tested over a temperature range of –80°C 
to +130°C), vibration tests (of 5 to 50 G at +25°C), and temperature/vibration tests (tested at 10 to 20 G 
over a temperature range of –60°C to +100°C). Combined temperature and vibration testing at these 
extremes proves that the CEM-2020 is expected to provide long-term operation in a rugged environment. 
Note that the vibration and temperature extremes listed in this paragraph are specific to HALT and do not 
reflect recommended operation levels. These operational ratings are included in this section. 

Environment 
Humidity .................................................. Complies with IEC 68-2-38  

Temperature 
Operating................................................. –40 to +70°C (–40 to +158°F) 
Storage  ................................................... –40 to +85°C (–40 to +185°F) 

UL Approval (CEM-2020 Only) 
“cURus” recognized to UL Standard 508 & CSA Standard C22.2 No. 14. 

UL Approval (CEM-2020H Only) 
UL recognized to UL Standard 508. 

CSA Certification 
CSA certified to Standard C22.2 No.14. 

NFPA Compliance 
Complies with NFPA Standard 110, Standard for Emergency and Standby Power. 

CE Compliance 
This product complies with the requirements of the following EC Directives: 

• Low Voltage Directive (LVD) - 73/23/EEC as amended by 93/68/EEC 
• Electromagnetic Compatibility (EMC) - 89/336/EEC as amended by 92/31/EEC and 93/68/EEC   
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This product conforms to the following Harmonized Standards: 

• EN 50178:1997 - Electronic Equipment for use in Power Installations 

• EN 61000-6-4:2001 - Electromagnetic Compatibility (EMC), Generic Standards, Emission 
Standard for Industrial Environments 

• EN 61000-6-2:2001 - Electromagnetic Compatibility (EMC), Generic Standards, Immunity for 
Industrial Environments 

Physical 
Dimensions.............................................. See Installation later in this chapter. 

Weight 
CEM-2020 ............................................... 2.25 lb (1.02 kg) 
CEM-2020H............................................. 1.90 lb (0.86 kg) 

Functional Description 

Contact Inputs 
The CEM-2020 provides 10 programmable contact inputs with the same functionality as the contact 
inputs on the DGC-2020ES. The label text of each contact input is customizable. 

Contact Outputs 

CEM-2020 

The CEM-2020 provides 24 programmable contact outputs with the same functionality as the contact 
outputs on the DGC-2020ES. Outputs 5 through 16 can carry 1 A. Outputs 17 through 28 can carry 4 A. 
The label text of each contact output is customizable. 

CEM-2020H 

The CEM-2020H provides 18 programmable contact outputs with the same functionality as the contact 
outputs on the DGC-2020ES. Outputs 5 through 16 can carry 2 A. Outputs 17 through 22 can carry 10 A. 
The label text of each contact output is customizable. 

Communications 

CAN 

A Control Area Network (CAN) is a standard interface that enables communication between the CEM-
2020 and the DGC-2020ES. 

BESTCOMSPlus® Software 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the Contact 
Expansion Module. Installation and operation of BESTCOMSPlus is described in the BESTCOMSPlus 
chapter. 

Installation 

Contact Expansion Modules are delivered in sturdy cartons to prevent shipping damage. Upon receipt of 
a module, check the part number against the requisition and packing list for agreement. Inspect for 
damage, and if there is evidence of such, immediately file a claim with the carrier and notify the Basler 
Electric regional sales office or your sales representative. 
If the device is not installed immediately, store it in the original shipping package in a moisture- and dust-
free environment. 
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Mounting 
Contact Expansion Modules are contained in a potted plastic case and may be mounted in any 
convenient position. The construction of a Contact Expansion Module is durable enough to mount directly 
on a genset using ¼-inch hardware. Hardware selection should be based on any expected 
shipping/transportation and operating conditions. The torque applied to the mounting hardware should not 
exceed 65 in-lb (7.34 N•m). 

See Figure 84 for CEM-2020 overall dimensions. All dimensions are shown in inches with millimeters in 
brackets. 

 
Figure 84. CEM-2020 Overall Dimensions 

 

See Figure 85 for CEM-2020H overall dimensions. All dimensions are shown in inches with millimeters in 
brackets. 
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Figure 85. CEM-2020H Overall Dimensions 

Connections 
Contact Expansion Module connections are dependent on the application. Incorrect wiring may result in 
damage to the module. 

Note 

Operating power from the battery must be of the correct polarity. 
Although reverse polarity will not cause damage, the CEM-2020 will 
not operate. 

Be sure that the CEM-2020 is hard-wired to earth ground with no 
smaller than 12 AWG copper wire attached to the chassis ground 
terminal on the module. 

Terminations 

The terminal interface consists of plug-in connectors with screw-down compression terminals. 

CEM-2020 connections are made with one 5-position connector, two 18-position connectors, and two 24-
position connectors with screw-down compression terminals. These connectors plug into headers on the 
CEM-2020. The connectors and headers have dovetailed edges that ensure proper connector orientation. 
The connectors and headers are uniquely keyed to ensure that the connectors mate only with the correct 
headers. Connector screw terminals accept a maximum wire size of 12 AWG (3.31 mm2). Maximum 
screw torque is 5 inch-pounds (0.56 N•m). 

5.50 [139.7]

6.38 [162.1]

7.50 [190.5]

8.38 [212.9]

2.23 [56.6]
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Operating Power 

The Contact Expansion Module operating power input accepts either 12 Vdc or 24 Vdc and tolerates 
voltage over the range of 6 to 32 Vdc. Operating power must be of the correct polarity. Although reverse 
polarity will not cause damage, the CEM-2020 will not operate. Operating power terminals are listed in 
Table 32. 

It is recommended that a fuse be added for additional protection for the wiring to the battery input of the 
Contact Expansion Module. A Bussmann ABC-7 fuse or equivalent is recommended. 

Table 32. Operating Power Terminals 

Terminal Description 

P1-  (SHIELD) Chassis ground connection 

P1- – (BATT–) Negative side of operating power input 

P1 + (BATT+) Positive side of operating power input 

Contact Inputs and Contact Outputs 

The CEM-2020 (Figure 86) has 10 contact inputs and 24 contact outputs. The CEM-2020H (Figure 87) 
has 10 contact inputs and 18 contact outputs. 

Note 

To follow UL guidelines, a fuse must be implemented in the 2Adc 
contact circuits (Outputs 5 through 16) of the CEM-2020H used in 
hazardous locations. The suggested fuse size in Adc = (100/Contact 
Voltage) with a maximum fuse size of 5Adc. 
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Figure 86. CEM-2020 Contact Input and Contact Output Terminals 
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Figure 87. CEM-2020H Contact Input and Contact Output Terminals 

CAN Interface 

These terminals provide communication using the SAE J1939 protocol and provide high-speed 
communication between the Contact Expansion Module and the DGC-2020ES. Connections between the 
CEM-2020 and DGC-2020ES should be made with twisted-pair, shielded cable. CAN interface terminals 
are listed in Table 33. Refer to Figure 88 and Figure 89. 

Table 33. CAN Interface Terminals 

Terminal Description 
P1- HI (CAN H) CAN high connection (yellow wire) 

P1- LO (CAN L) CAN low connection (green wire) 

P1-  (SHIELD) CAN drain connection 
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Note 

1. If the CEM-2020 is providing one end of the J1939 bus, a 120 Ω, 
½ watt terminating resistor should be installed across terminals 
P1- LO (CANL) and P1- HI (CANH). 

2. If the CEM-2020 is not part of the J1939 bus, the stub connecting 
the CEM-2020 to the bus should not exceed 914 mm (3 ft) in 
length. 

3. The maximum bus length, not including stubs, is 40 m (131 ft). 

4. The J1939 drain (shield) should be grounded at one point only. If 
grounded elsewhere, do not connect the drain to the CEM-2020. 

 

 
Figure 88. CAN Interface with CEM-2020 providing One End of the Bus 

 

 
Figure 89. CAN Interface with DGC-2020ES providing One End of the Bus 
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Remote Contact Input Configuration 

The CEM-2020 provides 10 contact inputs. Each of the 10 contact inputs can be independently 
configured to annunciate an alarm or pre-alarm when the input senses a contact closure. A user-
adjustable time delay can be set to delay recognition of a contact input. By default, all inputs are 
configured so that they do not trigger an alarm or pre-alarm. 

To make identifying the contact inputs easier, a user-assigned name can be given to each input. 

Contacts can be recognized always or only while the engine is running. 

The remote contact inputs are incorporated into a BESTlogicPlus programmable logic scheme by 
selecting them from the I/O group in BESTlogicPlus. For more details, refer to the BESTlogicPlus chapter. 

Remote contact input status is available in BESTlogicPlus Programmable Logic when “None” is selected 
for Alarm Configuration. 

The Remote Contact Inputs screen is found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Inputs > 
Configurable Inputs. The BESTCOMSPlus Remote Contact Inputs screen is illustrated in Figure 90. 

 
Figure 90. Settings Explorer, Programmable Inputs, Remote Contact Inputs Screen 

Remote Contact Output Configuration 

To make identifying the contact outputs easier, each of the contact outputs can be given a user-assigned 
name. 
The contact outputs are incorporated into a BESTlogicPlus programmable logic scheme by selecting 
them from the I/O group in BESTlogicPlus. For more details, refer to the BESTlogicPlus chapter. 
The Remote Contact Outputs screen is found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Outputs > 
Configurable Outputs. The BESTCOMSPlus Contact Outputs screen is illustrated in Figure 91. 
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Figure 91. Settings Explorer, Programmable Outputs, Remote Contact Outputs Screen 

Maintenance 

Preventive maintenance consists of periodically checking that the connections between the CEM-2020 
and the system are clean and tight. Contact Expansion Modules are manufactured using state-of-the-art 
surface-mount technology. As such, Basler Electric recommends that no repair procedures be attempted 
by anyone other than Basler Electric personnel. 
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MTU Fault Codes 
A DGC-2020ES connected to a genset equipped with an MTU engine ECU tracks and displays the active 
fault codes issued by the MTU engine ECU. Active MTU fault codes can be viewed through 
BESTCOMSPlus® by using the Metering Explorer to expand the MTU tree or through the front panel 
display by navigating to METERING, ALARMS-STATUS, MTU FAULT CODES. 

Each fault code is displayed with a fault description and the fault number. If the DGC-2020ES does not 
have descriptive information about a fault number that was received, the fault description will display 
as “NO TEXT AVAILABLE”. Fault codes displayed by the DGC-2020ES are listed in Table 34. 

Table 34. MTU Fault Codes 

Fault 
Code 

Number 
String Description 

3 HI T FUEL Fuel temperature too high (limit 1). 

4 SS T FUEL Fuel temperature too high (limit 2). 

5 HI T CHRG AIR Charge air temperature too high (limit 1). 

6 SS T CHRG AIR Air temperature too high (limit 2). 

9 HI T INTERCOOLER Coolant temperature of intercooler too high (limit 1). 

10 SS T INTERCOOLER Coolant temperature of intercooler too high (limit 2) 

15 LO P LUBE OIL Pressure of lube oil too low (limit 1). 

16 SS P LUBE OIL Pressure of lube oil too low (limit 2). 

19 HI T EXHAUST A Exhaust gas temperature (A-side) too high (limit 1). 

20 SS T EXHAUST A Exhaust gas temperature (A-side) too high (limit 2) 

21 HIT T EXHAUST B Exhaust gas temperature (B-side) too high (limit 1). 

22 SS T EXHAUST B Exhaust gas temperature (B-side) too high (limit 2). 

23 LO COOLANT LEVEL Coolant level too low (limit 1). 

24 SS COOLANT LEVEL Coolant level too low (limit 2). 

25 HI P DIFF LUBE OIL Differential pressure of oil filter too high (limit 1). 

26 SS P DIFF LUBE OIL Differential pressure of oil filter too high (limit 2). 

27 HI LEVEL LEAKAGE FUEL Level of leakage fuel too high (limit 1). 

29 HI ETC IDLE SPD TOO HI Idle speed of one of the switchable chargers too high. 

30 SS ENGINE OVERSPEED Engine overspeed (limit 2). 

31 HI ETC1 OVERSPEED Speed of basic charger too high (limit 1). 

32 SS ETC1 OVERSPEED Speed of basic charger too high (limit 2). 

33 L1 P FUELFLT DIF Differential pressure of fuel filter too high (limit 1). 

36 HI ETC2 OVERSPEED Speed of 1st switchable charger too high (limit 1). 

37 SS ETC2 OVERSPEED Speed of 1st switchable charger too high (limit 2). 

38 AL ETC SPEED DEVIATION Speed deviation between basic turbocharger and one of the 
switchable chargers. 

39 AL ETC2 CUTIN FAIL Switching of charger ETC2 failed. 

44 LO LEVEL INTRCLR Coolant level of intercooler too low (limit 1). 

45 FAULT L2 LEVEL INTRCLR Coolant level of intercooler too low (limit 2). 

51 HI T LUBE OIL Lube oil temperature too high (limit 1). 

52 SS T LUBE OIL Lube oil temperature too high (limit 2). 

57 LO P COOLANT Coolant pressure too low (limit 1). 
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Fault 
Code 

Number 
String Description 

58 SS P COOLANT Coolant pressure too low (limit 2). 

59 SS T COOLANT L3 Coolant temperature too high/too low (limit 3). 

60 SS T COOLANT L4 Coolant temperature too high/too low (limit 4). 

63 HI P CRANKCASE Crankcase pressure too high (limit 1). 

64 SS P CRANK CASE Crankcase pressure too high (limit 2). 

65 LO P FUEL Fuel supply pressure too low (limit 1). 

66 SS P FUEL Fuel supply pressure too low (limit 2). 

67 HI T COOLANT Coolant temperature too high (limit 1). 

68 SS T COOLANT Coolant temperature too high (limit 2). 

69 L1 T EXTERN 1 Limit 1, out of range. 

70 L2 T EXTERN 1 Limit 2, out of range. 

71 L1 T EXTERN 2 Limit 1, out of range. 

72 L2 T EXTERN 2 Limit 2, out of range. 

73 L1 P EXTERN 1 Limit 1, out of range. 

74 L2 P EXTERN 1 Limit 2, out of range. 

75 L1 P EXTERN 2 Limit 1, out of range. 

76 L2 P EXTERN 2 Limit 2, out of range. 

77 LIM EXT CLNT LEV Binary signal 1 Plant active. 

78 LIM INTERCLR LEV Binary signal 2 Plant active. 

79 L BIN EXTERN 3 Binary signal 3 Plant active. 

80 L BIN EXTERN 4 Binary signal 4 Plant active. 

81 AL RAIL LEAKAGE Rail pressure gradient too low for Start or too high for Stop. 

82 HI P FUEL COMON RAIL Rail pressure > setpoint value. 

83 LO P FUEL COMMON RAIL Rail pressure < setpoint value. 

85 HI T UMBLASSEN ‘Umblasen’ temperature too high (limit 1). 

86 SS T UMBLASSEN ‘Umblasen’ temperature too high (limit 2). 

89 SS SPEED TOO LOW Engine is being stalled. The engine speed of the normally 
operating engine dropped below the limit from parameter 
2.2500.027 Limit Engine Speed Low without any stop request. 
For safety reason the engine is stopped when this event occurs. 

90 SS IDLE SPEED LOW Idle speed not reached. 

91 SS RELEASE SPEED LO Acceleration speed not reached. 

92 SS STARTER SPEED LO Starter speed not reached. 

93 SS PREHT TMP Preheat temperature too low (limit 2). 

94 LO PREHT TMP Preheat temperature too low (limit 1). 

95 AL PRELUBE FAULT Pre-lubrication fault. 

100 EDM NOT VALID Checksum fault EDM. 

101 IDM NOT VALID Checksum fault IDM. 

102 INVLD FUEL CNS 1 Fuel consumption counter detect. 

103 INVLD FUEL CNS 2 Consumption monitoring 2 not valid. 

104 ENG HRS INVALID 1 Engine Hours Counter defect. 

105 ENG HRS INVALID 2 Checksum fault. 

106 ERR REC1 INVALID Checksum fault. 
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Fault 
Code 

Number 
String Description 

107 ERR REC2 INVALID Checksum fault. 

118 LO ECU SUPPLY VOLTS Power supply voltage too low (limit 1). 

119 LOLO ECU SUPPLY VOLTS Power supply voltage too low (limit 2). 

120 HI ECU SUPPLY VOLTS Power supply voltage too high (limit 1). 

121 HIHI ECU SUPPLY VOLTS Power supply voltage too high (limit 2). 

122 HI T ECU Temperature of electronic too high (limit 1). 

134 15v POSECU DEFCT Internal electronic fault. 

136 15V NEGECU DEFCT Internal electronic fault. 

137 L1 5V BUFFR TEST Pressure-sensor fault, pressure-sensor wiring, or internal 
electronic fault. 

138 SENSOR PWR DEFCT Pressure-sensor fault, pressure-sensor wiring, or internal 
electronic fault. 

139 L1 TE BUFFR TEST Internal electronic fault. 

140 TE BUF ECU DEFCT Internal electronic fault. 

141 AL POWER TOO HIGH AL power too high. 

142 MCR EXCEEDED 1 HR STR AL MCR exceeded 1 hour. 

143 BANK1 ECU DEFECT Internal electronic fault. 

144 BANK2 ECU DEFECT Internal electronic fault. 

145 15V GOODECU DFCT Internal electronic fault. 

147 AD TST1ECU DEFCT Internal electronic fault. 

149 AD TST2ECU DEFCT Internal electronic fault. 

151 AD TST3ECU DEFCT Internal electronic fault. 

170 MI MODULE FAIL Module in maintenance indicator defect. 

171 MI NOT ACTIVE WI not active anymore. 

172 TBO EXPIRED TBO expired. 

173 MODL WRITE LIMIT EEPROM write limit reached. 

176 AL LIFE DATA NA No (fitting) LifeData-Backup-System is available within a delay 
time after ECU Reset. 

177 AL LIFE DATA INCPLT If the ADEC has to restore the LifeData from the backup-system 
and at least one checksum is wrong after the upload or the 
upload is incomplete, then this failure is set. 

180 AL CAN1 NODE LOST Connection to a node on CAN 1 lost. 

181 AL CAN2 NODE LOST Connection to a node on CAN 2 lost. 

182 AL CAN WRONG PARAMS Incorrect CAN parameter values have been entered. 

183 AL CAN NO PU DATA A CAN mode is selected which the communication is initialized 
aided of the PU data module. However, required PU data 
module is not present or is not valid. 

184 AL CAN PUDATA ERR During attempt to copy a received PU data module to Flash 
module, a program error occurred. 

185 CAN LESS MAILBXS CAN less mailboxes. 

186 AL CAN1 BUS OFF CAN controller 1 is in “Bus Off” state. 

187 AL CAN1 ERR PASSV CAN controller 1 has signaled a warning. 

188 AL CAN2 BUS OFF CAN controller 2 is in “Bus Off” state. 

189 AL CAN2 ERROR PASSV CAN controller 2 has signaled a warning. 
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Fault 
Code 

Number 
String Description 

190 AL EMU PARAM NO SUPPORT EMU parameters are not supported. 

201 SD T COOLANT Coolant temperature-sensor defect. 

202 SD T FUEL Fuel temperature-sensor defect. 

203 SD T CHARGE AIR Charge air temperature-sensor defect. 

205 SD T CLNT INTERC Intercooler coolant temperature-sensor defect. 

206 SD T EXHAUST A Exhaust gas temperature-sensor on A-side defect. 

207 SD T EXHAUST B Exhaust gas temperature-sensor on B-side defect. 

208 SD P CHARGE AIR Charge air pressure-sensor defect. 

211 SD P LUBE OIL Lube oil pressure-sensor defect. 

212 SD P COOLANT Coolant pressure-sensor defect. 

213 SD P COOLANT INTRCOOLR Intercooler coolant pressure-sensor defect. 

214 SD P CRANKCASE Crankcase pressure-sensor defect. 

215 SD P HD Rail pressure-sensor defect. 

216 SD T LUBE OIL Lube oil temperature-sensor defect. 

219 SD T INTAKE AIR Intake air temperature-sensor defect. 

220 SD COOLANT LEVEL Sensor for coolant level defect. 

221 SD P DIFF LUBE OIL Sensor for differential pressure of lube oil defect. 

222 SL LVL LKG FUEL Sensor for leakage level of fuel defect. 

223 SD LVL INTERCLR Sensor for coolant level of intercooler defect. 

227 SD PRE FILT P LUBE OIL Pressure sensor for lube oil before filter defect. 

229 AL SD CAM STOP Sensor of Camshaft defect and sensor of crankshaft defect 
before. 

230 SD CRANKSHFT SPD Sensor defect on crankshaft. 

231 SD CAMSHAFT SPD Sensor defect on camshaft. 

232 SD CHARGER1 SPEED Speed-sensor of basic charger defect. 

233 SD CHARGER2 SPEED Speed-sensor of switching charger defect. 

240 SD P FUEL Fuel pressure-sensor defect. 

241 SD T UMBLASSEN Temperature-sensor of recirculated charge air defect. 

242 SD T COOLANT R Redundant coolant temperature-sensor defect. 

244 SD P LUBE OIL R Redundant pressure sensor for lube oil defect. 

245 SD POWER SUPPLY Internal ECU error. 

246 SD T ELECTRONIC Internal ECU fault. 

249 SD CAN STOP Missing data CAN. 

250 SD CAN SPD DEMND Missing data CAN. 

251 SD CAN UP DOWN Missing data CAN. 

252 SD CAN NOTCH POS Missing data CAN. 

253 SD CAN OVERRIDE Missing data CAN. 

254 SD CAN TST OVRSP Missing data CAN. 

255 SD CAN ENGAGE SIG Missing data CAN. 

256 SD CAN CYL CUTOUT Missing data CAN. 

257 SD CAN LOCAL Missing data CAN. 

258 SD CAN RCS ENGAGE Missing data CAN. 
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Fault 
Code 

Number 
String Description 

259 SD CAN RCS CYL CT Missing data CAN. 

260 SD 15V POS SPPLY Internal ECU fault. 

261 15V POS SPPLY Internal ECU fault. 

262 SD 5V BUFFR TEST Internal ECU fault. 

263 SD TE BUFFR TEST Internal ECU fault. 

264 SD BANK 1 TEST Internal ECU fault. 

265 SD BANK 2 TEST Internal ECU fault. 

266 SD SPD DEMAND AN Analog speed demand defect. 

267 SD SPDMTEST BNCH Short circuit, cable breakage. 

268 SD SPINUT Analog spinning value defect. 

269 SD LOAD ANLG FLT Filtered analog load pulse signal not available. 

270 SD FREQUENCY INPUT Frequency input defect. 

271 SD T EXTERN 1 Missing data CAN. 

272 SD T EXTERN 2 Missing data CAN. 

273 SD P EXTERN 1 Missing data CAN. 

274 SD P EXTERN 2 Missing data CAN. 

275 SD EXT CLNT LVL Missing data CAN. 

276 SD INTERCLER LVL Missing data CAN. 

277 SD BIN EXT3 Missing data CAN. 

278 SD BIN EXT4 Missing data CAN. 

279 SD CANRES TRIPFL Missing data CAN. 

280 SD CAN ALRM RST Missing data CAN. 

281 SD ADTEST1 SPPLY Internal ECU fault. 

282 SD ADTEST 2 SPPLY Internal ECU fault. 

283 SD ADTEST3 SPPLY Internal ECU fault. 

284 SD CAN LAMP TEST Missing data CAN. 

285 SD CAN IDLE RQ SR Missing data CAN. 

286 SD CAN IDLE REQ Missing data CAN. 

287 SD CAN IDLE REQ Missing data CAN. 

288 SD CAN TRBOSW LCK Missing data CAN. 

301 TIMING CYLNDR A1 Error in timing of injector cylinder A1: timing value too low/high. 

302 TIMING CYLNDR A2 Error in timing of injector cylinder A2: timing value too low/high. 

303 TIMING CYLNDR A3 Error in timing of injector cylinder A3: timing value too low/high. 

304 TIMING CYLNDR A4 Error in timing of injector cylinder A4: timing value too low/high. 

305 TIMING CYLNDR A5 Error in timing of injector cylinder A5: timing value too low/high. 

306 TIMING CYLNDR A6 Error in timing of injector cylinder A6: timing value too low/high. 

307 TIMING CYLNDR A7 Error in timing of injector cylinder A7: timing value too low/high. 

308 TIMING CYLNDR A8 Error in timing of injector cylinder A8: timing value too low/high. 

309 TIMING CYLNDR A9 Error in timing of injector cylinder A9: timing value too low/high. 

310 TIMING CYLNDR A10 Error in timing of injector cylinder A10: timing value too low/high. 

311 TIMING CYLNDR B1 Error in timing of injector cylinder B1: timing value too low/high. 

312 TIMING CYLNDR B2 Error in timing of injector cylinder B2: timing value too low/high. 
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Fault 
Code 

Number 
String Description 

313 TIMING CYLNDR B3 Error in timing of injector cylinder B3: timing value too low/high. 

314 TIMING CYLNDR B4 Error in timing of injector cylinder B4: timing value too low/high. 

315 TIMING CYLNDR B5 Error in timing of injector cylinder B5: timing value too low/high. 

316 TIMING CYLNDR B6 Error in timing of injector cylinder B6: timing value too low/high. 

317 TIMING CYLNDR B7 Error in timing of injector cylinder B7: timing value too low/high. 

318 TIMING CYLNDR B8 Error in timing of injector cylinder B8: timing value too low/high. 

319 TIMING CYLNDR B9 Error in timing of injector cylinder B9: timing value too low/high. 

320 TIMING CYLNDR B10 Error in timing of injector cylinder B10: timing value too low/high. 

321 WIRING CYLNDR A1 Short circuit in injector cable of cylinder A1. 

322 WIRING CYLNDR A2 Short circuit in injector cable of cylinder A2. 

323 WIRING CYLNDR A3 Short circuit in injector cable of cylinder A3. 

324 WIRING CYLNDR A4 Short circuit in injector cable of cylinder A4. 

325 WIRING CYLNDR A5 Short circuit in injector cable of cylinder A5. 

326 WIRING CYLNDR A6 Short circuit in injector cable of cylinder A6. 

327 WIRING CYLNDR A7 Short circuit in injector cable of cylinder A7. 

328 WIRING CYLNDR A8 Short circuit in injector cable of cylinder A8. 

329 WIRING CYLNDR A9 Short circuit in injector cable of cylinder A9. 

330 WIRING CYLNDR A10 Short circuit in injector cable of cylinder A10. 

331 WIRING CYLNDR B1 Short circuit in injector cable of cylinder B1. 

332 WIRING CYLNDR B2 Short circuit in injector cable of cylinder B2. 

333 WIRING CYLNDR B3 Short circuit in injector cable of cylinder B3. 

334 WIRING CYLNDR B4 Short circuit in injector cable of cylinder B4. 

335 WIRING CYLNDR B5 Short circuit in injector cable of cylinder B5. 

336 WIRING CYLNDR B6 Short circuit in injector cable of cylinder B6. 

337 WIRING CYLNDR B7 Short circuit in injector cable of cylinder B7. 

338 WIRING CYLNDR B8 Short circuit in injector cable of cylinder B8. 

339 WIRING CYLNDR B9 Short circuit in injector cable of cylinder B9. 

340 WIRING CYLNDR B10 Short circuit in injector cable of cylinder B10. 

341 OPN LD CYLNDR A1 Open load in injector cable of cylinder A1. 

342 OPN LD CYLNDR A2 Open load in injector cable of cylinder A2. 

343 OPN LD CYLNDR A3 Open load in injector cable of cylinder A3. 

344 OPN LD CYLNDR A4 Open load in injector cable of cylinder A4. 

345 OPN LD CYLNDR A5 Open load in injector cable of cylinder A5. 

346 OPN LD CYLNDR A6 Open load in injector cable of cylinder A6. 

347 OPN LD CYLNDR A7 Open load in injector cable of cylinder A7. 

348 OPN LD CYLNDR A8 Open load in injector cable of cylinder A8. 

349 OPN LD CYLNDR A9 Open load in injector cable of cylinder A9. 

350 OPN LD CYLNDR A10 Open load in injector cable of cylinder A10. 

351 OPN LD CYLNDR B1 Open load in injector cable of cylinder B1. 

352 OPN LD CYLNDR B2 Open load in injector cable of cylinder B2. 

353 OPN LD CYLNDR B3 Open load in injector cable of cylinder B3. 

354 OPN LD CYLNDR B4 Open load in injector cable of cylinder B4. 
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Fault 
Code 

Number 
String Description 

355 OPN LD CYLNDR B5 Open load in injector cable of cylinder B5. 

356 OPN LD CYLNDR B6 Open load in injector cable of cylinder B6. 

357 OPN LD CYLNDR B7 Open load in injector cable of cylinder B7. 

358 OPN LD CYLNDR B8 Open load in injector cable of cylinder B8. 

359 OPN LD CYLNDR B9 Open load in injector cable of cylinder B9. 

360 OPN LD CYLNDR B10 Open load in injector cable of cylinder B10. 

361 AL POWER STAGE LOW Internal error of electronic. 

362 AL POWER STAGE HIGH Internal error of electronic. 

363 AL STOP POWER STAGE Internal error of electronic. 

364 AL STOP POWER STAGE 2 Internal error of electronic. 

365 AL MV WIRING GND Cable line error. 

371 AL WIRING TO 1 Short circuit or open load on transistor output 1 (TO 1). 

372 AL WIRING TO 2 Short circuit or open load on transistor output 2 (TO 2). 

373 AL WIRING TO 3 Short circuit or open load on transistor output 3 (TO 3). 

374 AL WIRING TO 4 Short circuit or open load on transistor output 4 (TO 4). 

381 AL WIRING TOP 1 Short circuit or open load on transistor output plant 1 (TOP 1). 

382 AL WIRING TOP 2 Short circuit or open load on transistor output plant 2 (TOP 2). 

383 AL WIRING TOP 3 Short circuit or open load on transistor output plant 3 (TOP 3). 

384 AL WIRING TOP 4 Short circuit or open load on transistor output plant 4 (TOP 4). 

385 AL WIRING TOP 5 Short circuit or open load on transistor output plant 5 (TOP 5). 

386 AL WIRING TOP 6 Short circuit or open load on transistor output plant 6 (TOP 6). 

390 AL MCR EXCEEDED DBR/MCR Function: MCR (Maximum Continuous Rating) in 
exceeded. 

392 HI T COOLNT R Redundant coolant temperature too high (limit 1). 

393 SS T COOLNT R Redundant coolant temperature too high (limit 2). 

394 LO P LUBE OIL R Redundant pressure of lube oil too low (limit 1). 

395 SS P LUBE OIL R Redundant pressure of lube oil too low (limit 2). 

396 TD T COOLANT Maximum deviation of T-Coolant sensors. 

397 TD P LUBE OIL Maximum deviation of P-Oil sensors. 

399 AL INTERFACE ECU Interface ECU. 

400 AL OPN LD DIGIN 1 Open load on digital input 1. 

401 AL OPN LD DIGIN 2 Open load on digital input 2. 

402 AL OPN LD DIGIN 3 Open load on digital input 3. 

403 AL OPN LD DIGIN 4 Open load on digital input 4. 

404 AL OPN LD DIGIN 5 Open load on digital input 5. 

405 AL OPN LD DIGIN 6 Open load on digital input 6. 

406 AL OPN LD DIGIN 7 Open load on digital input 7. 

407 AL OPN LD DIGIN 8 Open load on digital input 8. 

408 AL OPN LD E STOP Open load on input for emergency stop. 

410 LO U PDU Power driver voltage (injectors) too low (limit 1). 

411 LOLO U PDU Power driver voltage (injectors) too low (limit 2). 

412 HI U PDU Power driver voltage (injectors) too high (limit 1). 

DGC-2020ES MTU Fault Codes 



200  9469200990 Rev B 

Fault 
Code 

Number 
String Description 

413 HIHI U PDU Power driver voltage (injectors) too high (limit 2). 

414 HI L WATER FUEL PREFILT Water level of fuel prefilter too high (limit 1). 

415 LO P COOLANT INTRCOOLR Coolant pressure of intercooler too low (limit 1). 

416 SS P COOLANT INTRCOOLR Coolant pressure of intercooler too low (limit 2). 

417 SD L WATER FUEL PREFILT Water level-sensor of fuel pre-filter defect. 

420 AL L1 AUX 1 Input of Aux 1 injured limit 1. 

421 AL L2 AUX 1 Input of Aux 1 injured limit 2. 

428 AL L1 T AUX 1 Temperature input of Aux 1 injured limit 1. 

438 LO P FUEL RAIL 2 STR Low pressure on fuel rail 2. 

439 HI P FUEL RAIL 2 STR Hi pressure on fuel rail 2. 

440 AL L1 P AUX 1 Pressure input of Aux 1 injured limit 1. 

441 AL RAIL 2 LEAKAGE STR Alarm fuel rail 2 leak detected. 

442 AL L2 P AUX 1 Pressure input of Aux 1 injured limit 2. 

444 SD U PDU Sensor defect of Injector Power driver unit. 

445 SD P AMBIENT AIR Ambient air pressure-sensor defect. 

448 HI P CHARGE AIR Pressure of charge air too high (limit 1). 

449 SS P CHARGE AIR Pressure of charge air too high (limit 2). 

450 SD IDLE END TRQ IN Input of Idle/End-Torque defect 

454 SS PWR RED ACT Power Reduction is activated. 

455 AL L1 AUX1 PLANT Input of Aux 1 (plant) injured limit 1. 

456 AL L2 AUX1 PLANT Input of Aux 1 (plant) injured limit 2. 

461 LO T EXHAUST EMU Exhaust gas temperature of EMU too low (limit 1). 

462 HI T COOLANT EMU Coolant temperature of EMU injured limit 1. 

463 SD AUX 2 Sensor defect on Aux 2. 

464 SD P AUX 1 Analog input for pressure Aux 1 defect. 

467 AL L2 T AUX 1 Temperature input of Aux 1 injured limit 2. 

468 SD T AUX 1 Analog input for Temperature Aux 1 defect. 

469 SD AUX 1 Analog input for Aux 1 defect. 

470 SD T ECU ECU temperature-sensor defect. 

471 SD COIL CURRENT Coil Current sensor defect. 

472 AL STOP SD Engine stop, because critical channel has sensor defect. 

473 AL WIRING PWM CM2 Open load or short circuit on channel PWM_CM2. 

474 AL WIRING FREQ OUT Open load or short circuit on frequency output (FO) channel. 

475 AL CR TRIG ENG ST Released in case of an engine stop in order to trigger the crash 
recorder. 

476 AL CRASH REC ERR Initial error of crash recorder. 

478 AL COMB ALM YEL Combined Alarm YELLOW (Plant). 

479 AL COMB ALM RED Combined Alarm RED (Plant). 

480 AL EXT ENG PROT External Engine Protection function active. 

500 AL WIRING POM STARTER 1 A wiring fault has been detected in the connection of starter 1 of 
POM. 

501 AL WIRING POM STARTER 2 A wiring fault has been detected in the connection of starter 2 of 
POM. 
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Fault 
Code 

Number 
String Description 

502 AL OPEN LD POM ALTRNATR An open load on POM’s alternator output has been detected. 

503 AL BATT NOT CHARGING Battery is not being charged by alternator. 

504 AL CAN POM NODE LOST POM is missing on CAN bus. 

505 AL NEW POM FOUND New POM found. 

506 AL LOW STARTER VOLTS Battery voltage is too low for starting. 

507 AL POM ERROR A general POM error has been detected. 

508 AL WRONG POM ID POM sends a different identification number (ID) than expected.  

509 AL CHECK POM FUSE Check POM fuse. 

510 AL OVERRIDE APPLIED Override applied. 

515 STARTER NOT ENGAGED Starter of POM could not be engaged. 

543 MULTIPLE FDH SLAVES There is more than one device which is configured as Backup 
for FDH-Functionality. 

544 CONFIGURATION CHANGED Gets active in case of changing system configuration e.g. by 
changing ECU- or SAM-Device. Remains until undo procedure 
or data is transferred by a valid maintenance case. Is cancelled 
automatically. 

549 AL PWR CUTOFF STR This is the alarm from the function Emergency Stop Counter. 
ECU power was disconnected while the engine was still running. 
This could lead to a possible overpressure in the high pressure 
system which might damage the engine. 

555 AL CALL FIELD SERVICE Gets active in case of completing a maintenance-case which 
manipulates Engine-Parameters. Remains also after switching 
on-off ECU until a valid release code is entered via Display- and 
Button-Control of SAM-Device. Release Code is available via 
Internet by a special procedure. 

576 AL ESCM OVERRIDE STR Exceeding of the corrected current MCR - odr DBR/MCR value. 

594 AL L1 PRV 1 DEFECT STR Yellow alarm pressure relief valve first rail. 

595 AL L2 PRV 1 DEFECT STR Red alarm pressure relief valve first rail. 

598 AL L1 PRV 2 DEFECT STR Yellow alarm pressure relief valve second rail. 

599 AL L2 PRV 2 DEFECT STR Red alarm pressure relief valve second rail. 

610 AL WIRING SUCK RESTRCT 1 
STR 

Open load or short circuit on PWM HP fuel control block 
channel. 

611 AL WIRING SUCK RESTRCT 2 
STR 

Open load or short circuit on PWM HP fuel control block channel 
2. 

612 AL WIRING PRESS CTRL VLV 1 
STR 

Open load or short circuit on PWM pressure regulating valve 
channel. 

613 AL WIRING PRESS CTRL VLV 2 
STR 

Open load or short circuit on PWM pressure regulating valve 
channel 2. 

615 AL EIL PROTECTION STR Alarm for Protection Module in response to faulty or manipulated 
EIL. 

692 AL ECU PWR OFF ON REQ STR ECU configuration changed, switch power off/on. 

696 AL SMARTCONCT USB ERR 
STR 

Alarm configuration parameter. 

697 AL SMARTCONCT RS485 ERR 
STR 

Alarm configuration parameter. 

698 AL SD STOP BUTTON STR Channel signals open load or internal error. 

700 AL SD START BUTTON STR Channel signals open load. 
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Fault 
Code 

Number 
String Description 

701 AL SD UP BUTTON STR Channel signals open load. 

702 AL SD DN BUTTON STR Channel signals open load or internal error. 

703 AL SD EXT SPEED DMD SW 
STR 

Channel signals open load. 

704 AL SD SPEED DMD INCREASE 
STR 

Channel signals open load or internal error. 

705 AL SD BINARY SPD DMD LMT 
STR 

Channel signals open load or internal error. 

706 AL SD DROOP 2 SWITCH STR Channel signals open load or internal error. 

707 AL SD FREQUENCY SWITCH 
STR 

Channel signals open load or internal error. 

709 AL SD OVERRIDE BUTTON STR Channel signals open load or internal error. 

710 AL SD ALARM RESET STR Channel signals open load or internal error. 

711 AL SD CYLINDER CUTOUT STR Channel signals open load or internal error. 

712 AL SD RQST BIN OUT TST STR Channel signals open load or internal error. 

713 AL SD EXT ENGINE PROTECTN 
STR 

Channel signals open load or internal error. 

714 AL SD PRELUBE SIGNAL STR Channel signals open load. 

715 AL SD EXT INC IDLE BIN STR Channel signals open load. 

716 AL SD EXT INC IDLE BIN BRK 
STR 

Channel signals open load. 

717 AL SD RQST PLANT DBR STR Channel signals open load. 
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Exhaust Treatment 
Diesel Particulate Filter (DPF) 

In order to meet Tier 4 emission requirements, some engine manufacturers are applying Diesel 
Particulate Filters (DPF) to the exhaust system of the engine. A Diesel Particulate Filter traps particulate 
matter contained in diesel exhaust and prevents it from distributing into the air. The particulate matter is 
later burned off during a regeneration process. 

The DGC-2020ES communicates DPF control and status information to and from the engine ECU via 
J1939 communications in the form of various Parameter Group Numbers (PGN) and Suspect Parameter 
Numbers (SPN). These are summarized in the following paragraphs. 

Regeneration 
Regeneration is accomplished by operating the engine at elevated exhaust temperatures where the 
accumulated particulate is burned off. If, in normal operation, the engine can be loaded to a high enough 
level to achieve the elevated exhaust temperature, then regeneration can occur as a part of normal 
operation. This is known as passive regeneration. 

High exhaust temperatures can also be accomplished by methods such as providing dampers in the 
exhaust stream or heating the exhaust through the burning of fuel. This is known as active regeneration 
since it is outside of normal engine operation. 

Heavily loaded engines will seldom require active regeneration. A lightly loaded engine will likely undergo 
active regeneration when regeneration is required. 

DPF Control 
DPF control information is sent from the DGC-2020ES to the Engine ECU through PGN Number 57244 
(0xE000). A manual regeneration request is sent using SPN 3695, Diesel Particulate Filter Regeneration 
Force Switch. Regeneration can be inhibited by SPN 3695, Diesel Particulate Filter Regeneration Inhibit 
Switch. 

Manual Regeneration 

The operator can force a regeneration cycle by turning on the Manual Regeneration setting found on the 
front panel under SettingsCommunicationCANbus SetupECU SetupDPF Regenerate Setup. The 
parameter will remain on for a few seconds then go off. The ECU will respond to the momentary setting 
by logging the request to force a manual regeneration. A continuous request is not used because this can 
be problematic for some engine ECUs. 

Manual regeneration can also be initiated by clicking the Manual Regeneration button on the ECU Setup 
screen in BESTCOMSPlus®. BESTlogic™Plus programmable logic can also be used to initiate manual 
regeneration by setting the DPF Manual Regeneration (DPFMANREGEN) logic element true. 

Regeneration Inhibit 

The operator can inhibit regeneration by turning on the DPF Regeneration Disable setting found on the 
ECU Setup screen in BESTCOMSPlus. 

Regeneration can also be disabled by turning on the Disable Regeneration setting on the ECU Setup 
screen in BESTCOMSPlus. 

BESTlogicPlus programmable logic can also be used to inhibit regeneration by setting the DPF 
Regeneration Inhibit (DPFREGENINHIBIT) logic element true. 
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DPF Status and Pre-Alarms 
The DGC-2020ES receives DPF status information which is broadcast from the engine ECU in various 
Parameter Group Numbers (PGN) and Suspect Parameter Numbers (SPN). The DGC-2020ES displays 
this information on the front panel, and in BESTCOMSPlus, via DPF related pre-alarms. The J1939 
parameters and the resulting DGC-2020ES pre-alarms are summarized in the following paragraphs. 

• PGN 64892 (0xFD7C) Diesel Particulate Filter Control 1 

o SPN 3697, Diesel Particulate Filter Lamp Command 

DPF REGEN REQUIRED Pre-Alarm: When SPN 3697 has a 
value of 1 or 4 indicating the DPF lamp is on, the DGC-2020ES 
will annunciate a pre-alarm with text of DPF REGEN REQUIRED. 
The DPF symbol, shown to the right, will accompany the text 
when the pre-alarm appears on the DGC-2020ES front panel.  

o SPN 3698, Exhaust System High Temperature Lamp Command 

HIGH EXHAUST TEMP Pre-Alarm: When SPN 3698 has a value 
of 1 indicating the high exhaust temperature lamp is on, the DGC-
2020ES will annunciate a pre-alarm with text of HIGH EXHAUST 
TEMP. The high exhaust temperature symbol, shown to the right, 
will accompany the text when the pre-alarm appears on the DGC-
2020ES front panel.  

o SPN 3703 Diesel Particulate Filter Active Regeneration Inhibited Due to Inhibit Switch 

DPF REGEN INHIBITED Pre-Alarm: When SPN 3703 has a value 
of 1 indicating the DPF Regeneration is inhibited due to the inhibit 
switch being set, the DGC-2020ES will annunciate a pre-alarm 
with text of DPF REGEN INHBTD. The DPF regeneration inhibited 
symbol, shown to the right, will accompany the text when the pre-
alarm appears on the DGC-2020ES front panel.  

• DPF Soot Level Annunciation via Diagnostic Trouble Code (DTC) SPN 3719 Diesel Particulate Filter 
Soot Load Percent 

In addition to the standard diagnostic trouble code annunciation, the DGC-2020ES will 
annunciate a pre-alarm under circumstances described below. 

o FMI = 15: Data Valid But Above Normal Operating Range Least Severe Level 

DPF SOOT LEVEL HIGH Pre-Alarm: When the FMI is equal to 15, 
the DGC-2020ES will annunciate a pre-alarm with text of DPF 
SOOT LVL HI. The DPF symbol, shown to the right, will 
accompany the text when the pre-alarm appears on the DGC-
2020ES front panel.  

o FMI = 16: Data Valid But Above Normal Operating Range Moderately Severe Level 

DPF SOOT LEVEL MODERATELY HIGH Pre-Alarm: When the 
FMI is equal to 16, the DGC-2020ES will annunciate a pre-alarm 
with text of DPF SOOT LVL MOD HI. The DPF warning symbol, 
shown to the right, will accompany the text when the pre-alarm 
appears on the DGC-2020ES front panel.  

o FMI = 0: Data Valid But Above Normal Operating Range Most Severe Level 

DPF SOOT LEVEL EXTREMELY HIGH Pre-Alarm: When the FMI 
is equal to 0, the DGC-2020ES will annunciate a pre-alarm with 
text of DPF SOOT LVL EXT HI. The DPF stop symbol, shown to 
the right, will accompany the text when the pre-alarm appears on 
the DGC-2020ES front panel. If the DPF soot level reaches the 
most severe level, the engine ECU may shut the engine down and 
prevent it from running or it may allow it to run, but at a reduced 
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power level. The DGC-2020ES only indicates a pre-alarm. It does not prevent the engine 
from running or cause operation at a reduced power level, but the operator should be aware 
that the engine ECU or after treatment system may cause such behavior. 

Exhaust After-Treatment Systems (EATS) 

In order to meet Tier 4 emission requirements, some engine manufacturers are adding Exhaust After 
Treatment Systems (EATS) which treat the engine exhaust within the exhaust system to reduce 
particulate matter and harmful contaminants prior to releasing the exhaust into the atmosphere. One such 
system uses urea-based Diesel Exhaust Fluid (DEF) catalyst which is combined with the exhaust gasses 
in the EATS to bring the emissions to acceptable levels.  

The DGC-2020ES meters EATS information from the engine ECU via J1939 CANbus and 
displays the DEF level within the DEF tank(s), and also displays several pre-alarms 
related to the EATS system. Any DEF related pre-alarms annunciated on the front panel 
display the symbol used for DEF functions which is shown to the right.  

Most systems will contain one DEF tank, while some may contain two tanks. The DGC-2020ES front 
panel displays the level of DEF in each tank under MeteringAlarms-StatusJ1939 StatusDEF Tank1 
LVL% and MeteringAlarms-StatusJ1939 StatusDEF Tank2 LVL%. The tank 1 level is sent from the 
ECU via SPN 1761 in J1939 PGN 65110 - After Treatment 1 Reagent Tank 1 Information. The tank 2 
level is sent from the ECU via SPN 4367 in J1939 PGN 64829 - After Treatment 1 Reagent Tank 2 
Information. The tank levels are expressed in units of percent. 

Pre-Alarms 
The ECU sends DEF level diagnostics to the DGC as SPNs 5245 and 5246 in PGN 65110 (the AT1TI 
PGN). SPN 5245 communicated DEF level diagnostics, whereas SPN 5246 communicates DEF 
inducement level status. 

There are several pre-alarms related to the EATS which annunciate DEF level diagnostics and DEF 
inducement level status. They are always enabled and will annunciate when received from the engine 
ECU. Each of them contains the symbol for DEF functions when annunciated on the front panel; however 
it will not be displayed in BESTCOMSPlus. The pre-alarms are summarized in the following paragraphs. 

• DEF FLUID LOW: This pre-alarm displays when SPN 5245 has a value of 1, indicating that the DEF 
tank level is low. A DEF level of 8% to 23% causes this annunciation. 

• DEF FLUID EMPTY: This pre-alarm displays when SPN 5245 has a value of 4, indicating that the 
DEF tank level is low. The low condition is announced when the tank level is below 8%. When this 
occurs and is not remedied, the engine ECU may enter a mode of inducement not to operate the 
engine where some of the conditions in the pre-alarms descriptions below may occur. 

• DEF ENGINE DERATE: This pre-alarm displays when SPN 5246 has a value of 3, indicating the 
Engine Derate level of inducement. This indicates that the engine is going into a reduced power mode 
indicating the lowest level of inducement not to operate the engine when the EATS is not functioning 
properly or out of DEF. 

• DEF PRESEVERE INDUCEMENT: This pre-alarm displays when SPN 5246 has a value of 4, 
indicating the Pre-Severe Inducement level of inducement. This indicates that the engine has entered 
the second highest level of inducement not to operate the engine when the EATS is not functioning 
properly or the DEF level is low. The ECU will allow the engine to run for a maximum of 3 hours in 
this condition. After expiration of the 3 hours, the engine will enter the severe inducement state and 
cannot be restarted until the DEF level is raised above 14%. 

• DEF SEVERE INDUCEMENT: This pre-alarm displays when SPN 5246 has a value of 5, indicating 
the Severe Inducement level of inducement. This indicates that the engine has entered the highest 
level of inducement not to operate the engine when the EATS is not functioning properly or DEF level 
is low. The ECU will allow the engine to run for a maximum of 3 hours in this condition. After 
expiration of the 3 hours, the engine will enter the severe inducement state and cannot be restarted 
until the DEF level is raised above 14%. 
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• DEF INDUCEMENT OVERRIDE: This pre-alarm displays when SPN 5246 has a value of 6, indicating 
the Temporary Override of inducement. This indicates DEF inducement is temporarily overridden. 
The engine may operate with reduced power, or for a limited time, after which time it may re-enter the 
SEVERE INDUCEMENT state. 

Exit Conditions for DEF Severe Inducement 
• First Restart: Return to 0% torque reduction in exit condition, until proper DEF level and quality 

evaluation. If low level or poor DEF quality is detected during the next monitoring cycle, the severe 
inducement will be active after the next restart. After the second restart, a service tool is required to 
exit the severe inducement. 

• With Service Tool Clearing: Invoke 0% torque reduction with service tool clearing until proper DEF 
level and quality evaluation. If low level or poor DEF quality is detected during the next monitoring 
cycle, the severe inducement will be active after the next restart. 
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Diagnostic Trouble Codes 
Diagnostic engine information is obtained from a compatible engine control unit (ECU). The DGC-2020ES 
will receive an unsolicited message of a currently active diagnostic trouble code (DTC). Previously active 
DTCs are available upon request. Active and previously active DTCs can be cleared on request. Table 35 
lists the diagnostic information that the DGC-2020ES obtains over the CAN interface. 

Table 35. Diagnostic Information Obtained Over the CAN Interface 

Parameter Transmission 
Repetition Rate 

Active diagnostic trouble code 1 s 
Lamp status 1 s 
Previously active diagnostic trouble code On request 
Request to clear active DTCs On request 
Request to clear previously active DTCs On request 

DTCs are reported in coded diagnostic information that includes the Suspect Parameter Number (SPN), 
Failure Mode Identifier (FMI), and Occurrence Count (OC). All parameters have an SPN and are used to 
display or identify the items for which diagnostics are being reported. The FMI defines the type of failure 
detected in the subsystem identified by an SPN. The reported problem may not be an electrical failure but 
a subsystem condition needing to be reported to an operator or technician. The OC contains the number 
of times that a fault has gone from active to previously active. 

For certain DTCs, if the DGC-2020ES recognizes a pair of SPN and FMI numbers, it displays a single 
string as listed in Table 36. If the DGC-2020ES recognizes an SPN in Table 36, but the FMI does not 
match the FMI in Table 36, then it displays the string from Table 36 corresponding to the table entry 
where the FMI is # and a second string corresponding to the FMI number listed in Table 37. For example, 
if the DGC-2020ES receives SPN 29 and FMI 13, it displays ACCEL PEDAL 2 POSITN and OUT OF 
CALIBRATION. If the DGC-2020ES does not have descriptive information about an SPN and FMI that 
was received, the description will display as “NO TEXT AVAILABLE”. 

Table 36. DTCs Displayed by the DGC-2020ES 

SPN FMI String Displayed Description 
28 3 Throttle Volt HI Throttle Voltage High 

28 4 Throttle Volt LO Throttle Voltage Low 

28 14 Throttle Volt OOR Throttle Input Voltage Out of Range 

29 3 Throttle Volt HI Throttle Voltage High 

29 4 Throttle Volt LO Throttle Voltage Low 

29 14 Throttle Volt OOR Throttle Input Voltage Out of Range 

29 # ACCEL PEDAL 2 POSITN Caption string for accelerator pedal 2 position 

52 15 INTERCOOLER TEMP HI Engine Intercooler Temperature is above the HIGH threshold 

91 3 Thr Pos Sns Volt HI Throttle Position Sensor Input Voltage (High) 

91 4 Thr Pos Sns Volt LO Throttle Position Sensor Input Voltage (Low) 

91 14 Thr Pos Sns Volt OOR Throttle Voltage (Out of Range) 

94 1 FUEL DELIV PRS LO LO Engine Fuel Delivery Pressure is below the LOW LOW 
threshold 

94 3 Fuel Pmp Prs Volt HI Fuel Pump Pressure Input Voltage (High) 

94 4 Fuel Pmp Prs Volt LO Fuel Pump Pressure Input Voltage (Low) 

94 17 Fuel Pressure LO Fuel Supply Pressure (Low Least Severe) 

97 3 Water In Fl Volt HI Water In Fuel Signal Voltage High 
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SPN FMI String Displayed Description 
97 4 Water In Fl Volt LO Water In Fuel Signal Voltage Low 

97 16 Water in Fuel Water In Fuel Detected 

98 # ENG OIL LEVEL Caption used on front panel for Display of J1939 Parameter 

99 # OIL FILTER DIFF PRESS Caption string for oil filter differential pressure parameter 

100 1 ENG OIL PRESS LO LO Engine Oil Pressure is below the LOW LOW threshold 

100 3 Oil Prs Snsr Volt HI Oil Pressure Sensor Input Voltage (High) 

100 4 Oil Prs Snsr Volt LO Oil Pressure Sensor Input Voltage (Low) 

100 17 ENG OIL PRESS LO Engine Oil Pressure is below the LOW threshold 

100 18 Oil Prs Snsr Volt MLO Oil Pressure Sensor Input Voltage (Moderately Low) 

100 31 Oil Pressure INVLD Oil Pressure (Invalid) 

101 # CRANKCASE PRESSURE Caption string for crankcase pressure 

102 2 Manifld Air Prs INVD Manifold Air Pressure Invalid 

102 3 Mnfld AirP SnsVlt HI Manifold Air Pressure Sensor Input Voltage High 

102 4 Mnfld AirP SnsVlt LO Manifold Air Pressure Sensor Input Voltage Low 

103 0 Trbo Overspd Severe Turbo Overspeed (Most Severe) 

103 2 Trbo Speed MisMatch Turbo Speed (Mismatch) 

103 5 Trbo Spd Sns Curr LO Turbo Speed Sensor Current (Low) 

103 6 Trbo Spd Sns Curr HI Turbo Speed Sensor Current (High) 

103 8 Trbo Speed INVLD Turbo Speed (Invalid) 

103 31 Trbo Speed MISSING Turbo Speed (Missing) 

105 0 EGR Mixed Air Tmp HI Exhaust Gas Recirculation Mixed Air High (Least Severe) 

105 3 EGR Air Temp Vlt HI Exhaust Gas Recirculation Mixed Air Temp Voltage (High) 

105 4 EGR Air Temp Vlt LO Exhaust Gas Recirculation Mixed Air Temp Voltage (Low) 

105 15 EGR Mixed Air Tmp HI Exhaust Gas Recirculation Mixed Air High (Least Severe) 

105 16 EGR MxdAir Tmp MHI Exhaust Gas Recirculation Mixed Air Temp (Moderately High) 

107 0 Air Filt Restricted Air Filter Restriction (High) 

108 2 Barometrc Prs INVLD Barometric Pressure (Invalid) 

108 31 Barometrc Prs ERR Barometric Pressure (Error) 

109 1 ENG COOLNT PRS LO LO Engine Coolant Pressure is below the LOW LOW threshold 

109 17 ENG COOLANT PRS LO Engine Coolant Pressure is below the LOW threshold 

110 0 ENG COOLNT TMP HI HI Engine Coolant Temperature is above the HIGH HIGH 
threshold 

110 3 Cool Tmp Sns Volt HI Coolant Temp Sensor Input Voltage (High) 

110 4 Cool Tmp Sns Volt LO Coolant Temp Sensor Input Voltage (Low) 

110 15 ENG COOLANT TEMP HI Engine Coolant Temperature is above the HIGH threshold 

110 16 Cool Temp MHI Coolant Temp Sensor Input (Moderately High) 

110 17 Cool Temp LO Coolant Temp Sensor Input (Low Least Severe) 

111 1 Coolnt Lvl LO Coolant Level (Low) 

111 17 ENG COOLANT LVL LO Engine Coolant Level is below the LOW threshold 

111 # LOW COOL LEVEL Low Coolant Level string used in event log and/or Alarm and 
Prealarm annunciation 

157 3 Fuel Rail Prs Vlt HI Fuel Rail Pressure Input Voltage (High) 

157 4 Fuel Rail Prs Vlt LO Fuel Rail Pressure Input Voltage (Low) 

157 10 Fuel Rail Prs LOSS Fuel Rail Pressure Loss Detected 
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157 17 Fuel Rl Prs NOT DEV Fuel Rail Pressure Not Developed 

158 0 KSW BATT VOLTS HI HI Key Switch Battery Potential is above the HIGH HIGH 
threshold 

158 1 KSW BATT VOLTS LO LO Key Switch Battery Potential is below the LOW LOW threshold 

158 15 KSW BATT VOLTS HI Key Switch Battery Potential is above the HIGH threshold 

158 17 KSW BATT VOLTS LO Key Switch Battery Potential is below the LOW threshold 

168 # LOW BATT VOLT Low Battery Voltage string used in event log and/or Alarm and 
Prealarm annunciation 

174 0 Fuel Temp EXT HI Fuel Temp (Extremely High) 

174 3 Fuel Tmp Sns Volt HI Fuel Temp Sensor Input Voltage (High) 

174 4 Fuel Tmp Sns Volt LO Fuel Temp Sensor Input Voltage (Low) 

174 16 Fuel Temp MHI Fuel Temp (Moderately High) 

175 # ENG OIL TEMP Caption used on front panel for Display of J1939 Parameter 

188 17 SPEED AT IDLE LO Metering string for ECU trouble code metering indicates Engine 
Idle speed is below the LOW threshold  

189 0 Engine Spd DERATE Engine Speed Derate 

190 0 Engine OvrSpd EXTRM Engine Overspeed (Extreme) 

190 1 ENGINE SPEED LOW Engine speed is below the LOW threshold 

190 16 Engine OvrSpd MODRT Engine Overspeed (Moderate) 

190 17 SPEED AT IDLE LO Engine Idle speed is below the LOW threshold 

190 # ENGINE SPEED Caption used on front panel for Display of J1939 Parameter 

237 2 VIN Data MisMatch VIN Data Mismatch with other controllers 

412 0 EGR Temp EXT HI Exhaust Gas Recirculation Temp (Extremely High) 

412 3 EGR Temp In Vlt HI Exhaust Gas Recirculation Temp Input Voltage (High) 

412 4 EGR Temp In Vlt LO Exhaust Gas Recirculation Temp Input Voltage (Low) 

412 16 EGR Temp MHI Exhaust Gas Recirculation Temp (Moderately High) 

520 # RETARDER % TORQUE Caption string for retarder % torque 

563 # ABS ACTIVE Caption String for Antilock Brake System (ABS) active 

611 3 Inj Short to PWR Injector Wiring Shorted to Power 

611 4 Inj Short to GND Injector Wiring Shorted to Ground 

624 # DIAGNOSTIC LAMP Caption String for Diagnostic Lamp 

627 1 Inj Spply Vlt Problm Injector Supply Voltage Problem 

627 16 ECU Power Volt HI ECU Power High Voltage 

627 18 ECU Power Volt LO ECU Power Low Voltage 

627 13 ECU ERROR ECU Error 

630 # ECU INTERNAL ERROR Caption string for ECU Internal Error 

636 2 Pump Pos Sns Noisy Pump Position Sensor Input Noise 

636 5 Pump Pos Sns Curr LO Pump Position Sensor Current (Low) 

636 6 Pump Pos Sns Curr HI Pump Position Sensor Current (High) 

636 8 Pump Pos Sns In MSNG Pump Position Sensor Input Missing 

636 10 Pump Pos Sns In ERR Pump Position Sensor Input Pattern Error 

637 2 Crank Pos Sns Noisy Crank Position Input Noise 

637 5 Crank Pos Sns Curr LO Crank Position Sensor Current (Low) 

637 6 Crank Pos Sns Curr HI Crank Position Sensor Current (High) 
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637 7 Crnk/Pmp Pos Tmg OOS Crank/Pump Position Timing Moderately Out of Sync 

637 8 Crank Pos Sns MSNG Crank Position Missing 

637 10 Crank Pos Sns In ERR Crank Position Input Pattern Error 

639 # J1939 NETWORK 1 Caption String for J1939 Network number 1 

641 4 Trbo Actuator ERR Turbo Actuator Error 

641 12 ECU/Trbo Comm ERR ECU/Turbo Communication Error 

641 13 TrboAct Lrnd Val ERR Turbo Actuator Learned Value Error 

641 16 Trbo Act Temp MHI Turbo Actuator Temp (Moderately High) 

651 2 Cyl 1 EUI PN INVLD Cylinder #1 EUI Part Number (Invalid) 

651 5 Cyl 1 EUI Ckt OPEN Cylinder #1 EUI Circuit (Open) 

651 6 Cyl 1 EUI Ckt SHORT Cylinder #1 EUI Circuit (Shorted) 

651 7 Cyl 1 EUI Ckt MECH FL Cylinder #1 EUI Circuit (Mechanical Failure) 

651 13 Cyl 1 EUI QR INVLD Cylinder #1 EUI Circuit QR Code (Invalid) 

651 # CYLINDER 1 INJECTOR Caption String for Cylinder 1 Injector 

652 2 Cyl 2 EUI PN INVLD Cylinder #2 EUI Part Number (Invalid) 

652 5 Cyl 2 EUI Ckt OPEN Cylinder #2 EUI Circuit (Open) 

652 6 Cyl 2 EUI Ckt SHORT Cylinder #2 EUI Circuit (Shorted) 

652 7 Cyl 2 EUI Ckt MECH FL Cylinder #2 EUI Circuit (Mechanical Failure) 

652 13 Cyl 2 EUI QR INVLD Cylinder #2 EUI Circuit QR Code (Invalid) 

652 # CYLINDER 2 INJECTOR Caption String for Cylinder 2 Injector 

653 2 Cyl 3 EUI PN INVLD Cylinder #3 EUI Part Number (Invalid) 

653 5 Cyl 3 EUI Ckt OPEN Cylinder #3 EUI Circuit (Open) 

653 6 Cyl 3 EUI Ckt SHORT Cylinder #3 EUI Circuit (Shorted) 

653 7 Cyl 3 EUI Ckt MECH FL Cylinder #3 EUI Circuit (Mechanical Failure) 

653 13 Cyl 3 EUI QR INVLD Cylinder #3 EUI Circuit QR Code (Invalid) 

653 # CYLINDER 3 INJECTOR Caption String for Cylinder 3 Injector 

654 2 Cyl 4 EUI PN INVLD Cylinder #4 EUI Part Number (Invalid) 

654 5 Cyl 4 EUI Ckt OPEN Cylinder #4 EUI Circuit (Open) 

654 6 Cyl 4 EUI Ckt SHORT Cylinder #4 EUI Circuit (Shorted) 

654 7 Cyl 4 EUI Ckt MECH FL Cylinder #4 EUI Circuit (Mechanical Failure) 

654 13 Cyl 4 EUI QR INVLD Cylinder #4 EUI Circuit QR Code (Invalid) 

654 # CYLINDER 4 INJECTOR Caption String for Cylinder 4 Injector 

655 2 Cyl 5 EUI PN INVLD Cylinder #5 EUI Part Number (Invalid) 

655 5 Cyl 5 EUI Ckt OPEN Cylinder #5 EUI Circuit (Open) 

655 6 Cyl 5 EUI Ckt SHORT Cylinder #5 EUI Circuit (Shorted) 

655 7 Cyl 5 EUI Ckt MECH FL Cylinder #5 EUI Circuit (Mechanical Failure) 

655 13 Cyl 5 EUI QR INVLD Cylinder #5 EUI Circuit QR Code (Invalid) 

655 # CYLINDER 5 INJECTOR Caption String for Cylinder 5 Injector 

656 2 Cyl 6 EUI PN INVLD Cylinder #6 EUI Part Number (Invalid) 

656 5 Cyl 6 EUI Ckt OPEN Cylinder #6 EUI Circuit (Open) 

656 6 Cyl 6 EUI Ckt SHORT Cylinder #6 EUI Circuit (Shorted) 

656 7 Cyl 6 EUI Ckt MECH FL Cylinder #6 EUI Circuit (Mechanical Failure) 

656 13 Cyl 6 EUI QR INVLD Cylinder #6 EUI Circuit QR Code (Invalid) 
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656 # CYLINDER 6 INJECTOR Caption String for Cylinder 6 Injector 

657 # CYLINDER 7 INJECTOR Caption String for Cylinder 7 Injector 

658 # CYLINDER 8 INJECTOR Caption String for Cylinder 8 Injector 

659 # CYLINDER 9 INJECTOR Caption String for Cylinder 9 Injector 

660 # CYLINDER 10 INJECTOR Caption String for Cylinder 10 Injector 

661 # CYLINDER 11 INJECTOR Caption String for Cylinder 11 Injector 

662 # CYLINDER 12 INJECTOR Caption String for Cylinder 12 Injector 

663 # CYLINDER 13 INJECTOR Caption String for Cylinder 13 Injector 

664 # CYLINDER 14 INJECTOR Caption String for Cylinder 14 Injector 

665 # CYLINDER 15 INJECTOR Caption String for Cylinder 15 Injector 

666 # CYLINDER 16 INJECTOR Caption String for Cylinder 16 Injector 

667 # CYLINDER 17 INJECTOR Caption String for Cylinder 17Injector 

668 # CYLINDER 18 INJECTOR Caption String for Cylinder 18 Injector 

669 # CYLINDER 19 INJECTOR Caption String for Cylinder 19 Injector 

670 # CYLINDER 20 INJECTOR Caption String for Cylinder 20 Injector 

671 # CYLINDER 21 INJECTOR Caption String for Cylinder 21 Injector 

672 # CYLINDER 22 INJECTOR Caption String for Cylinder 22 Injector 

673 # CYLINDER 23 INJECTOR Caption String for Cylinder 23 Injector 

674 # CYLINDER 24 INJECTOR Caption String for Cylinder 24 Injector 

676 # ENG GLOW PLUG RELAY Caption String for Engine Glow Plug Relay 

677 # ENGINE START RELAY Caption String for Engine Start Relay 

701 # AUX I/O 1 Caption String for Auxiliary I/O 1 

702 # AUX I/O 2 Caption String for Auxiliary I/O 2 

703 # AUX I/O 3 Caption String for Auxiliary I/O 3 

704 # AUX I/O 4 Caption String for Auxiliary I/O 4 

705 # AUX I/O 5 Caption String for Auxiliary I/O 5 

706 # AUX I/O 6 Caption String for Auxiliary I/O 6 

707 # AUX I/O 7 Caption String for Auxiliary I/O 7 

708 # AUX I/O 8 Caption String for Auxiliary I/O 8 

709 # AUX I/O 9 Caption String for Auxiliary I/O 9 

710 # AUX I/O 10 Caption String for Auxiliary I/O 10 

711 # AUX I/O 11 Caption String for Auxiliary I/O 11 

712 # AUX I/O 12 Caption String for Auxiliary I/O 12 

713 # AUX I/O 13 Caption String for Auxiliary I/O 13 

714 # AUX I/O 14 Caption String for Auxiliary I/O 14 

715 # AUX I/O 15 Caption String for Auxiliary I/O 15 

716 # AUX I/O 16 Caption String for Auxiliary I/O 16 

898 2 REQ SPD DATA ERRATIC Speed Demand Data is erratic 

898 9 Spd/Trq Msg INVLD Vehicle Speed/Torque Message Invalid 

898 # ENGINE REQSTED SPEED Caption String for Engine Requested Speed 

923 # PWM OUTPUT Caption String for Engine PWM Output 

970 2 Aux Eng SD SW INVLD Auxiliary Engine Shutdown Switch (Invalid) 

970 31 Aux Eng SD SW ACTV Auxiliary Engine Shutdown Switch Active 
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971 31 Eng Derate SW ACTV External Engine Derate Switch Active 

975 # FAN SPEED Caption String for Engine Fan Speed 

1072 # ENG BRAKE OUTPUT 1 Caption String for Engine Brake Output 1 

1074 # ENG EXHAUST BRAKE OUT Caption String for Engine Exhaust Brake Output 

1075 5 Fuel TR Pump Curr LO Fuel Transfer Pump Current (Low) 

1075 6 Fuel TR Pump Curr HI Fuel Transfer Pump Current (High) 

1075 12 Fuel TR Pump ERR Fuel Transfer Pump (Error) 

1079 # SENSOR SUPPLY VOLTS 1 Caption String for Sensor Supply Voltage 1 

1080 3 Snsr Supp 1 Volt LO Sensor Supply 1 Voltage (Low) 

1080 4 Snsr Supp 1 Volt HI Sensor Supply 1 Voltage (High) 

1080 # SENSOR SUPPLY VOLTS 2 Caption String for Sensor Supply Voltage 2 

1081 # ENG WAIT TO START LMP Caption String for Engine Wait to Start Lamp 

1109 31 Eng Shutdown WARNING Engine Shutdown Warning 

1109 # EPS SHUTDN APPROACHG Caption String for indication that Engine Protective System 
Shutdown Is Approaching 

1110 31 Eng Prot Shutdown Engine Protection Shutdown 

1136 0 ECU Temp EXT HI ECU Temperature (Extremely High) 

1136 15 ENG ECU TEMP HI ECU Temperature has exceeded the HIGH level 

1136 16 ECU Temp MHI ECU Temperature (Moderately High) 

1172 3 Trbo Cmp Tmp Volt HI Turbo Compressor Inlet Temp Input Voltage (High) 

1172 4 Trbo Cmp Tmp Volt LO Turbo Compressor Inlet Temp Input Voltage (Low) 

1172 16 Trbo Cmp In Tmp MHI Turbo Compressor Inlet Temp (Moderately High) 

1180 0 Trbo Trbn Tmp EXT HI Turbo Turbine Inlet Temp (Extremely High) 

1180 16 Trbo Trbn In Tmp MHI Turbo Turbine Inlet Temp (Moderately High) 

1231 # J1939 NETWORK 2 Caption String for J1939 Network number 2 

1235 # J1939 NETWORK 3 Caption String for J1939 Network number 3 

1237 # ENG SHUTDN ORIDE SW Caption String for Engine Shutdown Override Switch 

1322 # MULTI  CYL MISFIRE Caption String for Misfire detected on multiple engine cylinders 

1323 # MISFIRE CYLINDER 1 Caption String for Misfire detected on a single engine cylinder 

1324 # MISFIRE CYLINDER 2 Caption String for Misfire detected on a single engine cylinder 

1325 # MISFIRE CYLINDER 3 Caption String for Misfire detected on a single engine cylinder 

1326 # MISFIRE CYLINDER 4 Caption String for Misfire detected on a single engine cylinder 

1327 # MISFIRE CYLINDER 5 Caption String for Misfire detected on a single engine cylinder 

1328 # MISFIRE CYLINDER 6 Caption String for Misfire detected on a single engine cylinder 

1329 # MISFIRE CYLINDER 7 Caption String for Misfire detected on a single engine cylinder 

1330 # MISFIRE CYLINDER 8 Caption String for Misfire detected on a single engine cylinder 

1331 # MISFIRE CYLINDER 9 Caption String for Misfire detected on a single engine cylinder 

1332 # MISFIRE CYLINDER 10 Caption String for Misfire detected on a single engine cylinder 

1333 # MISFIRE CYLINDER 11 Caption String for Misfire detected on a single engine cylinder 

1334 # MISFIRE CYLINDER 12 Caption String for Misfire detected on a single engine cylinder 

1335 # MISFIRE CYLINDER 13 Caption String for Misfire detected on a single engine cylinder 

1336 # MISFIRE CYLINDER 14 Caption String for Misfire detected on a single engine cylinder 

1337 # MISFIRE CYLINDER 15 Caption String for Misfire detected on a single engine cylinder 

Diagnostic Trouble Codes  DGC-2020ES 



9469200990 Rev B 213 

SPN FMI String Displayed Description 
1338 # MISFIRE CYLINDER 16 Caption String for Misfire detected on a single engine cylinder 

1339 # MISFIRE CYLINDER 17 Caption String for Misfire detected on a single engine cylinder 

1340 # MISFIRE CYLINDER 18 Caption String for Misfire detected on a single engine cylinder 

1341 # MISFIRE CYLINDER 19 Caption String for Misfire detected on a single engine cylinder 

1342 # MISFIRE CYLINDER 20 Caption String for Misfire detected on a single engine cylinder 

1343 # MISFIRE CYLINDER 21 Caption String for Misfire detected on a single engine cylinder 

1344 # MISFIRE CYLINDER 22 Caption String for Misfire detected on a single engine cylinder 

1345 # MISFIRE CYLINDER 23 Caption String for Misfire detected on a single engine cylinder 

1346 # MISFIRE CYLINDER 24 Caption String for Misfire detected on a single engine cylinder 

1347 3 Pump Ctrl Vlv Curr HI Pump Control Valve Current (High) 

1347 5 Pmp Ctrl Vlv C MSMCH Pump Control Valve Current (Mismatch) 

1347 7 Fuel Rl Prs Ctrl ERR Fuel Rail Pressure Control (Error) 

1569 31 Fuel Derate Fuel Derate 

1638 # HYDRAULIC TEMP Caption String for Hydraulic Temperature 

1639 1 Fan Speed Zero Fan Speed Detected (Zero) 

1639 16 Fan Speed HI Fan Speed Detected (High) 

1639 18 Fan Speed LO Fan Speed Detected (Low) 

2000 13 Security Violation Security Violation 

2005 9 TSC CAN Msg NT RCV TSC CAN Message Not Received 

2030 9 AC Clutch Msg NT RCV A/C Clutch Status CAN Message Not Received 

2071 9 Tr Oil Can Msg NT RCV Trans. Oil, Tier Size, Vehicle Speed CAN Message Not 
Received 

2629 0 TRBO 1 OUT TMP HI HI Turbocharger 1 outlet pressure is above the HIGH HIGH 
threshold 

2629 15 TURBO 1 OUT TMP HI Turbocharger 1 outlet pressure is above the HIGH threshold 

2630 0 EGR FrAir Tmp EXT HI Exhaust Gas Recirculation Fresh Air Temp (Extremely High) 

2630 3 EGR FrAir Tmp Vlt HI Exhaust Gas Recirculation Fresh Air Temp Input Voltage 
(High) 

2630 4 EGR FrAir Tmp Vlt LO Exhaust Gas Recirculation Fresh Air Temp Input Voltage (Low) 

2630 15 EGR FrAir Tmp HI Exhaust Gas Recirculation Fresh Air Temp (High Least 
Severe) 

2630 16 EGR FrAir Tmp MHI Exhaust Gas Recirculation Fresh Air Temp (Moderately High) 

2634 # POWER RELAY Caption String for main Power Relay 

2659 2 EGR Flo/Tmp MISMATCH Exhaust Gas Recirculation Flow/Temp Mismatch 

2659 15 EGR Flo Rt High Exhaust Gas Recirculation Flow Rate (High Least Severe) 

2659 17 EGR Flo Rt LO Exhaust Gas Recirculation Flow Rate (Low Least Severe) 

2790 16 Trbo Cmp Out Tmp HI Turbo Compressor Outlet Temp (Moderately High) 

2791 2 EGR Vlv Pos Invld Exhaust Gas Recirculation Valve Position Invalid 

2791 3 EGRVlv Pos In Vlt HI Exhaust Gas Recirculation Valve Position Input Voltage (High) 

2791 4 EGRVlv Pos In Vlt LO Exhaust Gas Recirculation Valve Position Input Voltage (Low) 

2791 13 EGR Vlv Control ERR Exhaust Gas Recirculation Valve Control Error 

2791 31 EGR Valve Cal ERR Exhaust Gas Recirculation Valve Calibration Error 

2791 # EGR VALVE CONTROL Caption String for EGR Valve Control 

2795 7 Trbo Act Pos MSMATCH Turbo Actuator Position Mismatch 
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3719 0 DPF SOOT LVL EXT HI String for Diagnostic Trouble Code Indicating Diesel Particulate 

Filter Soot Level High - Most Severe Level 

3719 15 DPF SOOT LVL HI String for Diagnostic Trouble Code Indicating Diesel Particulate 
Filter Soot Level High - Least Severe Level 

3719 16 DPF SOOT LVL MOD HI String for Diagnostic Trouble Code Indicating Diesel Particulate 
Filter Soot Level High - Moderately Severe Level 

520837 1 STARTER SPEED LO LO Starter Speed is below the LOW LOW threshold 

520838 1 RUN UP SPEED LO LO Run Up Speed is below the LOW LOW threshold 

522192 12 MTU ENGINE BAD Component failure of the MTU engine control ECU 

523212 # ENGPRT CAN MSG Caption String for CAN Message 

523216 # PREHTENCMD CAN MSG Caption String for CAN Message 

523218 # RxCCVS CAN MSG Caption String for CAN Message 

523222 # TC01 CAN MSG Caption String for CAN Message 

523238 # SWTOUT CAN MSG Caption String for CAN Message 

523239 # DECV1 CAN MSG Caption String for CAN Message 

523240 # FUNMODCTL CAN MSG Caption String for CAN Message 

523350 # CYL BANK 1 INJECTORS Caption String for Cylinder Bank 1 Injectors 

523351 # CYL BANK 1 INJECTORS Caption String for Cylinder Bank 1 Injectors 

523352 # CYL BANK 2 INJECTORS Caption String for Cylinder Bank 2 Injectors 

523353 # CYL BANK 2 INJECTORS Caption String for Cylinder Bank 2 Injectors 

523354 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523355 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523370 # RAIL PRESSURE Caption String for Rail Pressure 

523420 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523450 # MULTI STATE SWITCH 1 Caption String for Multi State Switch 1 

523451 # MULTI STATE SWITCH 2 Caption String for Multi State Switch 2 

523452 # MULTI STATE SWITCH 3 Caption String for Multi State Switch 3 

523470 # RAIL PRESSURE LMT VLV Caption String for Rail Pressure Limit Valve 

523490 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error   

523500 # CAN MSG TIMEOUT Caption String indicating Can Message Timeout has occurred 

523550 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error   

523561 # INJECTN  PERIOD CYL 1 Caption String for Single Cylinder Injection Period 

523562 # INJECTN  PERIOD CYL 2 Caption String for Single Cylinder Injection Period 

523563 # INJECTN  PERIOD CYL 3 Caption String for Single Cylinder Injection Period 

523564 # INJECTN  PERIOD CYL 4 Caption String for Single Cylinder Injection Period 

523565 # INJECTN  PERIOD CYL 5 Caption String for Single Cylinder Injection Period 

523566 # INJECTN  PERIOD CYL 6 Caption String for Single Cylinder Injection Period 

523567 # INJECTN  PERIOD CYL 7 Caption String for Single Cylinder Injection Period 

523568 # INJECTN  PERIOD CYL 8 Caption String for Single Cylinder Injection Period 

523600 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523601 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523602 # FAN SPEED Caption String for Engine Fan Speed 

523604 # RXENGTMP CAN MSG Caption String for CAN Message 

523605 # TSC1-AE MSG MISSING Caption String for CAN Message 
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523606 # TSC1-AR MSG MISSING Caption String for CAN Message 

523607 # TSC1-DE MSG MISSING Caption String for CAN Message 

523608 # TSC1-DR MSG MISSING Caption String for CAN Message 

523609 # TSC1-PE MSG MISSING Caption String for CAN Message 

523610 # TSC1-VE MSG MISSING Caption String for CAN Message 

523611 # TSC1-VR MSG MISSING Caption String for CAN Message 

523612 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

523613 # RAIL PRESSURE Caption String for Rail Pressure 

523615 # METERING UNIT VALVE Caption String for Metering Unit Valve 

523617 # ECU ERROR String for Diagnostic Trouble Code Indicating ECU Error 

 

Table 37. DTCs Displayed by the DGC-2020ES (FMI Strings) 

FMI String Displayed Description 
0 DATA HI MOST SEVERE Data is higher than expected at the most severe level 

1 DATA LO MOST SEVERE Data is lower than expected at the most severe level 

2 DATA ERRATIC OR BAD Data is erratic, intermittent, or incorrect 

3 VOLTS HI OR SHORTED Measured voltage is higher than expected or shorted to a high source 

4 VOLTS LO OR SHORTED Measured voltage is lower than expected or shorted to a low source 

5 CURRENT LO OR OPEN Measured current is lower than expected or the circuit is open 

6 CURRENT HI OR SHORTED Measured current is higher than expected or shorted 

7 MECHANICAL SYSTM ERR Mechanical system error 

8 FREQ OR PWM ERROR Error in frequency, pulse width or period of any frequency or PWM signal 
is outside its predetermined limits 

9 ABNORMAL UPDATE RATE Update rate of parameter is abnormal 

10 DATA RT OF CHG ERR Rate of change of data is abnormal 

11 FAILURE CAUSE UNKNOWN String indicating failure cause is unknown 

12 BAD INTELLIGNT DEVICE Engine ECU is reporting that an intelligent device or component failure 
has been detected 

13 OUT OF CALIBRATION Device or parameter is out of calibration 

14 CONSULT ENG MFG  DATA User should consult engine manufacturer's data 

15 DATA HI LST SEVERE Data is higher than expected at the least severe level 

16 DATA HI MODERATE SVR Data is higher than expected at a moderately severe level 

17 DATA LO LST SEVERE Data is lower than expected at the least severe level 

18 DATA LO MODERATE SVR Data is lower than expected at a moderately severe level 

19 NETWORK DATA ERR String Indicating Network Data contained an error indication 
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Revision History 
Table 38 provides a historical summary of the changes made to the DGC-2020ES hardware. Firmware 
changes are listed in Table 39 and software changes are listed in Table 40. The corresponding revisions 
made to this instruction manual are summarized in Table 41. Revisions are listed in chronological order. 

Table 38. Hardware Revision History 
Hardware 

Version and Date Change 

A, 03/13 • Initial release 

Table 39. Firmware Revision History 
Firmware 

Version and Date Change 

1.00.00, 03/13 • Initial release 

Table 40. Software Revision History 
Software 

Version and Date Change 

3.03.00, 03/13 • Initial Release 

Table 41. Instruction Manual Revision History 
Manual 

Revision and Date Change 

A, 03/13 • Initial release 
B, 02/14 • Expanded description of RDP alarm annunciation 

• Added BESTlogicPlus status input blocks GENBREAKERSTATUS 
and MAINSBREAKERSTATUS. 

• Removed product registration information 
• Moved Revision History to back of manual 
• Minor text edits 
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